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Safety

This section provides guidelines and information for safely using and 
operating the MicroXCT™:

– Safety Guidelines

– EMO Shutdown

– Enclosure Covers and Access Door(s)

– Potential Hazards and Safety Precautions – Personnel

– Potential Hazards and Safety Precautions – Equipment

– Safety Labels
MicroXCT-200 and MicroXCT-400 User’s Guide ix



Safety
Safety Guidelines

Observe and follow these safety guidelines when using the MicroXCT:

WARNING Electrical and X-ray hazard present. Use the MicroXCT as 
cautioned herein, to avoid personal injury and/or damage to the MicroXCT.

WARNING Failure to observe and follow these guidelines is in violation of 
product use and warranty, and puts you at risk of serious injury. Xradia® is not 
liable for personal injury nor damage to the MicroXCT caused by misuse.

WARNING In the rare event that you or someone working with the 
MicroXCT is injured as a result of using the MicroXCT, and the injury requires 
immediate medical attention, follow the emergency procedures established 
by your work site.

– Use the MicroXCT only for applications and uses for which it is designed.

– Use only the components and/or machine accessories prescribed 
or provided by Xradia.

– Use the MicroXCT within environmental conditions specified 
in Appendix G, “Specifications.”

– Do not use the MicroXCT with objects nor raw materials other than those 
for which it is intended.

– If the MicroXCT is covered by an Xradia field service contract, do not 
attempt to maintain, service, repair, nor modify the MicroXCT, because 
these tasks must be performed only by trained Xradia personnel.

– Although the X-ray source automatically turns OFF when the access 
door(s) is (are) open, ensure that the access door(s) is (are) completely 
closed and not damaged nor blocked in any way.

WARNING If the access door(s) does (do) not completely close or is (are) 
damaged, turn OFF the MicroXCT and contact the Xradia Support Team.
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Safety
– Do not intentionally defeat the access door safety interlocks.

– In the event of a personal safety or MicroXCT emergency, 
use the EMO button to turn OFF power to the MicroXCT.

WARNING The EMO shutdown process (pressing of the EMO button) can 
damage the MicroXCT, particularly the workstation and/or optional storage 
server, potentially causing data loss and/or irreversible damage – use only 
in the event of a personal safety or equipment emergency.

NOTE Use of the non-emergency shutdown is recommended 
in non-emergency events. (Refer to “Shutting Down the MicroXCT 
in a Non-Emergency Event,” on page 246.)

– Use only a grounded AC power outlet.

– Use the MicroXCT on an electrical circuit that is not shared by any 
other equipment.

– All users should be sufficiently trained regarding how to use the 
MicroXCT, by trained Xradia personnel.

– Use of the MicroXCT by children is prohibited.

– Keep hands and other body parts, as well as other objects, away from 
hardware mechanisms (such as the sample stage, detector, and X-ray 
source) when moving the sample, detector, and X-ray source axes.

– Keep the operating temperature range at an ambient room temperature, 
between 18 to 25°C, with a variation of less than 2°C, for optimum 
image quality.

– Avoid operating the MicroXCT in areas where spray or liquids can enter 
or adhere to it.
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EMO Shutdown

WARNING Risk level is HIGH.

WARNING The EMO shutdown process (pressing of the EMO button) can 
damage the MicroXCT, particularly the workstation and/or optional storage 
server, potentially causing data loss and/or irreversible damage – use only in 
the event of a personal safety or equipment emergency. Refer to “Loss of Data 
and/or Irreversible Damage Due to EMO Shutdown,” for how to recover lost 
data, or what to do if there is irreversible damage.

Pressing the Emergency Off (EMO) button turns OFF:

– All hazardous energy sources, including the X-ray source and 
high-voltage power supply

– All moving parts within the MicroXCT, such as the motor 
control modules

– The workstation, and if included, the optional storage server

The EMO button is located on the front panel (and back panel, MicroXCT-400 
only) of the enclosure, within easy reach. The EMO button, as well as the 
RESET button, are illustrated in the following figure.

EMO and RESET Buttons

To shutdown the MicroXCT in an emergency event

1. Firmly press the EMO button, to immediately turn OFF power 
to the MicroXCT.

After the emergency event has passed, proceed to “Turning ON 
the MicroXCT,” on page 247.

MicroXCT-200 MicroXCT-400
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Enclosure Covers and Access Door(s)

WARNING Do not remove any baffles within or covers on the MicroXCT. 
Removal will expose personnel to harmful X-ray radiation, which can result 
in fatal injuries.

WARNING If the access door(s) does (do) not completely close or is (are) 
damaged, turn OFF the MicroXCT and contact the Xradia Support Team.

WARNING If any part of the enclosure is damaged, turn OFF the MicroXCT 
and contact the Xradia Support Team.

WARNING Do not modify any part of the enclosure.

The steel and lead-lined enclosure covers and access door(s):

– Provide protection from X-ray beams and high voltage generated 
by the MicroXCT

– Maintain the MicroXCT at operating temperature

The access door(s) include(s) a fail-safe (safety) interlock. The X-ray source 
will turn ON only if the access door(s) is (are) closed. The X-ray source 
automatically turns OFF when the access door(s) is (are) opened.

NOTE Although the X-ray source automatically turns OFF when the access 
door(s) is (are) opened, it is recommended that the X-ray source first be 
turned OFF, prior to opening the access door(s).

NOTE Instructions for turning OFF the X-ray source are provided in 
“Loading the Sample Holder Assembly onto the Sample Stage,” step 6, on 
page 45. Instructions for turning ON the X-ray source are provided 
in “Turning on the X-ray Source,” on page 58.

For personal and equipment safety:

– Do not remove any bolted-down covers or doors

– Ensure that the access door(s) is (are) completely closed 
and not damaged nor blocked in any way

– Do not intentionally defeat the access door safety interlocks
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Potential Hazards and Safety Precautions – Personnel

The MicroXCT is designed to be safe for customer use. However, potential 
hazards do exist. This section describes the potential hazards to personnel, 
such as radiation and high voltage, and methods to isolate and control 
the hazards.

Read and understand all the safety information and follow the procedures 
when using the MicroXCT. Severe or catastrophic injury to personnel, or 
damage to the equipment or facility can result if the prescribed procedures 
are not followed.

The MicroXCT uses 20 to 90 kV (90 kV X-ray source) or 40 to 150 kV 
(150 kV X-ray source) X-rays for imaging. A high-voltage power supply 
is required to generate the high-energy radiation, and a shielding 
enclosure is required to contain the radiation. The potential hazards 
to the personnel include:

– High Voltage

– Ionizing Hazard

– Pinch Hazards

– Magnetic Field

– Hazardous Materials

Each is described in the sections that follow.
xiv MicroXCT-200 and MicroXCT-400 User’s Guide



Safety
High Voltage

WARNING Risk level is High.

CAUTION Press the EMO button to shut down the MicroXCT in a personal 
safety or equipment emergency. Refer to “EMO Shutdown,” for further details.

The X-ray source and some motion components require high voltage 
of up to 90 kV (90 kV X-ray source) or 150 kV (150 kV X-ray source) 
in normal operation. The high-voltage power is located within the 
X-ray source, within the enclosure.

Observe the following safety guidelines:

– Do not attempt to defeat the access door safety interlocks, and keep 
the access door(s) closed when the X-ray source is turned ON

– Do not remove the enclosure panels

– Do not touch any parts inside the enclosure, unless instructed 
to do so by this guide

Potential Damage Severe to catastrophic injuries can result from 
electrocution by the high-voltage source. Electric shock from hazardous 
voltage sources can result in minor to moderate injuries.

Hazard Control All high-voltage sources are sealed. Electrical faults 
are shorted to ground. Do not touch anything within the MicroXCT 
unless instructed to do so otherwise within this guide or 
by Xradia personnel. Firmly press the EMO button in an emergency, 
to shut down the MicroXCT.
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Ionizing Hazard

WARNING Do not modify any part of the enclosure.

CAUTION Risk Level is LOW due to equipment protections in place.

CAUTION Press the EMO button to shut down the MicroXCT in a personal 
safety or equipment emergency. Refer to “EMO Shutdown,” for further details.

The X-ray source generates X-rays, from 20 to 90 kV (90 kV X-ray source) or 
40 to 150 kV (150 kV X-ray source), used by the MicroXCT to image samples 
and reference images.

Observe the following safety guidelines:

– Do not attempt to defeat the access door safety interlocks, and keep 
the access door(s) closed when the X-ray source is turned ON

– Do not remove the enclosure panels

Potential Damage Exposure to X-ray radiation causes moderate to severe 
illness to personnel, mostly in the form of soft tissue damage, or cancer 
in severe cases, or death due to radiation poisoning.

Hazard Control The enclosure, with its safety interlocks and lead shielding, 
protects users from harmful X-ray radiation. To ensure the enclosure’s 
integrity, Xradia personnel performs a radiation survey during regularly 
scheduled service every six months, for MicroXCT units under warranty 
or service packages.
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Pinch Hazards

CAUTION Risk level is LOW.

The radiation-shielding enclosure, which includes the access door(s), is made 
of steel and lead plates that are extremely heavy. Placing body parts in the path 
of a closing access door can cause bodily injury. Minor injuries can occur in 
rare occasions, and serious injuries are extremely unlikely.

Although unlikely, it is also possible to be pinched by the clamp or clip sample 
holder provided with the MicroXCT.

Potential Damage Physical pain or minor injuries can result from the pinch.

Hazard Control Pay attention when opening or closing the enclosure access 
door(s). Air dampers slow the movement of the door(s) during the last inch 
or so of travel, to avoid slamming of the door(s).

Keep your fingers free of the part of the clamp or clip sample holder, that 
closes onto the sample, to avoid being pinched.

If a body part is caught in a closing access door

1. Reverse the motion of the access door(s), to free the body part(s).

If a finger is caught in a sample holder

1. Reverse the motion that closed the sample holder onto your finger.
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Magnetic Field

CAUTION Risk level is LOW.

The MicroXCT includes several motors that generate low levels 
of magnetic field.

Potential Damage The magnetic field strength is extremely low. 
Injury to personnel or damage to equipment is extremely unlikely.

Hazard Control Be aware of the presence of the magnetic field around 
the motors.

Exercise caution if

– A person near the motors uses a pacemaker

– A person near the motors is holding objects sensitive to magnetic fields, 
such as a floppy disk, external hard disk drive, credit card, hotel key card, 
and so forth
xviii MicroXCT-200 and MicroXCT-400 User’s Guide



Safety
Hazardous Materials

CAUTION The materials listed here are not customer-accessible, and should 
only be accessed by trained Xradia personnel.

CAUTION Be aware of the presence of these hazardous materials. 
Contact Xradia prior to decommissioning and disposing of the MicroXCT 
for special cautions, instructions, and possible recycling of parts.

The MicroXCT contains the following hazardous materials:

– Beryllium – A beryllium window is used on the X-ray source. The total 
quantity of beryllium is approximately 4g.

– Thallium-doped Cesium Iodide – This material is used as the 
scintillator and is integrated into the detector. The quantity of thallium 
is approximately 2.5 mg. The thallium content is approximately 
1% of the weight of the cesium iodide.

– Lead – This material prevents X-rays from escaping the enclosure and 
exposing personnel to X-ray radiation. The interior of the steel enclosure 
contains 6-mm-thick lead sheets on all sides, top, and bottom. The right 
side contains an additional 3 mm of lead sheet, for a total of 9 mm. 
The lead sheets are covered by steel sheets or paint.
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Potential Hazards and Safety Precautions – Equipment

The MicroXCT is designed to be safe for customer use. However, potential 
hazards do exist.

Read and understand all the safety information and follow the procedures 
when using the MicroXCT. Severe or catastrophic injury to personnel, or 
damage to the equipment or facility can result if the prescribed procedures 
are not followed.

Potential hazards to equipment include:

– Loss of Data and/or Irreversible Damage Due to EMO Shutdown

– Collision of Moving Parts

– Improper Grounding

Each is described in the sections that follow.
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Loss of Data and/or Irreversible Damage 
Due to EMO Shutdown

WARNING Risk level is HIGH.

WARNING The EMO shutdown process (pressing of the EMO button) can 
damage the MicroXCT, particularly the workstation and/or optional storage 
server, potentially causing data loss and/or irreversible damage – use only 
in the event of a personal safety or equipment emergency.

Potential Damage If you used the EMO Shutdown process, it is possible 
that there will be data loss on the hard disk drive(s), and/or irreversible 
damage to the MicroXCT.

Hazard Control Use the EMO shutdown process only in the event of 
a personal safety or equipment emergency. If possible, to avoid damage 
to the MicroXCT, use the process described in “Shutting Down the MicroXCT 
in a Non-Emergency Event,” on page 246, instead.

To recover lost data

– If a backup copy of the data files that were lost is available, 
copy or restore the files back onto the hard disk drive

– Contact your Information Technology (IT) department for assistance

– Contact the Xradia Support Team for assistance

NOTE To help protect data files generated by the MicroXCT, you are 
welcome to install a backup program, or other backup process that 
is required by your IT department, on the MicroXCT.

If there is irreversible damage to the MicroXCT

– Contact the Xradia Support Team for resolution
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Collision of Moving Parts

CAUTION Risk level is LOW.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

NOTE Tips for troubleshooting collision and imminent collision are described 
more fully in “Troubleshooting Sample Issues in XMController,” on page 210.

Motorized components (sample and detector and/or sample and X-ray source) 
can collide when they are moved during normal operation, if you are 
not careful. Collisions are likely due to moving the sample, detector, and/or 
X-ray source too close to one another. In most cases, should collision occur, 
damage to equipment will be minor.

Potential Damage Collisions can cause misalignment and, in more severe 
cases, damage to subcomponents. Should the MicroXCT require realignment, 
contact the Xradia Support Team.

Hazard Control Use caution when moving motors, particularly the sample, 
detector, and/or X-ray source components.

Guidelines for reducing collision risk

– Ensure that the sample holder is correctly loaded onto the sample stage 
(flat part facing front, tungsten balls on the stage aligned with the sample 
holder base).

– Always position the mouse pointer over , in the same axis panel, 
after clicking GO in the Motion Controller dialog box. This will enable 
you to quickly click it and stop movement, if collision is imminent.

– Whenever moving the detector and X-ray source, use small increments 
when moving toward the sample.
xxii MicroXCT-200 and MicroXCT-400 User’s Guide



Safety
Improper Grounding

WARNING Risk level is High.

CAUTION Press the EMO button to shut down the MicroXCT in a personal 
safety or equipment emergency. Refer to “EMO Shutdown,” for further details.

NOTE The MicroXCT should already be connected to power, at installation.

There should be no problem with improper grounding when the MicroXCT 
is properly connected to a grounded power source, per specifications.

Observe the following safety guidelines:

– Ensure that the three-prong power connector (located at the back 
of the MicroXCT) is connected to a grounded 100 to 240 VAC, 
12A power source

– If using an uninterruptible power source (UPS), line conditioner, surge 
protector, or similar device, ensure that the MicroXCT is connected 
to the device, and that the device’s power connector is connected to 
a grounded 100 to 240 VAC, 12A power source
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Safety Labels

The following table illustrates and describes the WARNING and CAUTION 
safety labels, located in/on the MicroXCT.

Safety Labels 

Icon Description and Location in/on MicroXCT

Warns Xradia service personnel to turn OFF and lock out MicroXCT 
power prior to attempting to service the MicroXCT.
Adhered to the top of the Power Distribution Unit (PDU).

Warns you to not remove the enclosure, to protect yourself and 
others from harmful X-ray radiation.
Adhered to the baffles or covers bolted onto the MicroXCT.

Warns you to turn OFF the X-ray source before opening the access 
door(s), to protect yourself and others from harmful X-ray radiation.
Adhered to the front of the MicroXCT. 

Warns you to not place your hands on the ledge, because the door 
rolls over the ledge when it is being opened.
Adhered to the right side of the MicroXCT-200, beside the access 
door. It is visible only when the access door is closed. 
xxiv MicroXCT-200 and MicroXCT-400 User’s Guide



Preface

This user’s guide provides information for using the Xradia® MicroXCT™-200 
and MicroXCT™-400 High-Resolution 3D X-ray Imaging Systems. It describes 
the features, functions, and use of these products.

The following details document organization and conventions, 
and assumptions.
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Document Organization

The process tasks described in each chapter follow a typical workflow. 
Additional information is provided in the appendices.

This guide is organized as follows:

– Safety provides guidelines and information for safely using and operating 
the MicroXCT.

– Chapter 1, “Overview,” provides an overview of the technology 
used by the MicroXCT, as well as the main components, programs, 
and processes used to generate and view tomographic data.

– Chapter 2, “Setting Up for Data Acquisition,” describes the pre-data 
acquisition procedures, including (but not limited to) mounting, 
loading, and coarse positioning of the sample using XMController, 
and turning on the X-ray source.

– Chapter 3, “Selecting the First Tomography Point,” how to use 
XMController to select the first tomography point for a tomography 
dataset, and for use later, when running a recipe.

– Chapter 4, “Automatically Acquiring Additional Data and 
Reconstructing Tomography Point(s),” how to use XMController 
to record the tomography point selected in Chapter 3, select 
the remaining tomography points for tomography datasets, 
and run an automatic recipe.

– Chapter 5, “Manually Acquiring Images and Tomographic Data,” 
describes how to use XMController to acquire images and tomographic 
data using Continuous, Single, Averaging, and Mosaic acquisition modes, 
and how to create and apply a reference image.

– Chapter 6, “Manually Reconstructing a 3D Dataset,” describes how to use 
XMReconstructor to manually reconstruct 3D tomography datasets when 
a dataset is manually acquired, a dataset is automatically acquired but not 
reconstructed, the center shift is incorrect, or the automatic 
reconstruction had problems.

– Chapter 7, “Viewing Tomographies,” describes how to use XM3DViewer 
to view and edit 2D reconstructed slices and 3D volume datasets for use 
in reports and movies.
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– Appendix A, “Troubleshooting,” describes how to resolve common issues 
that may be encountered when using the MicroXCT, and provides Xradia 
Support Team contact information.

– Appendix B, “MicroXCT Files and File Storage,” describes the file types 
unique to the MicroXCT programs, recommended file handling, and how 
to export the files to graphic formats.

– Appendix C, “Shutting Down and Restarting the MicroXCT,” describes 
how to shutdown and restart the MicroXCT, and then home all 
motorized axes to pre-defined initialization positions.

– Appendix D, “Visual Light Camera Monitor Brightness Controls,” 
describes how to change the brightness, to reduce image glare, 
on the visual light camera monitor that has icon control buttons.

– Appendix E, “Removing the Sample after Use,” describes how 
to remove the sample from the MicroXCT, after you have finished 
imaging the sample.

– Appendix F, “Determining Whether the MicroXCT is 360°-Enabled,” 
describes how to determine whether the MicroXCT is 180° or 
360°-enabled.

– Appendix G, “Specifications,” lists the MicroXCT-200 and MicroXCT-400 
specifications that are of use to customers.

– Appendix H, “Electrical Documentation,” provides electrical 
documentation specific to the Emergency Off (EMO) system and 
safety interlocks.

– Appendix J, “License, Warranty, and Service Information,” provides the 
software license agreement, limited warranties, service and maintenance 
information, and Xradia contact information.

– Appendix K, “Glossary,” describes terms used within this guide.
MicroXCT-200 and MicroXCT-400 User’s Guide xxvii



Preface
Document Conventions

The following sections contain descriptions of the document conventions 
applied in this guide.

Instructions and Information
Instructions and information are conveyed as follows:

– Numbered steps denote tasks performed in the order listed

– Bulleted lists denote information that does not need to be processed 
in sequence

Special Text Formats
Special text formats use the following conventions:

– Critical information, menu names, and text displayed on-screen appear 
in bold. For example:

Click OK.

– Values to be typed are in italics. For example:

Type 130 in the Source Z text box.

– Generic references to a specific item or task are in italics. For example:

Select the appropriate save option.

– The following colors, when used to reference an item that is that color, 
appear in bold and the specified color:

blue, green, orange, red, yellow 
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Cross-References
Cross-references (chapters, appendices, headings, step numbers, and so forth) 
appear in blue. This information is hyperlinked, and if you use the pointer 
tool in a PDF, you can “jump” to the referenced text. 

Page numbers are included with the referenced subheadings, if the text 
appears outside the current main section. For example, if you are reading 
text in Chapter 1, and the referenced text is in Chapter 3, the reference 
includes a page number.

Terminology
Graphical user interface (GUI) terms, select and click, are used as follows:

– Select

Choose/highlight an item for use. For example:

– Select a file type from the Files of type drop-down list box

– Select Microscope > Motion Controller… 

– Click

Select a button, box, or other item that incurs an action that issues 
a command or sets an option. For example:

– Click OK 

– Click  in the icon bar
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Notes, Cautions, and Warnings
Notes, Cautions, and Warnings appear throughout the guide. Examples 
of format and content are provided below. For Cautions and Warnings, 
it is particularly important to read and understand each, and the possible 
dangers that can be encountered when using the MicroXCT.

NOTE Used when information is sufficiently important to require attention.

CAUTION Used when information is critical to avoid device or equipment 
damage, or to avoid severely impacting processing. If the caution indicates 
“contact the Xradia Support Team,” stop using the MicroXCT, then contact 
Xradia at the number provided in “Contacting the Xradia Support Team (Technical 
Support),” on page 231.

WARNING Used when information is critical to avoid personal injury 
or severe equipment damage. If the warning indicates “contact the Xradia 
Support Team,” stop using the MicroXCT, then contact Xradia at the number 
provided in “Contacting the Xradia Support Team (Technical Support),” on 
page 231.

Assumptions

This guide assumes that you have:

– Been sufficiently trained by Xradia personnel in basic use 
of the MicroXCT

– Experience using Microsoft Windows XP (or previous versions of 
Windows) and a basic working knowledge of how to use its user 
interface, including browsing for data paths and files, using the mouse 
pointer to click and drag, and closing open windows and dialog boxes, 
opening, saving, and closing files, and so forth
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1 Overview

This chapter provides an overview of the technology used by the Xradia® 
MicroXCT™-200 and MicroXCT™-400, as well as the main components, 
programs, and processes used to generate and view tomographic data.
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Chapter 1 – Overview
Technology Overview

The following provides a brief overview of how the Xradia MicroXCT 
is used as a diagnostic tool, how the MicroXCT works, and the current 
MicroXCT product family.

X-ray Microscopy
When used together, microscopy enables observation of features smaller 
than those visible to the naked eye, and X-ray enables observation of features 
internal to structures.

While medicine and dentistry remain the most common usages of X-ray, 
it is also widely used in other applications, from airport security to industrial 
inspection and quality control systems. CAT scanning, or X-ray tomography, 
has made it possible to use X-rays to create three-dimensional (3D) 
representations of structures as complex as the internals of the human body.

How X-ray Microscopy Works
X-ray microscopes form images, based upon the X-rays transmitted by the 
sample. Where the sample absorbs more X-rays, the image is darker; where it 
transmits more, the image is brighter. Absorption increases with density and 
thickness, and it is also generally higher for elements with a higher atomic 
number in the periodic table.

In X-ray microscopes (unlike electron microscopes), the sample is generally 
at normal atmospheric pressure. It can be heated or cooled, as necessary. 
Wet samples are mounted between X-ray transparent windows or in 
thin-walled capillaries. X-rays are not affected by factors such as electric 
nor magnetic fields; therefore, samples, including semiconductor packages 
and various other materials, can be imaged under real operating conditions, 
or while subject to mechanical forces.
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Chapter 1 – Overview
What Xradia MicroXCT Does
Xradia’s advanced X-ray computed tomography (CT) products help advance 
innovation in science and industry. Xradia’s CT technology has been used by 
scientists and engineers to provide insight in 3D, into the internal structure 
of samples in a large variety of applications.

– In life science research, Xradia’s MicroXCT enables imaging of hard and 
soft tissue with an unmatched combination of resolution and sample 
size. Xradia’s proprietary detector technology, as well as phase contrast 
imaging, provides the unique ability to image soft tissue with good 
contrast, even in combination with calcified tissue and bone structures.

– In advanced materials research and development, Xradia’s multi-length 
scale solution enables the development of a full model of the material, 
from millimeter down to nanometer scale. Material defects, such as 
cracks and voids, can be visualized at these length scales.

– Semiconductor package development and failure analysis engineers use 
the MicroXCT product family to verify micron-sized defects, without the 
need for physical delayering or cross-sectioning, thus maintaining the 
integrity of the samples.

– CT technology can be used in rock physics modeling, and for drilling 
feasibility analysis in oil and gas exploration.

Key to effective imaging is the ability to use a succession of increasing 
resolutions, combined with smaller and smaller fields of view that allow 
“zooming” into the particular region of interest. As product and sample 
complexity increases, 3D-imaging modalities are required, to fully 
understand the 3D intricacies of structures.

Xradia MicroXCT Product Family
This guide describes use of CT technology, for the following models within the 
MicroXCT product family:

– MicroXCT-200 – A flexible and easy-to-use system for general-purpose 
imaging at sub-1 micron pixel resolution, for samples up to 100 mm 
in diameter, 150 mm in height, and 1 kg in weight.

– MicroXCT-400 – A large system ideal for in-situ studies. The imaging 
resolution is identical to the MicroXCT-200; however, the sample 
size can be up to 500 mm in diameter, 400 mm in height, and 
15 kg in weight.
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MicroXCT Hardware and Software

The MicroXCT includes the hardware and software needed to create 
tomography images and to view them.

Hardware Description
This section describes the MicroXCT major hardware components.

Major External and Internal Hardware Components
Figure 1-1 and Figure 1-2 provide a visual external view of the MicroXCT-200 
and MicroXCT-400, respectively. Table 1-1 lists the major external hardware 
components, as they relate to Figure 1-1 and Figure 1-2.

Figure 1-3 and Figure 1-4 provide a visual internal view of the MicroXCT-200 
and MicroXCT-400, respectively, with the access door(s) open. Table 1-2 
lists the major internal hardware components, as they relate to Figure 1-3 
and Figure 1-4.

WARNING Do not touch anything within the enclosure, except for 
the following:

– Sample stage, while loading the sample holder assembly,

– X-ray source, when installing a source filter, and

– Non-motorized turret (if MicroXCT unit does not include a motorized 
turret), when manually selecting a non-Macro magnification lens,

unless instructed to do so by Xradia personnel. Otherwise, you will 
violate the product warranty.
4 MicroXCT-200 and MicroXCT-400 User’s Guide
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A

Figure 1-1 MicroXCT-200 External View, with Access Door Open, 
and Lower Doors Removed
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A

Figure 1-2 MicroXCT-400, External View, with Lower Doors Removed
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Table 1-1 MicroXCT-200 and MicroXCT-400 – Major External Components, 
Illustrated in Figure 1-1 and Figure 1-2 

Callout 
Letter Part Description

A Ergonomic Station
User console for controlling the MicroXCT for data acquisition 
and analysis. 
Refer to “Ergonomic Station,” for further details.

B EMO Button

Emergency OFF. Turns OFF power to the entire MicroXCT in an 
emergency, as well as in non-emergency events. Release to enable 
the RESET button, when starting the MicroXCT.
Refer to “Safety” Appendix C, “Shutting Down and Restarting the 
MicroXCT,” and Appendix H, “Electrical Documentation,” 
for further details.
MicroXCT-400 only – A second EMO button is located on the 
back panel, below the rear access doors (not shown).

C RESET Button

Resets MicroXCT power after a shutdown; use the EMO reset 
procedure. Also used when starting the MicroXCT.
Refer to Appendix C, “Shutting Down and Restarting the MicroXCT,” 
for further details.
MicroXCT-400 only – A second RESET button is located on the 
back panel, below the rear access doors (not shown).

D Light Tower

Indicator located on top of the MicroXCT, that visually reports 
status conditions:
– All lights OFF – Power to the MicroXCT is OFF
– Red light ON (top) – X-ray source is ON, and X-rays are present 

within the enclosure
– Red light OFF (top) – X-ray source is OFF, and X-rays are not 

present within the enclosure
– Yellow light ON (center) – Access door(s) is (are) closed
– Yellow light OFF (center) – Access door(s) is (are) open
– Green light ON (bottom) – Power to the microscope is ON
– Green light OFF (bottom) – Power to the microscope is OFF

Refer to Appendix H, “Electrical Documentation,” for further details.

E Enclosure

Insulated steel and lead-lined framework that covers the exterior 
of the MicroXCT, providing protection from harmful X-ray radiation.
Refer to “Enclosure Covers and Access Door(s),” on page xiii 
for further details.

F
Motion Controller 
Hardware

Provides the interface between the workstation and all motors. 
Located in the right cabinet. DO NOT TOUCH.

G Workstation
Windows XP-based computer included in the MicroXCT. 
Must be powered ON, by pressing its Power button.
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H Access Door(s)

Part of the enclosure. Closes off the X-ray source, providing 
protection from harmful X-ray radiation. The door(s) differ, by model:
– MicroXCT-200 – Single sliding door to the right, with 

a door handle. To open the door, using the door handle, 
slide to the RIGHT to OPEN, to the LEFT to CLOSE. 
 
There is also a sliding door to the left, which is bolted shut 
and is not needed for use. This other door is not mentioned 
elsewhere in the guide.

– MicroXCT-400 – Two hinged doors on the front. To open either 
door, using the door handles, pull toward you to open, and push 
toward the MicroXCT-400 to close. You can have both doors open 
simultaneously; however, if opening only one door, open the 
door on the right. 
 
There are also two hinged doors located at the back of the 
MicroXCT-400 (not shown). These doors can also be opened 
to access the sample stage, from the opposite side of the 
MicroXCT-400. These doors provide easier access to set up 
additional equipment, such as load cells on the sample stage. 
For the most part, these additional two doors on the back 
are not mentioned elsewhere in the guide.

J
Power Distribution 
Unit (PDU)

Distributes power to electrical components. The PDU is located 
inside the enclosure, behind a cabinet door, on the lower left side 
of the MicroXCT. Typically, you do not need to do anything with 
this part.

WARNING If either of the following occur, contact the 
Xradia Support Team:

– Alarm button is lit, indicating a light tower malfunction.
– Any of the PDU’s power breakers are tripped (in the 

DOWN position). DO NOT RESET THE BREAKER.

K
Source Controller 
Hardware

Provides the interface between the workstation and X-ray source. 
Included only with the 150 kV X-ray source. Located in the left 
cabinet. (Location shown only in Figure 1-2.) DO NOT TOUCH.

– Storage Server

Optional data storage. Networked to the workstation, if included, 
and recognized as an additional hard disk drive. (Not shown 
in either figure.)
Located inside the enclosure, beside the workstation.

Table 1-1 MicroXCT-200 and MicroXCT-400 – Major External Components, 
Illustrated in Figure 1-1 and Figure 1-2 (Continued)

Callout 
Letter Part Description
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Figure 1-3 MicroXCT-200 Internal View, with Access Door Open
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Figure 1-4 MicroXCT-400 Internal View, with Access Doors Open
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Table 1-2 MicroXCT-200 and MicroXCT-400 – Major Internal Components, 
Illustrated in Figure 1-3 and Figure 1-4 

Callout 
Letter Part Description

A Safety Interlocks
When the access door(s) is (are) opened, the safety interlocks turn OFF 
the X-ray source.
Refer to Appendix H, “Electrical Documentation,” for further details.

B X-ray Source

Mechanism that generates X-rays, from 20 to 90 kV (90 kV X-ray source) 
or 40 to 150 kV (150 kV X-ray source; shown in both figures), used by 
the MicroXCT to image samples and create reference images. Includes 
a source filter holder.
Refer to “X-ray Source,” and Appendix H, “Electrical Documentation,” 
for further details.

C Sample Stage
Platform upon which the sample (imaging target), mounted on a sample 
base, is secured for microscopy.

D
Visual Light 
Camera

Supplies images to the visual light camera monitor. Located behind 
the sample stage, at the rear of the enclosure. Used for positioning the 
sample, detector, and X-ray source.

E
Detector 
Assembly 
(Detector)

Assembly that picks up X-ray images of the sample.
Refer to “Detector Assembly,” for further details.

F Turret

Part of the detector assembly. Holds up to six lenses. The lens located 
at the lowest point on the turret is used to focus on the sample.
Turret lens selection is controlled by the drop-down arrow to the 

right of the XMController  icon.
Refer to “Detector Assembly,” for further details.

– Standard lenses (included with every MicroXCT) – 4X, 10X, 20X
– Optional lenses (available upon request) – 1X, 2Xa, b, 40X

G Macro Lenses

Optional square (Macro-70) or round (Macro-55 (0.5X)b, c, d) lenses that 
provide a second beam line for imaging with a larger field of view (FOV) 
than the other lenses, at a lower magnification.
There can only be one Macro lens in each MicroXCT. If included, the Macro 
lens is mounted beside the turret.
Macro lens selection is controlled by the drop-down arrow to the right 

of the XMController  icon. 
For further details regarding use of this icon, refer to Table 1-7.

a. The 2X lens is not available when the MicroXCT has an optional Macro lens.
b. The Macro-55 (0.5X) and 2X lenses have a round FOV. Therefore, their 3D FOV range is the diameter 

of the FOV.
c. The Macro-55 (0.5X) lens is obsolete, and was replaced by the Macro-70 as an option. 

The lens is still in use in some MicroXCT units.
d. MicroXCT-400 only.
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X-ray Source
The X-ray source generates X-rays, from 20 to 90 kV (90 kV X-ray source) 
or 40 to 150 kV (150 kV X-ray source), used by the MicroXCT to image 
samples and create reference images. The type of X-ray source is determined 
at the time of purchase. The 90 kV X-ray source is typically used for imaging 
softer materials (lower density). The 150 kV X-ray source is typically used for 
large and/or harder materials (high density). Both are illustrated in Figure 1-5. 
Table 1-3 lists the minimum and maximum voltage and power settings, by 
X-ray source.

The X-ray source includes a holder for installing a source filter – material 
(available in a filter kit from Xradia) that improves reconstructed image quality, 
by removing low-energy X-rays that do not provide useful information through 
the sample.

NOTE If MicroXCT power or the X-ray source has been turned OFF for 
more than eight hours, the X-ray source must go through an initial warm-up 
process, called X-ray source aging. This process can take 30 minutes or more, 
depending upon the length of time that the X-ray source was turned OFF.

NOTE 15 minutes is the minimum warm-up period, if the X-ray source has 
been turned OFF for more than 15 minutes, for optimal X-ray source stability 
during scans.
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Figure 1-5 90 kV and 150 kV X-ray Sources

Table 1-3 Minimum and Maximum Voltage and Power Settings, 
by X-ray Source

X-ray Source

Voltage
(kV)

Power
(W)

Minimum Maximum Minimum Maximum

90 kV 20 90 1 8

150 kV 40 150 4 10

90 kV X-ray Source 150 kV X-ray Source
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Detector Assembly
The detector assembly (“detector”) picks up X-ray images of the sample. 
“Lens” and “detector” are sometimes used interchangeably. The 1X through 
40X magnification lenses look similar and are all mounted on a turret, 
similar to optical microscopes that have different objectives (lenses). 
In most MicroXCT installations, the turret is motorized. (Refer to Figure 1-6.) 
The turret can hold up to six lenses.

Table 1-4 lists the magnification level, and spatial resolution and field of view 
(FOV) ranges for each magnification lens.

Figure 1-6 Detector Assembly
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Table 1-4 Spatial Resolution and FOV Ranges, by Magnification Level

Magnification Level/Lens
Resolution Range

(μm)
3D FOV Range

(mm)

Standard Lenses (included with every MicroXCT)

4X 5.0 – 6.0 2.4 – 6.0

10X 2.5 – 3.0 2.0 – 2.7

20X 1.5 1.3

Optional Lenses (available upon request)

Macro-70a

a. The Macro lens, if included, provides a second beam line for imaging, and is mounted 
beside, rather than on, the turret.

20.0 – 50.0 17.0 – 50.0

Macro-55 (0.5X)a, b, c, d

b. The Macro-55 (0.5X) lens is obsolete, and was replaced by the Macro-70 as an option. 
The lens is still in use in some MicroXCT units.

c. The Macro-55 (0.5X) and 2X lenses have a round FOV. Therefore, their 3D FOV range 
is the diameter of the FOV.

d. MicroXCT-400 only.

14.0 – 40.0 14.0 – 40.0

1X 9.0 – 22.0 4.0 – 15.0

2Xc, e

e. The 2X lens is not available when the MicroXCT has an optional Macro lens.

6.0 – 13.0 4.0 – 13.0

40X 1.0 0.7
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Ergonomic Station
Figure 1-7 provides a visual view of the MicroXCT ergonomic station. Table 1-5 
lists the station’s major components.

Figure 1-7 Ergonomic Station
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Table 1-5 MicroXCT Ergonomic Station – Major Components Illustrated in Figure 1-7 

Callout 
Letter Part Description

A Workstation Monitor

Display. Used to interface with the MicroXCT programs. 
Must be powered ON, by pressing its Power button.
Refer to “XMController,” “XMReconstructor,” 
and “XM3DViewer,” for further details. 

B Visual Light Camera Monitor

Displays images as seen by the visual light camera. 
Must be powered ON, by pressing its Power button.

Two models of visual light camera monitors are currently 
in use. One has self-descriptive control buttons, and 
the other has control buttons represented by icons. 
Instructions for using the latter to adjust monitor glare 
are provided in Appendix D, “Visual Light Camera Monitor 
Brightness Controls.”

C Shortcut Keys for -90° and 0°

– LEFT button rotates Sample Theta to -90°
– RIGHT button rotates Sample Theta to 0°
– Pressing the same button again, during rotation, 

immediately stops the selected rotation

D
Visual Light Camera 
Light Switch

– UP position turns interior light ON
– DOWN position turns interior light OFF

E Joystick for Visual Positioning

– Pushing the joystick forward (away from you) moves the 
sample stage DOWN, while pulling the joystick backward 
(toward you) moves the sample stage UP

– With Sample Theta at 0°, pushing the joystick LEFT and 
RIGHT moves the sample in the NEGATIVE and POSITIVE 
Z directions, respectively

– With Sample Theta at -90°, pushing the joystick LEFT and 
RIGHT moves the sample in the NEGATIVE and POSITIVE 
X directions, respectively

Refer to Figure 2-5, “Axis Definitions of X-ray Source, 
Sample, and Detector,” on page 40 for an illustration 
of the X and Z axis directions.

F Visual Light Camera Controller
Handset used for controlling the visual light camera.
Refer to “Visual Light Camera Controller,” for further details.

G Mouse

Three-button pointing device used to interface with the 
programs used on the MicroXCT. The device’s position 
is visible on the workstation monitor.
The mouse button functions are dependent upon the 
program and function in which the mouse is being used.
Unless stated otherwise in this guide, all references to mouse 
clicks are to the left-mouse button.

H Wrist Pad Ergonomic wrist rest.

J Keyboard Standard computer keyboard, in QWERTY layout.
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Visual Light Camera Controller
The visual light camera allows visual positioning of the detector and X-ray 
source, in relation to the sample, by using the visual light camera controller.

Figure 1-8 Visual Light Camera Controller

Table 1-6 Visual Light Camera Controller Button Functions 

Button Description

Press to enable autofocus.

Press to enable On-Screen Display mode focusing functions.

Press to enable Menu mode.

Press to adjust the focus in On-Screen Display mode.
In Menu mode, can also be used to switch between modes, in the directions indicated 
by the arrows.

Press to zoom IN on the image displayed in the visual light camera monitor.
In Menu mode, can also be used to switch between modes, in the direction indicated by the 
arrow.

Press to zoom OUT from the image displayed in the visual light camera monitor.
In Menu mode, can also be used to switch menu modes in the direction indicated by the 
arrow.
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Software Control
MicroXCT uses the following three programs to control the Xradia 
tomography process:

– XMController

– XMReconstructor

– XM3DViewer

Figure 1-9 illustrates the relationship between the three programs, and the 
data, processes, and files generated by each. Each program is described in 
the sections that follow.

Figure 1-9 MicroXCT Data, Processes, and Files
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XMController
XMController is the program used to manage the data acquisition process, 
from setting up the sample to the acquisition of data, either manually 
or through the automatic Recipe. It is also used to acquire X-ray images, 
and monitor and control the microscope’s hardware components. 
Use of XMController is described in Chapter 2 through Chapter 5.

Figure 1-10 illustrates the default XMController main window, and Table 1-7 
describes the user interface icons.

NOTE The main window’s menu bar changes, during use, to also include 
Process and Window menus.

Figure 1-10 Default XMController Main Window

X-ray Source StatusMenu Bar Icon Bar

Status Bar
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NOTE If an icon is highlighted orange in the icon bar, its associated dialog 
box is already open, and clicking the icon closes, rather than opens, the 
dialog box.

Table 1-7 XMController User Interface Icons 

Icon Description

Click to select the file to be opened/used. Opens the Open File dialog box.
Same as selecting File > Open….

Click to save the currently open file. Opens the Save File dialog box.
Same as selecting File > Save.

Click to set the acquisition parameters (mode, exposure time, binning, 
and mode-dependent settings) and start acquisition process. Opens the 
Acquisition Setting dialog box.
Same as selecting Microscope > Settings.

Click to acquire a single image, using the current acquisition settings.
Same as selecting Microscope > Acquire one Image.

Click to acquire continuous images, using the current acquisition settings, until stopped. 
Used in the sample positioning process.
Same as selecting Microscope > Continuous acquisition.

Click to automatically run and reconstruct 3D dataset tomographies. Opens the Recipe 
dialog box.
Same as selecting Microscope > Recipes….

Click to stop image acquisition. Closes the Acquisition Status message box.
Same as selecting Microscope > Abort.

Click to position the sample, and the X-ray source and detector in relation to the sample. 
Opens the Motion Controller dialog box, with Sample, Source, and Detector tabs.
Same as selecting Microscope > Motion Controller….

Click to control the X-ray source – turn the X-ray source ON/OFF, and set the X-ray source 
voltage and power. Opens the Xray Source dialog box.
Same as selecting Microscope > Source Controller….

Click to access tools for manipulating the acquired image. Opens the Image Controls 
dialog box. Tabs include Annotation, Info, Axis positions, Reference, and Notes.
Same as selecting View > Image Controls.
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Click to control and adjust image contrast and brightness.
Same as selecting View > Histogram tool.

Click the drop-down arrow to the right of the icon to select the magnification lens and/or 
see which magnification lens is selected (indicated with a check mark ( )).
When selecting a lens, the icon functions differently, depending upon whether 
the MicroXCT has a motorized or non-motorized turret and/or optional Macro lens:

Lenses listed in the drop-down list are dependent upon which lenses are installed:
– Standard lenses (included with every MicroXCT) – 4X, 10X, 20X
– Optional lenses (available upon request) – Macro-70, Macro-55 (0.5X)a, b, c, 

1X, 2Xb, d, 40X

a. The Macro-55 (0.5X) lens is obsolete, and was replaced by the Macro-70 as an option. 
The lens is still in use in some MicroXCT units.

b. The Macro-55 (0.5X) and 2X lenses have a round FOV. Therefore, their 3D FOV range is the diameter 
of the FOV.

c. MicroXCT-400 only.
d. The 2X lens is not available when the MicroXCT has an optional Macro lens.

Table 1-7 XMController User Interface Icons (Continued)

Icon Description

Turret
Optional

Macro Lens Icon Function

Motorized No
Click the drop-down arrow to the right of the icon, 
then select the magnification lens you want to use.

Motorized or 
Non-Motorized

Yes

Click the drop-down arrow to the right of the icon, 
then select the magnification lens you want to 
use. If you selected the optional Macro lens, the 
Waiting… dialog box opens. When the dialog box’s 
title changes to Done!, click Done.

Non-Motorized No

After manually moving the turret to the 
magnification lens you want to use, click the 
drop-down arrow to the right of the icon, 
then verify that the lens is marked as selected 
(indicated with a check mark ( )).
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XMReconstructor
XMReconstructor is the program used to reconstruct all the 2D images 
(projections) acquired during data acquisition/tomography, to create a 
3D reconstructed volume. Use of XMReconstructor is described in Chapter 6, 
“Manually Reconstructing a 3D Dataset.”

Figure 1-11 illustrates the main window, and Table 1-8 describes the user 
interface icons.

Figure 1-11 Default XMReconstructor Main Window (Opened File Shown for Reference Only)

Menu Bar Icon Bar

Status Bar
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NOTE If an icon is highlighted orange in the icon bar, its associated dialog 
box is already open, and clicking the icon closes, rather than opens, the 
dialog box.

Table 1-8 XMReconstructor User Interface Icons 

Icon Description

Click to select the file to be opened/used. Opens the Open File dialog box.
Same as selecting File > Open….

Click to set the reconstruction parameters and start the reconstruction 
process. Opens the Reconstruction Setting dialog box.
Same as selecting Reconstruction > Reconstruction Setting….

Click to reconstruct the tomography data. Opens the 
Reconstruction Status window.
Same as selecting Reconstruction > Start Reconstruction.

Click to identify and correct center shift and beam hardening. 
Opens the Rotation Center / Beam Hardening dialog box.
Same as selecting Reconstruction > Find Center Shift.

Click to abort the center shift find, beam hardening correction find, 
and reconstruction processes.
Same as selecting Reconstruction > Abort.

Click to access tools for manipulating the projection images 
or reconstructed image while finding the center shift or beam hardening 
correction constant. Opens the Image Controls dialog box. 
Tabs include Annotation, Info, and Navigation.
Same as selecting View > Image Controls.

Click to control and adjust image contrast and brightness.
Same as selecting View > Histogram tool.
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XM3DViewer
After acquiring, referencing, and reconstructing the tomography dataset, 
the end result is a ready-to-load 3D reconstruction of the region(s) of interest 
that can be viewed in XM3DViewer. Use of XM3DViewer is described 
in Chapter 7, “Viewing Tomographies.”

NOTE In its main window title bar, XM3DViewer appears as “TXM3DViewer,” 
rather than as “XM3DViewer”.

NOTE This guide provides basic information for using XM3DViewer to 
view tomographic data after reconstruction. For further details regarding 
the program’s use (beyond what’s provided here, and in Chapter 7, “Viewing 
Tomographies”), refer to the Xradia ExamineRT Workstation 1.1 User’s Manual, 
available under XM3DViewer’s Help menu.

Figure 1-12 illustrates the main window, and Table 1-9 describes the user 
interface icons.

Figure 1-12 Default XM3DViewer Main Window – Examine Tab, with Descriptions 
of Each Quadrant
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Table 1-9 XM3DViewer User Interface Iconsa 

Type Icon Description

Layout

Click to display a single 2D reconstructed slice window. Click multiple 
times to cycle through the orientation of the slice in the 2D reconstructed 
slice window. When clicked, adds Cine controls to the main window 
(left side, below the other icon bars and tools).

Click to display four equally sized windows (default) – three 2D 
reconstructed slice windows plus one 3D volume window. Displays the 

same four images as .
In Figure 1-12, the white text in each quadrant window identifies 
specifically what appears in each window.

Click to display three equally sized 2D reconstructed slice windows, plus 

one larger 3D volume window. Displays the same four images as .

Click to display a single 3D volume window (not used for 
2D reconstructed slices).

Mouse mode

Standard navigation mode (default). Enables selecting and moving 
navigation lines (cross-hairs) in the 2D reconstructed slice and 
3D volume windows. If it is not the current mode, click to enable.
Navigation line (plane) colors – green = X/Z, blue = X/Y, and red = Y/Z.

Click to enable Zoom/Translate mode. Behaves differently, depending 
upon whether it is used in a 2D reconstructed slice or 3D volume window, 
as follows:
– 2D reconstructed slice window – Enables panning and zooming
– 3D volume window – Enables image rotation, panning, and zooming

Click to enable Window/Level mode. Behaves differently, depending 
upon whether it is used in a 2D reconstructed slice or 3D volume window, 
as follows:
– 2D reconstructed slice window – Enables interactive adjustment 

of contrast and brightness, by changing the width and center, 
respectively, of the Data window.

– 3D volume window – Enables interactive adjustment of contrast 
and brightness, by changing the width and center, respectively, 
of the Transfer function.

Click to enable Annotation mode. You can add arrows and text annotations:
– Arrow – Click within a 2D reconstructed slice or 3D volume window 

at the point you want to start the arrow, then click again at the point 
you want to end the arrow.

– Text associated with an arrow – Double-click the arrow, then type 
the text you want to add.

Click to enable Measurement mode. In the 2D reconstructed slice or 
3D volume window, at the region of interest, click once to define the start 
point for measuring, then again to define the endpoint for measuring.
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Options

Click to enable Orthogonal Slicing mode (default). Restricts the slice 
orientation in 2D reconstructed slice windows to the reconstruction 
plane (X/Z plane of the MicroXCT).

Click to enable Oblique Slicing mode. All three planes are orthogonal to 
one another; however, they are not orthogonal to the reconstruction plane.

Click to enable Dataset information mode. Toggles the display of dataset 
information text in the 2D reconstructed slice and 3D volume windows.

Click to enable Bounding box mode. Toggles the display of a wire frame 
of the bounding box in the 3D volume windows.

Click to enable Snapshot mode. Changes the mouse cursor to a camera. 
Click the icon, move the mouse onto the image, then click to take 
a picture (snapshot) of the image. This saves the entire image in the 
Snapshots panel.

Crop

No crop (default). Click to omit any previously applied cropping.

Click to focus on the region of interest within the 3D reconstructed 
volume, by isolating a region smaller than the complete image.

Click to enable cropping a corner within the 3D reconstructed volume.

Click to enable creating a diagonal area within the 3D reconstructed 
volume.

Click to enable creating a parallel slice within the 3D reconstructed 
volume.

a. Complete details regarding mouse use for these functions, is included in the process steps in which they 
are used, in Chapter 7, “Viewing Tomographies.”

Table 1-9 XM3DViewer User Interface Iconsa (Continued)

Type Icon Description
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Process Overview

Figure 1-13 (“automatic” processes) and Figure 1-14 (“manual” processes) 
provide an overall view of the MicroXCT process flow.

Figure 1-13 Overall MicroXCT Process Flow – Automated Processes
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Figure 1-14 Overall MicroXCT Process Flow – Manual Processes
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2 Setting Up for Data Acquisition

This chapter describes the pre-data acquisition procedures, including 
(but not limited to) mounting, loading, and coarse positioning of the 
sample using XMController, and turning on the X-ray source. Before setting 
up the MicroXCT to take images or tomographies, the precautions and steps 
provided in this chapter should be taken to minimize collisions between 
the sample and the detector and X-ray source.

WARNING Failure to follow these precautions could increase camera, 
X-ray source, and lens depreciation, and/or potentially cause damage to 
magnification lenses and motors, MicroXCT alignment, and can potentially 
cause the MicroXCT to fail.

CAUTION Troubleshooting tips regarding imminent collision appear 
throughout this chapter. For more complete collision-related troubleshooting 
tips, refer to “Troubleshooting Sample Issues in XMController,” on page 210.
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Process Overview

The process of setting up for data acquisition is comprised of the following 
subprocesses:

1. Mounting the Sample in/on a Sample Holder.

– Mounting Using a Clamp

– Mounting Using a Clip

– Mounting Using a Pin Vise

– Mounting Using a Sample Base

2. Installing the Sample.

a. Loading the Sample Holder Assembly onto the Sample Stage.

b. Coarsely Positioning the Sample.

c. Selecting the Lowest Magnification.

d. Coarsely Positioning the Detector.

e. Verifying the X-ray Source’s Position.

3. Turning on the X-ray Source.

Each is described in the sections that follow.
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Mounting the Sample in/on a Sample Holder

This process describes how to mount a sample in or on a sample holder. 
The sample holder assembly (sample plus sample holder) can then be loaded 
onto the MicroXCT’s sample stage, for imaging of the sample.

In general, samples should be placed in/on their sample holders in such 
a manner that the region of interest in the sample (the focus of the data 
acquisition) is:

– Facing up

– Located above the top surface of the holder

– Positioned so that the least amount of material is penetrated by X-ray

Additionally, the sample must be:

– Securely mounted in/on the holder

– Stable, such that it does not move nor vibrate in response to gentle 
tapping on the holder

CAUTION Follow the safe sample handling procedures established 
by your work site.

CAUTION A properly mounted sample should not move during data 
acquisition. Any movement, however small, will compromise image resolution 
and create streak artifacts in reconstructed 2D slices and 3D volume data.

NOTE Instructions for removing the sample from the sample holder, after you 
are finished using the sample, are provided in Appendix E, “Removing the Sample 
after Use.”
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Table 2-1 lists the various types of samples that can be imaged with the 
MicroXCT, and their corresponding holders. The use and mounting 
procedures for each holder type is described in the sections that follow. 
Table 2-2 lists the sample diameter/width and height limitations, by 
MicroXCT model.

The processes for mounting samples, for each sample holder type, 
is described in the sections that follow.

For specific sample applications, contact Xradia directly.

Table 2-1 Sample Types and Corresponding Sample Holders

Sample Holdera

a. The clamp, clip, and pin vise sample holders are permanently mounted onto a sample 
base, which is the rounded base with a flat edge that lines up with the sample stage when 
the sample holder assembly (sample plus sample holder) is loaded onto the sample stage. 
The stand-alone sample base is also used as a sample holder.

Sample Type

Clamp
Semiconductor; flat.
Sample should be no thicker than 10 mm.

Clip
Semiconductor; flat; rigid material.
Sample should be thin and flat, no thicker than 5 mm.

Pin Vise
Solid material (such as rock core samples, or thin, long pieces 
of material).
Sample (or toothpick or rod) should be 3 mm or less in diameter.

Sample Base Soft biological material that fits within a tube.

Table 2-2 Sample Diameter/Width and Height Limitations

Model
Diameter/Width Limitations

(Centered on Axis of Rotation) Height Limitations

MicroXCT-200 100 mm 150 mm

MicroXCT-400 500 mm 400 mm
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Mounting Using a Clamp
This process describes how to mount a sample, using the clamp sample 
holder. The clamp is primarily used for semiconductor or flat samples.

To mount a semiconductor or flat sample in a clamp

1. Turn the thumbscrew COUNTERCLOCKWISE on the clamp lever, to open 
the clamp region.

2. Position the sample in the clamp. Ensure that the region of interest 
is clearly visible, and not covered by the edges of the clamp.

CAUTION Keep your fingers free of the part of the clamp that closes 
onto the sample, to avoid being pinched.

NOTE Semiconductor samples are usually mounted at a slight 
tilt (as illustrated in Figure 2-1) so that the horizontal traces can 
be properly reconstructed.

3. Gently tighten the clamp thumbscrew CLOCKWISE, to hold the sample 
in place.

Proceed to “Installing the Sample.”

Figure 2-1 Sample Holder – Clamp with Semiconductor Sample
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Mounting Using a Clip
This process describes how to mount a sample, using the clip sample holder. 
The clip is used for semiconductor or flat samples, as well as for rigid material, 
such as a tooth.

To mount a semiconductor, flat, or rigid material sample in a clip

1. Push down on the clip to open it.

2. Position the sample between the clip’s pincers. Ensure that the region 
of interest is clearly visible, and not covered by the edges of the clip.

CAUTION Keep your fingers free of the part of the clip’s pincers, to avoid 
being pinched.

NOTE Semiconductor samples are usually mounted at a slight tilt 
(as illustrated in Figure 2-2) so that the horizontal traces can be properly 
reconstructed.

3. Release the clip to close.

Proceed to “Installing the Sample.”

Figure 2-2 Sample Holder – Clip with Semiconductor Sample
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Mounting Using a Pin Vise
This process describes how to mount a sample, using the pin vise sample 
holder. The pin vise is used for solid material, such as rock core samples, or 
thin, long pieces of material. The pin vise can directly hold the sample, or it 
can hold a toothpick or thin rod, with the sample epoxied on top of the 
toothpick or thin rod.

To mount a solid or thin, long material sample in a pin vise

1. Rotate the outer section of the vise to sufficiently narrow (CLOCKWISE) 
or widen (COUNTERCLOCKWISE) the pin opening, for inserting the 
sample (or toothpick or rod) into the vise.

2. Position the sample in the vise.

If using a toothpick or rod, place the end opposite from the sample, 
into the vise.

3. Rotate the outer section of the vise CLOCKWISE, to gently tighten 
the gripping section.

Proceed to “Installing the Sample.”

Figure 2-3 Sample Holder – Pin Vise with Sample on Thin Rod
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Mounting Using a Sample Base
This process describes how to mount a sample directly onto a sample base 
sample holder. The sample base is used for soft biological samples. The 
sample is loaded into a plastic tube, then epoxied onto the sample base, 
using 5-minute epoxy.

NOTE The sample must be securely packed within the tube.

To mount a soft biological sample onto a sample base

1. So that the sample base can be reused, apply cellophane tape to its top 
surface, prior to applying the epoxy.

2. Load the biological sample into a plastic tube, packing firmly so that the 
sample does not move within the tube.

3. Epoxy the tube onto the base, as per the epoxy manufacturer’s 
instructions.

CAUTION Follow the epoxy manufacturer’s safety guidelines.

Proceed to “Installing the Sample.”

Figure 2-4 Sample Holder – Sample Base with Sample in Plastic Tube
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Installing the Sample

The process of installing the sample is comprised of the following 
subprocesses:

1. Loading the Sample Holder Assembly onto the Sample Stage.

2. Coarsely Positioning the Sample.

3. Selecting the Lowest Magnification.

4. Coarsely Positioning the Detector.

5. Verifying the X-ray Source’s Position.

Each is described in the sections that follow.
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Throughout this chapter, and the remainder of this guide, directions X, Y, Z, 
and Theta are mentioned. Table 2-3 describes, and Figure 2-5 illustrates, 
the directions used when moving the sample, detector, and X-ray source, 
in relation to the visual light camera (located behind the sample stage).

Figure 2-5 Axis Definitions of X-ray Source, Sample, and Detector

Table 2-3 Sample, Detector, and X-ray Source Movement Directions

Direction 
(Axis) Movement

Movement From
User’s Perspective

X Toward and away from visual light camera IN and OUT

Y From top to bottom of the enclosure UP and DOWN

Z Beam line from X-ray source to detector LEFT and RIGHT

Theta Circular angle
CLOCKWISE and 

COUNTERCLOCKWISE

X-ray Source Sample Detector

Theta

Z

Y
X
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Loading the Sample Holder Assembly onto the 
Sample Stage
This process describes how to open XMController, and load the sample 
holder assembly. The latter involves moving the X-ray source and detector 
away from the sample stage, to allow access to the sample stage. After the X-ray 
source and detector are moved, the sample holder assembly (sample plus 
sample holder) can be loaded onto the sample stage.

NOTE From this point on, the processes assume that the MicroXCT is already 
turned ON. If it is not ON, use the processes described in Appendix C, “Shutting 
Down and Restarting the MicroXCT,” to restart MicroXCT and home all motorized 
axes to pre-defined initialization positions.

NOTE Instructions for removing the sample holder from the sample stage, 
after you are finished using the sample, are provided in Appendix E, “Removing 
the Sample after Use.”
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To load the sample holder assembly onto the sample stage

1. Start XMController, if it is not already running. Select Start > 
All Programs > Xradia > MicroXCT 7.x > XMController 7.x. 
The XMController main window opens.

NOTE “x” is the program’s current version number.

NOTE The main window’s menu bar changes, during use, to also include 
Process and Window menus.

Figure 2-6 Default XMController Main Window

X-ray Source StatusMenu Bar Icon Bar

Status Bar
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2. Open the Motion Controller dialog box, using one of the 
following methods:

– Select Microscope > Motion Controller… 

– Click  in the icon bar

The dialog box opens, defaulted to the Sample tab.

NOTE If  is highlighted orange in the icon bar, the Motion Controller 
dialog box is already open, and clicking the icon closes, rather than opens, 
the dialog box. If the dialog box is hidden behind other windows or dialog 
boxes, click the highlighted orange icon, then click the non-highlighted icon, 
as described above.

Figure 2-7 Motion Controller Dialog Box – Sample Tab

In step 3a,
type value 
here, then 

click GO

In step 3c, 
type value 
here, then 

click GO

In step 3b, 
type value 
here, then 
click GO

In step 3d,  
type value 
here, then 
click GO
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3. Follow steps a through d to bring the sample stage to the center of 
the axis of rotation. (Refer to Figure 2-7.) This ensures that the axes on 
the sample stage are centered, so that the sample, when loaded into the 
MicroXCT, is also centered.

a. In the Sample X panel, type 0 in the Sample X text box, 
then click GO.

b. In the Sample Y panel, type 0 in the Sample Y text box, 
then click GO.

c. In the Sample Z panel, type 0 in the Sample Z text box, 
then click GO.

d. In the Sample Theta panel, type 0 in the Sample Theta text box, 
then click GO.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

4. Click the Source tab. The Current Position status indicates the current 
Source Z position. Type -130 in the Source Z text box, then click GO.

The source retracts from the sample stage. When complete, the 
Source Z Current Position status indicates -130 mm, or the Source Z 
axis negative limit (-Limit hit) for your MicroXCT.

NOTE The Source and Detector tab labels are not fully visible when those 
tabs are selected in the Motion Controller dialog box; they are, however, 
fully visible when the Sample tab is selected.

Figure 2-8 Motion Controller Dialog Box – Source Tab

In step 4, type value 
here, then click GO

Current Position
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5. Click the Detector tab. The Current Position status indicates the 
current Camera Z position. Type 130 in the Camera Z text box, 
then click GO.

The detector retracts from the sample stage. When complete, the 
Camera Z Current Position status indicates 130 mm, or the Camera Z 
axis positive limit (+Limit hit) for your MicroXCT.

Figure 2-9 Motion Controller Dialog Box – Detector Tab

6. At this point, the X-ray source should be OFF, because you have not yet 
turned it ON. However, before proceeding, you must ensure that the 
X-ray source is turned OFF. The X-ray source is ON if the red light 
on the light tower (top light) is illuminated.

NOTE Refer to Table 1-1, “MicroXCT-200 and MicroXCT-400 – Major External 
Components, Illustrated in Figure 1-1 and Figure 1-2,” on page 7, for information 
regarding status of the light tower indicators.

Follow steps a and b to turn OFF the X-ray source:

a. Open the XRay Source dialog box, using one of the 
following methods:

– Select Microscope > Source Controller… 

– Click  in the icon bar

NOTE If  is highlighted orange in the icon bar, the Xray Source dialog 
box is already open, and clicking the icon closes, rather than opens, the 
dialog box. If the dialog box is hidden behind other windows or dialog boxes, 
click the highlighted orange icon, then click the non-highlighted icon, 
as described above.

In step 5, type value 
here, then click GO

Current Position
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Figure 2-10 XRay Source Dialog Box – X-Ray Source OFF and ON 
(150 kV Source Shown for “ON”)

b. If the Xray button label indicates green OFF, the X-ray Source 
is already turned OFF. Proceed to step 7. 
 
If the Xray button label indicates red ON, click the button to turn 
OFF the X-ray source. The label changes to green OFF, the red light 
on the light tower turns OFF, and the red dialog box values 
automatically change to 0.

NOTE There is no safety issue if the access door(s) is (are) opened without 
first turning OFF the X-ray source, because it automatically turns OFF when 
the access door(s) is (are) opened; however, it is better for the MicroXCT 
if the X-ray source is turned OFF by the software.

7. Open the access door. The Interlock indicator in the XRay Source 
dialog box indicates OPEN.

8. Place the sample holder assembly on the sample stage, with the flat 
edges of the assembly and sample stage aligned, facing the front of the 
MicroXCT. (Refer to Figure 2-12.) The dips on the assembly should 
match and help seat the assembly onto the three tungsten alignment 
balls (circled in red, in Figure 2-11) on the sample stage.

9. Close the access door(s). The Interlock indicator in the XRay Source 
dialog box indicates CLOSED. The yellow light on the light tower 
turns ON.

NOTE If you can see yourself on the visual light camera monitor, the access 
door(s) is (are) still open.

Proceed to “Coarsely Positioning the Sample.”

X-ray Source is turned OFF X-ray Source is turned ON
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Figure 2-11 Sample Stage, with Tungsten Alignment Balls Highlighted

Figure 2-12 Sample Holder Assembly Loaded onto the Sample 
Stage, with Flat Edges Aligned, Facing the Front 
of the MicroXCT (Clip Sample Holder Shown)

Tungsten Alignment 
Balls (3 pl)

Align the Sample 
Holder Assembly
and Sample Stage
Flat Edges
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Coarsely Positioning the Sample
Now that the sample is in place, it is necessary to ensure that the region 
of interest in the sample is clearly in view. This process describes how 
to coarsely position the sample, using the visual light camera and 
motion controller.

To coarsely position the sample

1. If the interior light is turned OFF, turn it ON, by moving the visual light 
camera light switch (D on Figure 1-7, “Ergonomic Station,” on page 16) 
to the UP (ON) position.

The sample is now visible on the visual light camera monitor.

NOTE If it is difficult to see the image due to glare, use the monitor’s 
brightness control to reduce the glare, until the sample is visible.

Two models of visual light camera monitors are currently in use. One has 
self-descriptive control buttons, and the other has control buttons represented 
by icons. Instructions for using the latter to adjust monitor glare is provided 
in Appendix D, “Visual Light Camera Monitor Brightness Controls.”

2. Open the Motion Controller dialog box, if it is not already open, 

by clicking  in the icon bar.

NOTE If  is highlighted orange in the icon bar, the Motion Controller 
dialog box is already open.

3. Select the Sample tab, if it is not already selected.
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4. Change the sample rotation to -90° (COUNTERCLOCKWISE), using one 
of the following methods:

– Press the -90° shortcut key (left green key) on the ergonomic station 
(C on Figure 1-7, “Ergonomic Station,” on page 16)

– In the Sample Theta panel of the Motion Controller dialog box 
Sample tab, type -90 in the Sample Theta text box, then click GO 

When complete, the Sample Theta Current Position status indicates 
-90.0 deg.

CAUTION If collision is imminent, press the -90° shortcut key again to stop 
the sample rotation.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

5. Use the processes described in the following table, to coarsely center 
(by rough estimate) the sample’s region of interest at -90° in the visual 
light camera monitor. The sample’s region of interest should fill the 
entire display area, when the visual light camera is zoomed IN.

In the Sample X and Sample Y panels, the Current Position 
status changes to indicate the current Sample X and Sample Y 
positions, respectively.

The sample is now coarsely positioned in the X and Y directions. The 
next two steps coarsely position the sample in the Z direction.

Tool Process

Joystick
Use the joystick to move the sample in the X (LEFT and 
RIGHT) and Y (UP and DOWN) directions. (Refer to 
E on Figure 1-7, “Ergonomic Station,” on page 16.)

Visual light 
camera controller

Use the visual light camera controller to zoom IN/
OUT, focus with the visual light camera, and monitor 
positioning progress. (Refer to F on Figure 1-7, 
“Ergonomic Station,” on page 16, and Table 1-6, 
“Visual Light Camera Controller Button Functions,” 
on page 18.)
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6. Change the sample rotation to 0°, using one of the following methods:

– Press the 0° shortcut key (right green key) on the ergonomic station 
(C on Figure 1-7, “Ergonomic Station,” on page 16)

– In the Sample Theta panel of the Motion Controller dialog box 
Sample tab, type 0 in the Sample Theta text box, then click GO 

When complete, the Sample Theta Current Position status indicates 
0 deg.

CAUTION If collision is imminent, press the 0° shortcut key again to stop 
the sample rotation.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

7. Use the processes described in the following table, to coarsely center 
(rough estimate) the sample’s region of interest at 0° in the visual light 
camera monitor. The region of interest should fill the entire display area, 
when the visual light camera is zoomed IN.

In the Sample Z panel, the Current Position status changes to indicate 
the current Sample Z position. The sample is now coarsely positioned 
in the Z direction.

The sample is now coarsely positioned in the X, Y, and Z directions. 
Proceed to “Selecting the Lowest Magnification.”

Tool Process

Joystick
Use the joystick to move the sample in the Z (LEFT and 
RIGHT) direction. (Refer to E on Figure 1-7, “Ergonomic 
Station,” on page 16.)

Visual light 
camera controller

Use the visual light camera controller to zoom IN/
OUT, focus with the visual light camera, and monitor 
positioning progress. (Refer to F on Figure 1-7, 
“Ergonomic Station,” on page 16, and Table 1-6, 
“Visual Light Camera Controller Button Functions,” 
on page 18.)
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Selecting the Lowest Magnification
This process describes how to select the lowest magnification lens, to visualize 
the sample at the largest field of view (FOV) available on the your MicroXCT. 
Using a low magnification lens enlarges the FOV. Therefore, the lower the 
magnification, the larger the FOV for the region of interest (that is, you 
can see more of the sample).

The selection process varies, depending upon whether your MicroXCT 
has a motorized or non-motorized turret and/or optional Macro lens.

To select the lowest magnification level – MicroXCT has a motorized 
turret, but does not have an optional Macro lens

1. Click the drop-down arrow to the right of  in the icon bar, 
then select the lowest magnification level (smallest number) 
listed in the drop-down list.

The turret rotates to the selected magnification lens position.

Proceed to “Coarsely Positioning the Detector.”

To select the lowest magnification level – MicroXCT has a motorized 
turret and an optional Macro lens

1. Click the drop-down arrow to the right of  in the icon bar, then 
select the optional Macro lens. The Waiting… dialog box opens.

2. When the dialog box’s title changes to Done!, click Done.

Proceed to “Coarsely Positioning the Detector.”
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To select the lowest magnification level – 
MicroXCT has a non-motorized turret

1. Turn OFF the X-ray source if it is ON.

NOTE The process for turning OFF the X-ray source is described in “Loading 
the Sample Holder Assembly onto the Sample Stage,” step 6.

2. Open the access door, if it is closed.

3. Slowly turn the turret (CLOCKWISE or COUNTERCLOCKWISE), 
until the lens with the lowest magnification clicks into place, 
at the bottom position (lowest point) of the turret.

4. Close the access door.

NOTE If you can see yourself on the visual light camera monitor, 
the access door is still open.

5. If you turned OFF the X-ray source in step 1, turn it back ON.

NOTE The process for turning ON the X-ray source is described in 
“Turning on the X-ray Source.”

6. Click the drop-down arrow to the right of  in the icon bar, and 
verify that the correct lens is selected (marked with a check mark ( )). 
If it is not selected, repeat steps 1 through 6.

Proceed to “Coarsely Positioning the Detector.”
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Coarsely Positioning the Detector
This process describes how to coarsely position the detector, using the visual 
light camera and motion controller. For fastest imaging, shortest exposure 
time, and greatest intensity in the X-ray image, the detector should be coarsely 
positioned near the sample, but not so close that the sample collides with the 
detector, in the Z direction.

To coarsely position the detector

1. Zoom OUT with the visual light camera, by pressing  on the 
visual light camera controller, until the entire sample and holder are 
visible on the visual light camera monitor.

2. While viewing the sample with the visual light camera monitor, 
rotate the sample to -90° (COUNTERCLOCKWISE), using one 
of the following methods:

– Press the -90° shortcut key (left green key) on the ergonomic station

– In the Sample Theta panel of the Motion Controller dialog box 
Sample tab, type -90 in the Sample Theta text box, then click GO 

When complete, the Sample Theta Current Position status indicates 
-90.0 deg.

CAUTION If collision is imminent, press the -90° shortcut key again to stop 
the sample rotation.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.
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Figure 2-13 Motion Controller Dialog Box – Sample Tab

3. In the Motion Controller dialog box, select the Detector tab, type a 
number from 20 to 120 mm in the Camera Z text box, then click GO.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

NOTE The Camera Z value indicates the distance (in mm) between the 
center of the region of interest in the sample and front of the detector. 
The smaller the number, the closer the detector is to the sample. 
Type a number that is close to the sample’s overall dimensions.

For example, if the sample is 25-mm wide, type 25 to start and adjust. 
The adjustment process is described in the next step.

Current Position status
changes to -90.0 deg
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Figure 2-14 Motion Controller Dialog Box – Detector Tab

4. Continue to change the value in the Camera Z text box, by typing 
decreased values, in small increments.

You can also use the processes described in the following table to move 
the detector, using the Step size text box and the buttons indicated. The 
default Step size is 5 mm; therefore, if a smaller Step size is needed, type 
a smaller value in the text box.

The smaller the Current Position value, the closer the detector is to the 
sample. The center of rotation is at 0 mm. Keep track of the detector’s 
position in the visual light camera monitor, to ensure that the detector 
does not collide with nor touch the sample. Leave a gap of at least 5 mm 
between the sample and detector.

5. Zoom IN with the visual light camera, by pressing  on the visual 
light camera controller, until the gap between the sample and detector 
is clearly visible.

Button Process

Click  once in the Detector tab, to move the detector closer 
to the sample by one step size.

Click  once in the Detector tab, to move the detector farther 
away from the sample by one step size.

In step 3, type value 
here, then click GO

Current Position

In step 4, type value here
Click either arrow button 
once, to move one Step size 
in the direction indicated
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6. Change the sample rotation back to 0°, using one of the 
following methods:

– Press the 0° shortcut key (right green key) on the ergonomic station

– In the Sample Theta panel of the Motion Controller dialog box 
Sample tab, type 0 in the Sample Theta text box, then click GO 

CAUTION If collision is imminent, press the 0° shortcut key again to stop 
the sample rotation. Repeat step 3, but move Camera Z to a larger Current 
Position value, to increase the clearance between the sample and detector 
by at least 5 mm. Press the 0° shortcut key to continue rotating to 0°.

CAUTION If collision is imminent, click  in the Sample Theta panel to 
pause the rotation. Select the Detector tab, then repeat step 3, but move 
Camera Z to a larger Current Position value, to increase the clearance 
between the sample and detector by at least 5 mm. Return to the Sample tab, 
type 0 in the Sample Theta text box, then click GO to continue rotating to 0°.

When complete, the Sample Theta Current Position status indicates 
0 deg.

Keep track of the detector’s position in the visual light camera monitor, 
to ensure that the detector does not collide with nor touch the sample.

Proceed to “Verifying the X-ray Source’s Position.”
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Verifying the X-ray Source’s Position
This process describes how to ensure that the X-ray source is at -130 mm 
or its negative limit (-Limit). The X-ray source must be at this position 
before proceeding to the next process.

To verify the X-ray source’s position

1. In the Motion Controller dialog box, select the Source tab.

2. The Source Z Current Position status should indicate -130 mm or the 
negative limit. If it does not, type -130 in the Source Z text box, then 
click GO.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

Proceed to “Turning on the X-ray Source.”

Figure 2-15 Motion Controller Dialog Box – Source Tab

Negative Limit hit is indicated here

In step 2, if necessary, 
type value here, then click GO

Current Position status indicates negative value
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Turning on the X-ray Source

This process describes how to turn ON the X-ray source, after the sample is 
installed and the access door(s) is (are) closed. The X-ray source must be ON 
for the X-ray source to accept user input.

NOTE If MicroXCT power or the X-ray source has been turned OFF for 
more than eight hours, the X-ray source must go through an initial warm-up 
process, called X-ray source aging. This process can take 30 minutes or more, 
depending upon the length of time that the X-ray source was turned OFF.

To turn ON the X-ray source

1. If the access door(s) is (are) open, close the door(s). The yellow light 
on the light tower turns ON.

NOTE If you can see yourself on the visual light camera monitor, the access 
door(s) is (are) still open.

2. Open the XRay Source dialog box, using one of the following methods:

– Select Microscope > Source Controller… 

– Click  in the icon bar

NOTE If  is highlighted orange in the icon bar, the Xray Source dialog 
box is already open, and clicking the icon closes, rather than opens, the 
dialog box. If the dialog box is hidden behind other windows or dialog boxes, 
click the highlighted orange icon, then click the non-highlighted icon, 
as described above.
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3. Click the Xray button (green OFF), to turn ON the X-ray source or start 
the X-ray source warm-up process.

NOTE If the X-ray source has been turned OFF for more than eight hours, 
it must go through a warm-up process called X-ray source aging. (Refer to the 
Note at the beginning of this process). When the aging is complete, the X-ray 
source turns itself OFF, the Xray button is green and the red light on the light 
tower is OFF. Click the Xray button (green OFF) again, to turn ON the X-ray 
source.

When the X-ray source turns ON, the Xray button label changes to red 
ON, the red light on the light tower turns ON, and the red dialog box 
values automatically change to the previously set voltage and power 
values. The green and yellow lights on the light tower remain ON.

WARNING If the red and yellow lights on the light tower are not turned ON, 
the source is not turning ON. Contact the Xradia Support Team.

Figure 2-16 XRay Source Dialog Box – X-Ray Source OFF and ON 
(150 kV Source Shown for “ON”)

X-ray Source is turned OFF X-ray Source is turned ON
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4. Type the appropriate voltage and power values in the Voltage (kV) 
and Power (W) text boxes, respectively, for the corresponding X-ray 
source and sample material type. (Refer to Table 2-4 and Figure 2-17.)

Figure 2-17 90 kV and 150 kV X-ray Sources

5. Click Apply.

One or more Wait message boxes briefly open and close, and the red 
values in the Xray Source dialog box change to indicate the actual 
voltage and power.

Proceed to Chapter 3, “Selecting the First Tomography Point.”

Table 2-4 XRay Source Dialog Box, Voltage and Power Settings 
by X-ray Source and Sample Material Type 

X-ray Source Sample Material Type
Voltage

(kV)
Power

(W)

90 kV – 80 8

150 kV

High density
(such as semiconductor)

140 10

Low density
(such as biological)

80 10

90 kV X-ray Source 150 kV X-ray Source
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3 Selecting the First 
Tomography Point

This chapter describes how to use XMController to select the first tomography 
point for a tomography dataset. Tomography points are used later, by the 
Recipe process, to collect and reconstruct tomographic data.

CAUTION Troubleshooting tips regarding imminent collision appear 
throughout this chapter. For more complete collision-related troubleshooting 
tips, refer to “Troubleshooting Sample Issues in XMController,” on page 210.

NOTE Additional tomography points, if needed, are selected in Chapter 4, 
“Automatically Acquiring Additional Data and Reconstructing Tomography Point(s).”
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Process Overview

The process of selecting the first tomography point is comprised of the 
following subprocesses:

1. Collecting Continuous Images.

2. Identifying the First Point.

3. Finely Positioning the Detector.

4. Finely Positioning the X-ray Source.

5. Selecting the Source Filter.

6. Installing the Selected Source Filter.

7. Determining the Optimum X-ray Source Voltage.

8. Determining the X-ray Source Power and Exposure Time.

Each is described in the sections that follow.
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Collecting Continuous Images

This process describes how to set up the correct parameters to acquire 
continuous images, using Continuous acquisition mode, that you can 
double-click later to set the sample position.

To collect continuous images

1. Follow steps a through c to take continuous images of the sample:

a. Click  in the icon bar. The Acquisition Setting dialog 
box opens.

Figure 3-1 Acquisition Setting Dialog Box – Settings Applied for Continuous 
Acquisition Mode
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b. Select and/or type the acquisition setting values:

CAUTION Camera temperature should be < -55°C. Contact the Xradia 
Support Team if the temperature is higher.

c. Click Start Acquisition to acquire the image. An Acquisition Status 
message box opens, indicating real-time acquisition status, and 
an Image window opens, showing the image being updated, 
with light intensity counts indicated in blue (lower left status bar 
of the window).

NOTE Acquisition Setting dialog box values cannot be changed until 
acquisition is stopped. If you need to abort the acquisition and change 

the values, click  in the icon bar, then repeat steps 1a through 1c 
with different settings.

The Acquisition Status message box closes when you click  
in the icon bar to abort continuous imaging.

NOTE To continue collecting images using the same acquisition setting 

values, click  in the icon bar. If you need to specify an exposure time 
value other than 1 second or binning value other than 4, change the values 
in the Acquisition Setting dialog box.

Option Setting Value

Mode Continuous

Exposure Time (sec) 1

Binning 4

ReadOut Time (u sec) Fast (default)
64 MicroXCT-200 and MicroXCT-400 User’s Guide



Chapter 3 – Selecting the First Tomography Point
Figure 3-2 Image Window Showing Light Intensity Count

Light intensity count
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2. Move the mouse pointer over the image and look at the region 
of interest’s light intensity counts. Resolve any issues with the 
image being too bright or dark:

NOTE There is no upper limit to the length of exposure time; however, 
it should be more than 0.2 seconds.

NOTE The refresh rate significantly decreases when the exposure time 
is increased.

Proceed to “Identifying the First Point.”

Issue with Image Process

Image is too bright

Depending upon the sample density, image saturation 
can occur, with light intensity counts higher than 60,000. 
If this occurs anywhere in the image, you must reduce 
the voltage and power values. In the XRay Source dialog 
box, type the minimum voltage and power values (refer 
to Table 3-1) in the Voltage (kV) and Power (W) text 
boxes, respectively, click Apply, then repeat step 1.

Image is still too bright Click  in the icon bar, then repeat step 1, with the 
exposure time reduced to 0.5 or binning reduced to 2.

Image is too dark Click  in the icon bar, then repeat step 1, with the 
exposure time increased to 2 or higher.

Table 3-1 Minimum and Maximum Voltage and Power Settings, 
by X-ray Source

X-ray Source

Voltage
(kV)

Power
(W)

Minimum Maximum Minimum Maximum

90 kV 20 90 1 8

150 kV 40 150 4 10
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Identifying the First Point

This process describes how to position the sample, using the continuous 
images created in the previous section, to focus on the first point to be 
scanned. In real-work events, up to 26 points can be collected in Version 7.x.

NOTE In the next XMController version release, there will be no limitation 
on the number of points that can be collected.

To identify the first point

1. Select View > Highlight Center of FOV. Yellow cross-hairs highlighting 
the center of the FOV are added to the current Image window.

Figure 3-3 Example Current Image Window, with Cross-Hairs Added
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2. Click  in the icon bar to open the Motion Controller dialog box, if it 
is not already open. The dialog box opens, defaulted to the Sample tab.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

NOTE If  is highlighted orange in the icon bar, the Motion Controller 
dialog box is already open.

3. In the Sample tab, verify that Sample Theta is at 0°. If Sample Theta 
is not at 0°, type 0 in the Sample Theta text box, then click GO 
to rotate Sample Theta to 0°.

4. In the Image window, locate the region of interest and double-click it, 
using the mouse pointer, to move the region of interest to the center 
of the cross-hairs.

NOTE The center of the yellow FOV cross-hairs (for the X and Y axes) 
automatically move to the clicked location. Use the mouse pointer 
to adjust the region of interest, as necessary.

5. In the Sample Theta panel of the Motion Controller dialog box 
Sample tab, type 90 in the Sample Theta text box, then click GO 
to rotate Sample Theta to +90°.

CAUTION If collision with the detector is imminent, click  in the Sample 
Theta panel. Next, select the Detector tab, type a value in the Camera Z text 
box that is at least 5 mm greater than the current value, then click GO. 
Return to the Sample tab, type 90 in the Sample Theta text box, then 
click GO to continue rotating Sample Theta to +90°.

6. With Sample Theta at +90°, double-click along the horizontal yellow 
cross-hair, to center the region of interest in the FOV cross-hairs, 
for the Z axis.

7. Click the drop-down arrow to the right of  in the icon bar, then 
select the magnification lens you want to use, based upon the required 
resolution. (Refer to Table 3-2.)

The Waiting… dialog box might open, and then close. Click Done 
when complete.

NOTE If the MicroXCT has a non-motorized turret, use the process described 
in “To select the lowest magnification level – MicroXCT has a non-motorized turret,” on 
page 52, to manually select the magnification lens.
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8. At the new magnification setting, follow steps a and b to verify that the 
region of interest is still visible in the FOV, at Sample Theta = +90° 
and 0°:

a. Currently, Sample Theta is at +90°. Double-click the region 
of interest, to bring it to the center of the FOV (intersection of 
the yellow cross-hairs).

b. In the Sample Theta panel of the Motion Controller dialog box 
Sample tab, type 0 in the Sample Theta text box, then click 
GO to rotate Sample Theta to 0°. Double-click the region of interest, 
to bring it to the center of the FOV.

9. If you do not see the region of interest at the selected resolution, repeat 
step 7, but reduce the magnification level by one step (for example, from 
10X to 4X), then repeat steps 2 through 8. A new Image window opens 
as a result of selecting a different magnification level.

Table 3-2 Spatial Resolution and FOV Ranges, by Magnification Level

Magnification Level/Lens
Resolution Range

(μm)
3D FOV Range

(mm)

Standard Lenses (included with every MicroXCT)

4X 5.0 – 6.0 2.4 – 6.0

10X 2.5 – 3.0 2.0 – 2.7

20X 1.5 1.3

Optional Lenses (available upon request)

Macro-70a

a. The Macro lens, if included, provides a second beam line for imaging, and is mounted 
beside, rather than on, the turret.

20.0 – 50.0 17.0 – 50.0

Macro-55 (0.5X)a, b, c, d

b. The Macro-55 (0.5X) lens is obsolete, and was replaced by the Macro-70 as an option. 
The lens is still in use in some MicroXCT units.

c. The Macro-55 (0.5X) and 2X lenses have a round FOV. Therefore, their 3D FOV range 
is the diameter of the FOV.

d. MicroXCT-400 only.

14.0 – 40.0 14.0 – 40.0

1X 9.0 – 22.0 4.0 – 15.0

2Xc, e

e.  The 2X lens is not available when the MicroXCT has an optional Macro lens.

6.0 – 13.0 4.0 – 13.0

40X 1.0 0.7
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10. When the region of interest is visible at the selected resolution, 

click  in the icon bar, to abort imaging.

Proceed to “Finely Positioning the Detector.”
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Finely Positioning the Detector

This process describes how to use the motion controller to position the 
detector as close to the sample as possible, while avoiding collision, for 
the shortest scan time.

To finely position the detector

1. Open the XRay Source dialog box, using one of the following methods:

– Select Microscope > Source Controller… 

– Click  in the icon bar

NOTE If  is highlighted orange in the icon bar, the Xray Source dialog 
box is already open, and clicking the icon closes, rather than opens, the 
dialog box. If the dialog box is hidden behind other windows or dialog boxes, 
click the highlighted orange icon, then click the non-highlighted icon, 
as described above.

2. Click the Xray button (red ON), to turn OFF the X-ray source. The 
button label changes to green OFF, the red light on the light tower 
turns OFF, and the red dialog box values automatically change to 0.

Figure 3-4 XRay Source Dialog Box – X-Ray Source OFF and ON 
(150 kV Source Shown for “ON”)

X-ray Source is turned OFF X-ray Source is turned ON
MicroXCT-200 and MicroXCT-400 User’s Guide 71



Chapter 3 – Selecting the First Tomography Point
3. Open the access door.

4. In the Motion Controller dialog box, select the Detector tab, type 
a value smaller than the current Camera Z position, in steps of 5 mm 
or less, in the Camera Z text box, then click GO.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

NOTE The Camera Z value indicates the distance (in mm) between the 
center of the region of interest in the sample and front of the detector. 
The smaller the number, the closer the detector will be to the sample. 
Type a number that is close to the sample’s overall dimensions.

Figure 3-5 Motion Controller Dialog Box – Detector Tab

5. To position the detector as close to the sample as possible, or until 
the status indicates -Limit hit, continue to change the value in the 
Camera Z text box by typing decreased values, in 1-mm steps, 
and clicking GO.

Keep track of the detector’s position in the visual light camera monitor 
and/or through the open access door, to ensure that the detector does 
not collide with nor touch the sample.

In step 4, type value 
here, then click GO

Current Position
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6. Follow steps a through c to verify the tomographic angle range, to ensure 
that the detector does not collide with nor touch the sample:

NOTE On the detector, the collision point is between the sample and 
the face of the bottom magnification lens (flat area) on the turret.

a. In the Motion Controller dialog box, select the Sample tab. 
In the Sample Theta panel, type the negative limit of the Sample 
Theta tomographic angle range (-90 or -180, per Table F-1, “Sample 
Types and Sample Theta Tomographic Angle Ranges,” on page 259) 
in the Sample Theta text box, then click GO.

NOTE If the negative limit of the Sample Theta tomographic angle range 
is determined to be -180, but the MicroXCT is only 180°-enabled, type -90; 
otherwise, type -180. If you do not know whether the MicroXCT is 180°- or 
360°-enabled, refer to Appendix F for further details.

Figure 3-6 Motion Controller Dialog Box – Sample Tab

In step 6a, type value here, 
then click GO
Current Position
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b. Keep track of the sample’s position in the visual light camera monitor 
and/or through the open access door, to ensure that the sample does 
not collide with nor touch the detector.

c. If the sample collides with the detector, or looks like it will collide 

with or touch the detector, click  in the Sample Theta panel 
to stop the movement. Select the Detector tab, type a value slightly 
greater than the current Camera Z position in the Camera Z text 
box, then click GO.

Continue repeating steps 6a through 6c, until the sample and 
detector do not collide with nor touch one another, and the 
Sample Theta Current Position status indicates the negative limit 
of the Sample Theta tomographic angle range (-90 deg or -180 deg, 
per Table F-1, “Sample Types and Sample Theta Tomographic Angle 
Ranges,” on page 259).

7. Repeat steps 6a through 6c for the positive limit of the Sample Theta 
tomographic angle range (+90 deg or +180 deg, per Table F-1).

8. If data is to be automatically reconstructed (using instructions 
documented in Chapter 4, “Automatically Acquiring Additional Data and 
Reconstructing Tomography Point(s)”) and the tomographic angle 
range is -90 to +90 – Repeat steps 6a through 6c, to check for collision 
with the detector, at angles up to Sample Theta = +170°.

9. Note the current Camera Z position in the Motion Controller dialog 
box Detector tab. This value can be used later, to calculate Source Z 
positions in “Finely Positioning the X-ray Source.”

Proceed to “Finely Positioning the X-ray Source.”
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Finely Positioning the X-ray Source

This process describes how to use the motion controller to position the X-ray 
source appropriately, for imaging with the chosen magnification lens:

– 10X, 20X, and 40X lenses – The X-ray source is placed as close to the 
sample as possible, while avoiding collision.

– Macro, 1X, 2X, and 4X lenses – The X-ray source is placed such that 
the distance between the X-ray source and detector is not less than 
that indicated in Table 3-3. The distance between the X-ray source 
and detector is equal to Camera Z - Source Z. 
 
For example, if the value noted for Camera Z in “Finely Positioning the 
Detector,” step 9, is 10 mm, then for a 4X lens, the X-ray source should 
be positioned no closer than -(65 - 10) = -55 mm from the region 
of interest in the sample. That is, Source Z can be at a more negative 
value than -55 mm – -60 mm will work; however, -50 mm will not.

NOTE If this process is not correctly followed for the Macro, 1X, 2X, 
and 4X lenses, the X-ray source aperture might be seen in the field of view 
(FOV). Refer to “Troubleshooting Magnification Lens Too Close to the X-ray 
Source – Keeping the X-ray Source Aperture out of the Field of View,” on 
page 224, for resolution.

Table 3-3 Minimum Distance between X-ray Source and Detector 
for Macro, 1X, 2X, and 4X Lenses

Lens
MicroXCT With

an Optional Macro Lens
MicroXCT Without

an Optional Macro Lens

Macro-70a

a. The Macro lens, if included, provides a second beam line for imaging, and is mounted 
beside, rather than on, the turret.

135 mm –

Macro-55 (0.5X)a, b, c

b. The Macro-55 (0.5X) lens is obsolete, and was replaced by the Macro-70 as an option. 
The lens is still in use in some MicroXCT units.

c. MicroXCT-400 only.

80 mm –

1X 33 mm 160 mm

2Xd

d.  The 2X lens is not available when the MicroXCT has an optional Macro lens.

– 92 mm

4x 13 mm 65 mm
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To finely position the X-ray source

1. In the Motion Controller dialog box, select the Sample tab, then rotate 
Sample Theta back to 0°, by typing 0 in the Sample Theta text box and 
clicking GO.

2. Zoom OUT with the visual light camera, by pressing  on the 
visual light camera controller, until the entire sample and holder are 
visible on the visual light camera monitor.

3. 10X, 20X, and 40X lenses – Skip this step.

Macro, 1X, 2X, and 4X lenses – Follow steps a through c to position 
Source Z:

NOTE If steps a through c are not followed correctly, the X-ray source 
aperture might be seen in the field of view (FOV). Refer to “Troubleshooting 
Magnification Lens Too Close to the X-ray Source – Keeping the X-ray Source Aperture 
out of the Field of View,” on page 224, for resolution.

a. Subtract the value of Camera Z noted in “Finely Positioning the 
Detector,” step 9, from the value indicated for the lens and 
MicroXCT type in Table 3-3.

b. In the Motion Controller dialog box, select the Source tab.

Figure 3-7 Motion Controller Dialog Box – Source Tab

In steps 3, 4, and 5, type 
value here, then click GO

Current Position
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c. In the Source Z text box, type the negative value of the value 
calculated in step a, then click GO.

Proceed to step 6.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

4. 10X, 20X, and 40X lenses – Follow steps a and b to position Source Z 
(refer to Figure 3-7):

a. In the Motion Controller dialog box, select the Source tab.

b. In the Source Z text box, type a negative value greater than the 
current Source Z position, in increments of about 10 to 20 mm, 
then click GO.

For example, if Source Z is currently at -130 mm, type -110 in 
the Source Z text box, then click GO, to bring the X-ray source 
closer to the sample. This will bring the X-ray source 20 mm closer 
to the sample.

5. 10X, 20X, and 40X lenses – Continue to position the X-ray source as 
close to the sample as possible, or until the Source Z Current Position 
status indicates +Limit hit, by typing increased negative values, 
in small increments, and clicking GO. (Refer to Figure 3-7.)

Keep track of the X-ray source’s position in the visual light camera 
monitor and/or through the open access door, to ensure that the 
X-ray source does not collide with nor touch the sample.

WARNING At this point, the sample is very close to the detector, and if 
the X-ray source collides with the sample, the detector can be damaged.

CAUTION For more complete troubleshooting tips regarding imminent 
collision, as well as for collision, refer to “Troubleshooting Sample Issues in 
XMController,” on page 210.
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6. Follow steps a through c to verify the tomographic angle range, to ensure 
that the X-ray source does not collide with nor touch the sample:

NOTE The collision point varies, by X-ray source:

– 90 kV X-ray source – Between the source filter holder and sample

– 150 kV X-ray source – Between the sample base and bottom 
of the X-ray source

a. In the Motion Controller dialog box, select the Sample tab. 
In the Sample Theta panel, type the value of the negative limit 
of the Sample Theta tomographic angle range (-90° or -180°, per 
Table F-1, “Sample Types and Sample Theta Tomographic Angle 
Ranges,” on page 259) in the Sample Theta text box, then click GO.

NOTE If the negative limit of the Sample Theta tomographic angle range 
is determined to be -180, but the MicroXCT is only 180°-enabled, type -90; 
otherwise, type -180. If you do not know whether the MicroXCT is 180°- or 
360°-enabled, refer to Appendix F for further details.

Figure 3-8 Motion Controller Dialog Box – Sample Tab

In step 6, type value here, 
then click GO
Current Position
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b. Keep track of the sample’s position in the visual light camera monitor 
and/or through the open access door, to ensure that the sample does 
not collide with nor touch the source.

c. If the sample collides with the source, or looks like it will collide with 

or touch the source, click  in the Sample Theta panel to stop the 
movement. Select the Source tab, type a negative value slightly less 
than the current Source Z position in the Source Z text box, then 
click GO.

For example, if the X-ray source is currently at -40 mm, type -45 in the 
Source Z text box, to move the X-ray source away from the sample 
by 5 mm.

Continue to repeat steps 6a through 6c, until the sample and 
X-ray source do not collide with nor touch one another, and the 
Sample Theta Current Position status indicates the negative limit 
of the Sample Theta tomographic angle range (-90 deg or -180 deg, 
per Table F-1, “Sample Types and Sample Theta Tomographic Angle 
Ranges,” on page 259).

7. Repeat steps 6a through 6c for the positive limit of the Sample Theta 
tomographic angle range (+90 deg or +180 deg, per Table F-1).

8. If data is to be automatically reconstructed (using instructions 
documented in Chapter 4, “Automatically Acquiring Additional Data and 
Reconstructing Tomography Point(s)”) and the angle range is -90° 
to +90° – Repeat steps 6a through 6c to check for collision with the 
X-ray source, at angles up to Sample Theta = +170°.

Proceed to “Selecting the Source Filter.”
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Selecting the Source Filter

Source filters are materials that improve reconstructed image quality, by 
removing low-energy X-rays that do not provide useful information through 
the sample, also known as hardening the X-ray, thus reducing the effects 
of beam hardening.

This process describes how to determine whether a source filter is needed, 
and if so, which source filter to use, based upon the transmission value 
and magnification lens in use. The transmission value is the ratio 
of X-rays through the sample versus the X-rays without the sample present:

Transmission Value = Image with Sample / Image without Sample

NOTE Source filters are available in a filter kit from Xradia.
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To select the source filter

1. Turn ON the X-ray source, following the process described in “Turning 
on the X-ray Source,” on page 58.

2. In the Motion Controller dialog box, select the Sample tab. In the 
Sample Theta panel, if the current Sample Theta position is not 0 deg, 
type 0 in the Sample Theta text box, then click GO.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

Figure 3-9 Motion Controller Dialog Box – Sample Tab

In step 2, type value 
here, then click GO
Current Position

In steps 4a and 5a, type 
value here, then click GO

In step 3, note the 
Current Position
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3. In the same dialog box and tab, note the current Sample X position. 
(Refer to Figure 3-9.) This value is used later, in step 5, as well as in other 
processes that appear later in this chapter.

4. Image without sample – Follow steps a through f to take a single image, 
with the sample out of the field of view (FOV):

a. Move the sample out of the FOV. In the Sample X panel of the 
Motion Controller dialog box Sample tab, type 60,000 in 
the Sample X text box, then click GO. (Refer to Figure 3-9.)

b. Click  in the icon bar. The Acquisition Setting dialog 
box opens.

Figure 3-10 Acquisition Setting Dialog Box – Settings Applied for Single 
Acquisition Mode
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c. Select and/or type the acquisition setting values:

CAUTION Camera temperature should be < -55°C. Contact the Xradia 
Support Team if the temperature is higher.

d. Click Start Acquisition to acquire the image. An Acquisition Status 
message box opens, indicating real-time acquisition status, and 
an Image window opens, showing the image being updated, 
with light intensity counts indicated in blue (lower left status bar 
of the window).

NOTE Acquisition Setting dialog box values cannot be changed until 
acquisition is stopped. If you need to abort the acquisition and change 

the values, click  in the icon bar, then repeat steps 4b through 4d 
with different settings.

The Acquisition Status message box closes when acquisition is 

complete, or when you click  in the icon bar to abort imaging.

e. Resolve any issues with the image being too bright or dark:

NOTE There is no upper limit to the length of exposure time; however, 
it should be more than 0.2 seconds.

Option Setting Value

Mode Single

Exposure Time (sec) 10

Binning 2

ReadOut Time (u sec) Fast (default)

Issue with Image Process

Image is too bright

Depending upon the X-ray source to detector distances 
and magnification lens used, image saturation can occur, 
with light intensity counts higher than 60,000. If this 
occurs anywhere in the image, you must reduce the 
power value. In the XRay Source dialog box, type 
the minimum power value (1 for the 90 kV X-ray source; 
4 for the 150 kV X-ray source) in the Power (W) text box, 
click Apply, then repeat steps 4b through 4d.

Image is still 
too bright

Repeat steps 4b through 4d, with the exposure time 
reduced to 1.

Image is too dark
Repeat steps 4b through 4d, with the exposure time 
increased to a value higher than 10 (such as 20).
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f. Note the image name in the top left corner of the final Image 
window’s title bar. This value is used later, as Input b in step 6d.

NOTE To collect another image using the same acquisition setting values, 

click  in the icon bar. If you need to specify an exposure time other than 
10 seconds or binning other than 2, change the values in the Acquisition Setting 
dialog box.

NOTE If the X-ray source is visible on the image, use the troubleshooting 
tips provided in “Troubleshooting Magnification Lens Too Close to the X-ray 
Source – Keeping the X-ray Source Aperture out of the Field of View,” on page 224, 
for resolution.

5. Image with sample – Follow steps a through c to take a second image, 
with the sample in the FOV:

a. Move the sample back into the FOV. In the Sample X panel of the 
Motion Controller dialog box Sample tab, type the Sample X 
position value, noted earlier in step 3, in the Sample X text box, 
then click GO. (Refer to Figure 3-9.)

NOTE In cases where the sample is significantly thinner in one dimension 
than the others, rotate Sample Theta to an angle that will reflect and average 
transmission between projection images at different Sample Theta angles. 
For example, for a semiconductor sample that has minimal thickness but 
larger width and height, rotate Sample Theta to -70° to acquire the image 
with the sample. Note the sample theta value. Always rotate Sample Theta 
back to 0° before trying to move the sample out of the FOV (by moving 
Sample X).

b. Click  in the icon bar, to acquire a single image with same 
acquisition settings selected in step 4.

c. Note the image name in the top left corner of the final Image 
window’s title bar. This value is used later, as Input a in step 6c.
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6. Follow steps a through f to calculate the transmission value, which 
is determined by dividing the second image (with sample) by the first 
image (without sample):

a. Select Process > Image Calculator. The Calculator dialog 
box opens.

Figure 3-11 Calculator Dialog Box – a/b Operation

b. Select a/b operation.

c. Select the image acquired in step 5 (“image with sample,” using the 
image name noted in step 5c), from the Input a drop-down list box.

d. Select the image acquired in step 4 (“image without sample,” 
using the image name noted in step 4f), from the Input b 
drop-down list box.

NOTE The window name that appears in the Window Name text box 
is automatically derived, based upon the selected operation. You can 
leave it as is, or rename it.
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e. Click Calculate. The Choose Output Format dialog box opens.

Figure 3-12 Choose Output Format Dialog Box

f. Click OK to select the Float output datatype (default). An 
Imagex_Div window opens, with the transmission value indicated 
in blue (lower left status bar of the window), on a scale of 0 to 1.

NOTE If the transmission value is greater than 1, you divided the blank 
image by the sample image. Repeat steps 6c through 6f to divide the 
sample image by the blank image.

Figure 3-13 Imagex_Div Window Resulting from Calculation

Transmission value
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7. Using the value determined in step 6, determine the appropriate source 
filter thickness to be used, in “Installing the Selected Source Filter”:

– 10X, 20X, or 40X lenses – Select the appropriate value 
from Table 3-4

– Macro, 1X, 2X, or 4X lenses – Select the appropriate value 
from Table 3-5

NOTE In most cases, the region of interest can contain different materials, 
with different transmission values. If this is the case, estimate an average 
transmission value to select a source filter.

To estimate an average, hover the mouse over the region of interest, 
look at the blue numbers, then roughly estimate the average value.

Proceed to the next process:

– If Table 3-4 or Table 3-5 indicates that a source filter is needed, 
proceed to “Installing the Selected Source Filter”

– If Table 3-4 or Table 3-5 indicates that a source filter is not needed, 
proceed to “Determining the Optimum X-ray Source Voltage”

Table 3-4 Source Filter Selection for 10X, 20X, and 40X Lenses, 
by X-ray Source

Transmission @ 80 kV
(90 kV X-ray Source)

Transmission @ 140 kV
(150 kV X-ray Source) Source Filter

> 0.63 – No Filter

0.44 – 0.63 – LE #1

0.34 – 0.44 – LE #2

0.28 – 0.34 – LE #3

0.21 – 0.28 – LE #4

0.14 – 0.21 – LE #5

0.08 – 0.14 – LE #6

– 0.18 – 0.30 HE #1

– 0.08 – 0.18 HE #2

– 0.06 – 0.08 HE #3

– 0.04 – 0.06 HE #4

– 0.03 – 0.04 HE #5

– < 0.03 HE #6
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Table 3-5 Source Filter Selection for Macro, 1X, 2X, and 4X Lenses, 
by X-ray Source

Transmission @ 80 kV
(90 kV X-ray Source)

Transmission @ 140 kV
(150 kV X-ray Source) Source Filter

> 0.740 – No Filter

0.58 – 0.74 – LE #1

0.46 – 0.58 – LE #2

0.36 – 0.46 – LE #3

0.28 – 0.36 – LE #4

0.20 – 0.28 – LE #5

0.12 – 0.20 – LE #6

– 0.20 – 0.32 HE #1

– 0.12 – 0.20 HE #2

– 0.08 – 0.12 HE #3

– 0.05 – 0.08 HE #4

– 0.03 – 0.05 HE #5

– < 0.03 HE #6
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Installing the Selected Source Filter

This process describes how to manually install the source filter selected 
in “Selecting the Source Filter.”

NOTE If “Selecting the Source Filter,” step 7, indicated that a source filter is not 
needed, proceed directly to “Determining the Optimum X-ray Source Voltage.”

To install the selected filter

1. If the Xray Source dialog box is not already open from a previous 

process, click  in the icon bar.

2. In the Xray Source dialog box, click the Xray button (red ON), 
to turn OFF the X-ray source. The button label changes to green OFF, 
the red light on the light tower turns OFF, and the red dialog box 
values automatically change to 0.

Figure 3-14 XRay Source Dialog Box – X-Ray Source OFF and ON 
(150 kV Source Shown for “ON”)

X-ray Source is turned OFF X-ray Source is turned ON
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3. Open the access door.

4. Follow steps a and b to install the source filter selected in “Selecting the 
Source Filter,” step 7.

a. Holding the metal tab at the top of the source filter and taking care 
not to touch the filter, gently slide the filter into the source filter 
holder, at the front of the X-ray source, with the thickest part of 
the filter facing outward, toward the sample. (Refer to Figure 3-15 
for handling and placement.)

b. Ensure that the lower edge of the source filter is firmly seated 
in the source filter holder.

CAUTION The sample might be very close to the X-ray source at this point. 
Take care not to scratch the source filter when installing.

Figure 3-15 Source Filter Installation (150 kV X-ray Source Shown)
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5. Close the access door.

NOTE If you can see yourself on the visual light camera monitor, the access 
door(s) is (are) still open.

6. In the XRay Source dialog box, click the Xray button (green OFF), 
to turn ON the X-ray source. The button label changes to red ON, 
the red light on the light tower turns ON, and the red dialog box values 
automatically change to the previously set voltage and power values. 
The green and yellow lights on the light tower remain ON.

Proceed to “Determining the Optimum X-ray Source Voltage.”

Figure 3-16 XRay Source Dialog Box – X-Ray Source OFF and ON 
(150 kV Source Shown for “ON”)

X-ray Source is turned OFF X-ray Source is turned ON
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Determining the Optimum X-ray Source Voltage

This process describes how to determine the modified transmission value 
after installing a source filter, and identify which X-ray source voltage to use, 
to acquire images with minimal beam-hardening artifacts.

NOTE If a source filter is not required, the initial transmission value is already 
known from “Selecting the Source Filter,” step 7. Proceed directly to step 6 
of this process, to adjust the X-ray source voltage to achieve the ideal 
transmission value.

To determine the optimum X-ray source voltage

1. In the Sample X panel of the Motion Controller dialog box Sample tab, 
type the Sample X position previously noted in “Selecting the Source 
Filter,” step 3, in the Sample X text box, then click GO.

NOTE If you applied a Sample Theta angle other than 0° in “Selecting the 
Source Filter,” step 5, rotate Sample Theta to that angle before moving Sample X 
to the value noted in “Selecting the Source Filter,” step 3.

2. Image with sample – Follow steps a through c to take a single image, 
with the sample in the FOV:

a. Click  in the icon bar. A new Image window opens after 
the acquisition is complete.

b. If the image is too dark, with light intensity counts of less 
than 500 – In the XRay Source dialog box, type the maximum 
power value (8 for the 90 kV X-ray source; 10 for the 150 kV X-ray 

source) in the Power (W) text box, click Apply, then click  in the 
icon bar to acquire another single image. If the image is still too dark, 
increase the exposure time to 2 times (2x) the current value in the 
Acquisition Setting dialog box for Single acquisition mode, then 
click Start Acquisition. A new Image window opens after the 
acquisition is complete.

c. Note the image name in the top left corner of the final Image 
window’s title bar. This value is used later, as Input a in step 4c.
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3. Image without sample – Follow steps a through d to take a single 
image, with the sample out of the FOV:

a. In the Sample Theta panel of the Motion Controller dialog 
box Sample tab, ensure that the current Sample Theta position 
is 0 deg. If not, type 0 in the Sample Theta text box, then click 
GO to rotate Sample Theta to 0°.

b. Move the sample out of the FOV. In the Sample X panel of 
the Motion Controller dialog box Sample tab, type 60,000 
in the Sample X text box, then click GO.

c. Click  in the icon bar. A new Image window opens after 
the acquisition is complete.

d. Note the image name in the top left corner of the final Image 
window’s title bar. This value is used later, as Input b in step 4d.

4. Follow steps a through f to determine the transmission value:

a. Select Process > Image Calculator. The Calculator dialog 
box opens. (Refer to Figure 3-11.)

b. Select a/b operation.

c. Select the image acquired in step 2 (“image with sample,” using the 
image name noted in step 2c), from the Input a drop-down list box.

d. Select the image acquired in step 3 (“image without sample,” using 
the image name noted in step 3d), from the Input b drop-down 
list box.

NOTE The window name that appears in the Window Name text box 
is automatically derived, based upon the selected operation. You can 
leave it as is, or rename it.

e. Click Calculate. The Choose Output Format dialog box opens.

f. Click OK to select the Float output datatype (default). An 
Imagex_Div window opens, with the transmission value indicated 
in blue (lower left status bar of the window), on a scale of 0 to 1.

NOTE The ideal transmission value should be between 0.23 and 0.35.

NOTE If the transmission value is greater than 1, you divided the blank 
image by the sample image. Repeat steps 4c through 4f to divide the 
sample image by the blank image.
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5. If the transmission value is not within the specified range, use the 
processes described in the following table to adjust the value 
(refer to Table 3-6 for the minimum and maximum voltage 
values, by X-ray source).

NOTE If you have repeated step 5 several times, and the transmission value 
still does not fall within the specified range, proceed directly to “Determining 
the X-ray Source Power and Exposure Time.”

6. At this point, there are many open Image windows within the 
XMController main window. Select Window > Close All…, 
then click No to All to not save any of the images and to close 
all the open Image windows.

Proceed to “Determining the X-ray Source Power and Exposure Time.”

Transmission 
Value Process

< 0.23
In the XRay Source dialog box, type an increased source voltage 
value (for example, in steps of 20 kV) in the Voltage (kV) text box, 
click Apply, then repeat steps 1 through 4.

> 0.35
In the XRay Source dialog box, type a reduced source voltage 
value (for example, in steps of 20 kV) in the Voltage (kV) text box, 
click Apply, then repeat steps 1 through 4.

Table 3-6 Minimum and Maximum Voltage, by X-ray Source

X-ray Source

Voltage
(kV)

Minimum Maximum

90 kV 20 90

150 kV 40 150
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Determining the X-ray Source Power and Exposure Time

This process describes how to adjust the X-ray source power and exposure 
time used, to achieve the optimum light intensity counts per projection image.

To determine the source power and exposure time

1. In the Sample X panel of the Motion Controller dialog box Sample tab, 
type the Sample X position previously noted in “Selecting the Source 
Filter,” step 3, in the Sample X text box, then click GO.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

NOTE If you applied a Sample Theta angle other than 0° in “Selecting the 
Source Filter,” step 5, rotate Sample Theta to that angle after moving Sample X 
to the value noted in “Selecting the Source Filter,” step 3.

NOTE Step 1 is also referenced as part of the multi-tomography point 
collection process, documented in Chapter 4, “Automatically Acquiring 
Additional Data and Reconstructing Tomography Point(s).” If collecting multi-
tomography points, type the Sample X position previously noted in “Selecting 
Additional Tomography Points, Using Continuous Imaging,” step 8, on page 108, 
in the Sample X text box instead, then click GO.
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Figure 3-17 Motion Controller Dialog Box – Sample Tab

In step 1, type value here, 
then click GO

Current Position
96 MicroXCT-200 and MicroXCT-400 User’s Guide



Chapter 3 – Selecting the First Tomography Point
2. Use the processes described in the following table to set the power.

3. Follow steps a through c to adjust the exposure time, to acquire at least 
5,000 light intensity counts, but no more than 30,000. Note the required 
exposure time to achieve a sufficient quantity of counts within this range.

a. Click  in the icon bar. The Acquisition Setting dialog 
box opens.

Figure 3-18 Acquisition Setting Dialog Box – Settings Applied for Single 
Acquisition Mode

Magnification Lens Process

10X, 20X, and 40X
In the XRay Source dialog box, type 4 in the Power (W) 
text box, then click Apply. Ensure that Current remains 
at a value that is less than or equal to 100 μA.

Macro, 1X, 2X, and 4X
In the XRay Source dialog box, type the maximum 
power value (8 for the 90 kV source; 10 for the 150 kV 
source) in the Power (W) text box, then click Apply.
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b. Select and/or type the acquisition setting values:

CAUTION Camera temperature should be < -55°C. Contact the Xradia 
Support Team if the temperature is higher.

c. Click Start Acquisition to acquire the image. An Acquisition Status 
message box opens, indicating real-time acquisition status, and 
an Image window opens, showing the image being updated, 
with light intensity counts indicated in blue (lower left status bar 
of the window).

NOTE Acquisition Setting dialog box values cannot be changed until 
acquisition is stopped. If you need to abort the acquisition and change 

the values, click  in the icon bar, then repeat steps 3a through 3c 
with different settings.

The Acquisition Status message box closes when acquisition is 

complete, or when you click  in the icon bar to abort imaging.

4. If the light intensity counts are not at least 1,000, or are significantly 
higher than 5,000, at the region of interest, repeat step 3, adjusting the 
exposure time, as needed, to be as close to 5,000 counts as possible. 
For example, if the number of light intensity counts is 10,000 and the 
exposure time is 10 seconds, reducing the exposure time to 5 seconds 
decreases the number of counts to 5,000.

NOTE Ideally, light intensity counts at the region of interest should be 
higher than 5,000, but less than 30,000; however, anything greater than 
1,000 is acceptable.

The last image acquired is used in “Recording the First Selected 
Tomography Point (Region of Interest),” on page 103.

5. Note the exposure time required. This value is used later, as input to 
acquiring the tomography dataset in Chapter 4, “Automatically Acquiring 
Additional Data and Reconstructing Tomography Point(s),” and 
Chapter 5, “Manually Acquiring Images and Tomographic Data.”

Option Setting Value

Mode Single

Exposure Time (sec) 10

Binning 2

ReadOut Time (u sec) Fast (default)
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6. In the Sample Theta panel of the Motion Controller dialog box 
Sample tab, type 0 in the Sample Theta text box, then click GO 
to rotate Sample Theta to 0°.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

NOTE There is no upper limit to the length of exposure time; however, 
it should be more than 0.2 seconds. If the exposure time has been reduced 
to the minimum, and the intensity is still to high, reduce the Source power 
value, by way of the Xray Source dialog box.

Figure 3-19 Image Window Showing Light Intensity Count

Light intensity count
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After you have located a point with the appropriate X-ray source and 
detector positions, source filter (if needed), source voltage (kV) and 
power (W), and exposure time, proceed to the next process:

– If you want to automatically acquire tomography of that point 
with a recipe, record the point, and set up the recipe, proceed 
to Chapter 4, “Automatically Acquiring Additional Data and 
Reconstructing Tomography Point(s)”

– If you want to acquire tomography of that point, by manually 
collecting a 3D (tomography) dataset, proceed to Chapter 5, 
“Manually Acquiring Images and Tomographic Data”

– If you want to continue to collect points, to be automatically imaged 
with a recipe, proceed to Chapter 4, “Automatically Acquiring 
Additional Data and Reconstructing Tomography Point(s)”
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4 Automatically Acquiring 
Additional Data and 
Reconstructing 
Tomography Point(s)

This chapter describes how to use XMController to record the tomography 
point selected in Chapter 3, select the remaining tomography points 
for tomography datasets, and run an automatic recipe. Recipes are used 
to automatically collect and reconstruct tomographic data. This is useful 
for repeated scanning of common areas on many samples, or of several 
areas on a single sample. The end result is a ready-to-load, 3D reconstructed 
volume of the region(s) of interest.

CAUTION Troubleshooting tips regarding imminent collision appear 
throughout this chapter. For more complete troubleshooting tips regarding 
imminent collision, as well as for collision, refer to “Troubleshooting Sample 
Issues in XMController,” on page 210.

NOTE The process for selecting the first tomography point is described in 
Chapter 3, “Selecting the First Tomography Point.” If you have not yet collected 
the first tomography point, proceed directly to Chapter 3, “Selecting the First 
Tomography Point.”

NOTE If you need to manually acquire and reconstruct images, refer to 
Chapter 5, “Manually Acquiring Images and Tomographic Data,” and Chapter 6, 
“Manually Reconstructing a 3D Dataset,” respectively.
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Process Overview

The process of automatically acquiring additional data and reconstructing 
tomography point(s) is comprised of the following subprocesses:

1. Recording the First Selected Tomography Point (Region of Interest).

2. Selecting Additional Tomography Points, Using Continuous Imaging.

3. Setting up a Recipe.

– Tour of the Recipe Dialog Box

– Opening the Recipe Dialog Box and Editing Collected Points

4. Setting Acquisition and Reconstruction Parameters.

5. Running a Recipe.

Each is described in the sections that follow.
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Recording the First Selected Tomography Point 
(Region of Interest)

This process describes how to record the first tomography point that 
you identified in Chapter 3, “Selecting the First Tomography Point.” 
This tomography point is used later, by the recipe, and appears 
first in the Recipe dialog box’s Tomography Locations panel.

NOTE Use of this tomography point and the Tomography Locations panel 
is described later, in “Opening the Recipe Dialog Box and Editing Collected Points.”

To record the first acquired tomography point

1. Click the Image window of the last “image with sample” acquired 
in “Determining the X-ray Source Power and Exposure Time,” 
step 4, on page 98, to make it the active window (that is, bring 
it to the front of any other open windows).

2. Select View > Highlight Center of FOV. Yellow cross-hairs highlighting 
the center of the FOV are added to the current Image window.
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Figure 4-1 Example Image Window, with Yellow Cross-Hairs Added

3. Click  in the icon bar. The Image Controls dialog box opens.

NOTE If  is highlighted orange in the icon bar, the Image Controls dialog 
box is already open, and clicking the icon closes, rather than opens, the 
dialog box. If the dialog box is hidden behind other windows or dialog boxes, 
click the highlighted orange icon, then click the non-highlighted icon, 
as described above.
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4. Select the Annotation tab, then click  to access the Tomography 
Point tool.

Figure 4-2 Image Controls Dialog Box – Annotation Tab

5. Click the center of the Image window, at the intersection of the yellow 
cross-hairs. (The red bounding box indicating the FOV should also 
be visible.) The Tomographic location set dialog box opens, defaulted 
to Add the point to tomographic location set.

Figure 4-3 Tomographic location set Dialog Box

In step 4, click this 
icon to select the 
Tomography Point tool

In step 7, click this 
icon to cancel the 
Tomography Point 

tool selection

Click this
button first,

if this is the first
tomography point
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6. Use the processes described in the following table to complete 
this step, dependent upon whether this is the first or subsequent 
tomography point.

NOTE Do not select Make this point as a Registration Point.

7. In the Annotation tab, click  to cancel the Tomography Point tool 
selection for the image. (Refer to Figure 4-2.)

Proceed to the next process:

– If you need to collect additional tomography points (for the 
recipe that you will be running later), proceed to “Selecting 
Additional Tomography Points, Using Continuous Imaging”

– If you do not need to collect additional tomography points, 
proceed to “Setting up a Recipe”

First or Subsequent 
Tomography Point Process

First

Click Clear existing Tomo Location and 
Registration Point, then click OK.
The image created will be labeled with a letter A 
(upper left corner).

Subsequent

Click OK.
The image created will be labeled with a letter B 
for the second point, C for the third point, and 
so forth (upper left corner).
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Selecting Additional Tomography Points, 
Using Continuous Imaging

This process describes how to use Continuous acquisition mode to select 
additional tomography points, when you need to collect tomography data 
for more than one point.

NOTE If you need to generate tomography on a single point only, 
proceed directly to “Setting up a Recipe.”

NOTE If you are just beginning to use the MicroXCT, it is recommended 
that you try running a few recipes with a single tomography point, to 
familiarize yourself with the overall process. To do this, proceed directly 
to “Setting up a Recipe,” run a few practice recipes, then return to this 
process when you are ready to run recipes with multiple points.

NOTE Because most of the process steps for this process are described 
earlier in the guide, they are cross-referenced, rather than repeated.

To select additional tomography points, using continuous imaging

1. Open the Motion Controller dialog box, if it is not already open, 

by clicking  in the icon bar. The dialog box opens, defaulted 
to the Sample tab.

NOTE If  is highlighted orange in the icon bar, the Motion Controller 
dialog box is already open, and clicking the icon closes, rather than opens, 
the dialog box. If the dialog box is hidden behind other windows or dialog 
boxes, click the highlighted orange icon, then click the non-highlighted icon, 
as described above.

2. Follow steps a and b to move the detector and X-ray source, respectively, 
away from the sample stage, to ensure that they do not collide with nor 
touch the sample:

a. Select the Motion Controller dialog box Detector tab, type a value 
that is 20 mm greater than the current Camera Z position in the 
Camera Z text box, then click GO.

b. Select the Motion Controller dialog box Source tab, type -130 
in the Source Z text box, then click GO.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.
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3. Click the drop-down arrow to the right of  in the icon bar, 
then select the lowest magnification.

NOTE Instructions for selecting the lowest magnification are provided 
in “Selecting the Lowest Magnification,” on page 51.

4. Click  in the icon bar to start Continuous acquisition mode, 
using the same exposure time and binning values used when the first 
tomography point was collected, as described in “Collecting Continuous 
Images,” steps 1 and 2, starting on page 63.

5. Identify an additional single point, using the same process described 
in “Identifying the First Point,” on page 67.

6. Position the detector and X-ray source as close to the sample as 
possible, without collision or touching, through the tomographic 
angle ranges, using the same processes described in “Finely 
Positioning the Detector,” on page 71, and “Finely Positioning the 
X-ray Source,” on page 75, respectively.

7. In the Motion Controller dialog box, select the Sample tab. In the 
Sample X panel, note the current Sample X position. This value 
is used in the next step.

8. Determine the optimum voltage, using the same process described 
in “Determining the Optimum X-ray Source Voltage,” on page 92. 
When finished, use the Sample X position noted in step 7 to move 
the sample back into the FOV.

9. Determine the power settings and note the exposure time required, 
using the same process described in “Determining the X-ray Source 
Power and Exposure Time,” on page 95.

10. Record the selected point identified in step 5 (Point B if second point, 
Point C if third point, and so forth), using the same process described 
in “Recording the First Selected Tomography Point (Region of Interest).”

11. Repeat steps 2 through 10 for each additional tomography point 
to be acquired (Point C, and if needed, additional points).

The tomographic point selection process is now complete. 
Proceed to “Setting up a Recipe.”
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Setting up a Recipe

This process describes how to set up a recipe, which is run to automatically 
collect and reconstruct tomography data, using the information and processes 
described in the following sections:

– Tour of the Recipe Dialog Box

– Opening the Recipe Dialog Box and Editing Collected Points

Figure 4-4 provides an overall view of the Recipe dialog box. Table 4-1 
describes the Recipe dialog box panels and boxes – what information 
you must supply and what is automatically entered.
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Tour of the Recipe Dialog Box
This section describes the Recipe dialog box. The Recipe dialog box has 
several panels, some of which are automatically filled in, and others that 
require manual text entry. The two most important dialog box panels for 
recipe generation are:

– Navigation – Contains settings specific to each tomographic point

– Tomography Locations – Contains points where tomographies 
will be acquired

Figure 4-4 provides a view of the Recipe dialog box. Table 4-1 briefly describes 
the dialog box’s panels, each panel’s function, and whether the information 
is automatically or manually entered/selected.

Figure 4-4 Recipe Dialog Box – Navigation and Tomography Locations Panels Highlighted

To
m

o
g

ra
p

hy
Lo

c
a

tio
n

s 
Pa

n
e

l
N

a
vi

g
a

tio
n

 P
a

n
e

l
a

n
d

 S
u

b
p

a
n

e
ls
110 MicroXCT-200 and MicroXCT-400 User’s Guide



Chapter 4 – Automatically Acquiring Additional 
Table 4-1 Recipe Dialog Box – Panel and Subpanel Descriptions

Panel
Subpanel

of

Data Entry Method

DescriptionAutomatic Manual

Acquisition

Navigation

Defines the starting and ending angles, 
and number of 2D images (projections) 
to be acquired per tomography point.a

Camera

Defines the exposure time required per 
projection, and the binning value. Leave 
Readout time as Fast. Select Apply 
exposure time correction only if you 
are running a semiconductor sample. 
The standard exposure time table will 
increase the exposure time at higher angles, 
up to eight times (8x) its setting at 0°, 
at Sample Theta = ±90°.

Source

Indicates the X-ray source voltage and 
power values. These values are 
automatically entered, based upon the 
images from which the tomography points 
were selected and should not be altered.

Magnification

Indicates the lens magnification and 
Source-to-Sample and Detector-to-
Sample distances. These values are also 
automatically entered based upon the 
images from which the tomography points 
were selected and should not be altered.

Multiple 
References 
Specific

Select Enable Multiple References to 
acquire reference images with specific 
parameters during tomography. This 
reduces artifacts due to variations in X-ray 
source spot and intensity, but is unnecessary 
if Dynamic Ring Removal (DRR) is enabled. 
The process for filling in the remaining text 
boxes is described in “Setting Acquisition 
and Reconstruction Parameters,” step 6.

Reconstruction
Defines reference image collection 
and reconstruction parameters.

Byte scaling
Navigation and 
Reconstruction

Used to set the global minimum and 
maximum byte scaling value for 
reconstruction, when stitching is required.
Also provides support for CT scaling.b

Turn OFF source once all recipes 
are done

Select to turn OFF the X-ray source after 
tomography for all tomography points 
in this recipe have been collected (default).
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Registration point

Set to 0, 0, 0 (X, Y, Z coordinates), by 
default. Use only for repeated samples with 
a well-defined fiducialc point; the samples 
must be identically mounted.d

Tomography Locations
Lists tomography points at which 
tomographic data will be acquired.

Saving
Specifies the location and file name for 
saving the output tomography dataset 
for this recipe.

Time and Space Required
Indicates the total amount of time and 
hard disk drive space required for all 
the tomography points in this recipe.

Operations
Select the next action to be taken – Open, 
Save, Run the current recipe, or Close.

a. Start and end angles are automatically calculated for a range of 180° plus fan angle. The angles must 
be manually entered for tomographic angle ranges of -180 to +180 for MicroXCT that are 360°-enabled. 
Instructions for determining whether the MicroXCT is 360°-enabled are provided in Appendix F, 
“Determining Whether the MicroXCT is 360°-Enabled.”

b. Refer to CT Scaling Instructions (G000135), included with the MicroXCT product documentation, 
for details related to CT scaling.

c. Fixed basis of reference or comparison.
d. Sample mounting options are discussed in “Mounting the Sample in/on a Sample Holder,” on page 33.

Table 4-1 Recipe Dialog Box – Panel and Subpanel Descriptions

Panel
Subpanel

of

Data Entry Method

DescriptionAutomatic Manual
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Opening the Recipe Dialog Box and Editing 
Collected Points
This process describes how to set up the recipe. When the recipe is run, data 
is collected from the previously selected and recorded tomography points.

NOTE This process assumes that you still have the Image window(s) open 
from the “Recording the First Selected Tomography Point (Region of Interest)” and 
“Selecting Additional Tomography Points, Using Continuous Imaging” processes.

To open the recipe dialog box and edit the collected points

1. Open the XRay Source dialog box, using one of the following methods:

– Select Microscope > Source Controller… 

– Click  in the icon bar

NOTE If  is highlighted orange in the icon bar, the Xray Source dialog box 
is already open.

2. Ensure that the X-ray source has been turned ON for more than 
15 minutes.

NOTE 15 minutes is the minimum warm-up period, if the X-ray source has 
been turned OFF for more than 15 minutes, for optimal X-ray source stability 
during scans.

NOTE The X-ray source should already be at the correct voltage and 
power settings for the selected sample, after completing the setup 
processes described in in Chapter 2, “Setting Up for Data Acquisition,” 
and Chapter 3, “Selecting the First Tomography Point.”
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3. Follow steps a through c to enable DRR, so that the reconstructed images 
will be free of ring artifacts:

a. Select Microscope > Configure System. The Configure System 
dialog box opens, defaulted to the General tab.

Figure 4-5 Configure System Dialog Box – General Tab, with Use DRR Selected

b. Select Use DRR (Dynamic Ring Removal).

c. Click OK.

4. Open the Recipe dialog box (refer to Figure 4-4), using one of the 
following methods:

– Select Microscope > Recipes… 

– Click  in the icon bar

In step 3b,  
select this option 
to enable DRR
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5. In the Tomography Locations panel, click Add the list of tomography 
locations from the current images. The tomography points selected 
earlier are added to the panel.

Figure 4-6 Recipe Dialog Box – Tomography Locations Panel, with Previously 
Selected Tomography Points Added

6. You can manipulate the listed tomography points, using the information 
provided in Table 4-2.

Entering/editing of the tomography locations is complete. 
Proceed to “Setting Acquisition and Reconstruction Parameters.”

Table 4-2 Tomography Locations Panel (Icon) Buttons

Button Function Process

Move UP Select the tomography point, then click  to move the 
point UP in the list.

Move DOWN Select the tomography point, then click  to move the 
point DOWN in the list.

Delete Select the tomography point, then click  to remove the 
point from the list.

Add
Click  to add a 0, 0, 0 (X, Y, Z) tomography point 
to the list. Change the point’s location, by editing the X, Y, 
and Z coordinates in the X/Y/Z Dist. from Reg Point (um) 
text boxes (left side of panel).

In step 5,
click here 

to add 
tomography 

points from 
the current 

Image window
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Setting Acquisition and Reconstruction Parameters

This process provides the opportunity to enter information in the Recipe 
dialog box that is not automatically filled in by XMController in the 
Acquisition, Camera, Source, Magnification, and Multiple References 
Specific panels.

Figure 4-7 Recipe Dialog Box – Acquisition, Camera, Source, Magnification, 
and Multiple References Specific Panels, with Buttons
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To set the acquisition and reconstruction parameters, for each 
tomography location

1. Select the first tomography point listed in the Tomography 
Locations panel.

NOTE When this process is repeated, as described in step 8, select each 
tomography point, in turn, to alter its acquisition and reconstruction settings.

2. In the Acquisition panel, the start and end angles are defaulted 
to include the fan angle for 180° + fan angle tomography, which is 
required for good reconstruction of that particular tomography point. 
Use the processes described in the following two bullets to determine 
and apply the appropriate angle option:

– 180° + fan angle tomography – Use this setting for flat samples, 
such as semiconductor samples. This angle range is automatically 
calculated and displayed for each point. In the text box, type the 
total number of images to collect. It is recommended to acquire 
at least two per degree. Calculate the number of images to collect as: 
 
((End Angle - Start Angle) * n) +1 
 
where n = number of images per degree

– 360° tomography – Set Start angle = -180 
 
Set End angle = 180 - 1/n 
 
Set No. of Image = (360 * n) +1 
 
where n = number of images per degree
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3. In the Camera panel, select and/or type the following camera 
setting values:

NOTE If the binning value is 1 (instead of 2), use an exposure time that 
is four times (4x) the values noted for each point previously collected during 
the single- and multiple-point “Recording the First Selected Tomography Point 
(Region of Interest)” processes.

4. In the Source panel, the Source Voltage and Power values are already 
set. Do not change these values. 

5. In the Magnification panel, the Source-sample distance and 
the Detector-sample distance are already set. Do not change 
these values. 

6. In the Multiple References Specific panel, select and/or type the 
following setting values:

NOTE If Enable Multiple References is not selected, but Collect Reference 
is selected in the Reconstruction panel, an averaged reference of 10 images 
will be acquired at the beginning of the recipe’s data acquisition.

NOTE If the sample is too large and cannot be automatically moved 
out of the FOV, do not enable Multiple References.

Option Setting Value

Exposure Time

Type the exposure time noted for 
each point previously collected 
in “Determining the X-ray Source Power 
and Exposure Time,” step 3, on page 97

Apply exposure time correction Do not select

Readout Time Fast (default)

Binning 2

Option Setting Value

Enable Multiple References
Select, if you need to acquire multiple 
reference images

Number of Frames Between Reference 100

Minimal Number of Reference Images 
to be Averaged

10

Average all reference images 
and apply as single reference

Select
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7. Follow steps a through g to specify the Reconstruction panel settings 
(upper right corner of the dialog box):

Figure 4-8 Recipe Dialog Box – Reconstruction Panel and 
Byte Scaling Subpanel

a. Select one of the following options from the Reference and Auto 
Recon drop-down list box:

Option Usage

Auto recon and 
collect reference

Use this option only if the sample will not collide with 
nor touch the detector and X-ray source between 
Sample Theta at -10° and +170°.
Automatically reconstructs and collects the reference 
image for this tomography point.

Collect reference 
but no auto recon

Use this option if the sample will collide with the 
detector and X-ray source, between Sample Theta 
at -10° and +170°.
Collects the reference image for this tomography 
point, but does not automatically reconstruct 
the dataset.

Do not auto recon 
or collect reference

Use this option if the sample is too large 
to automatically move out of the FOV.
Collects only the projections for this tomography 
point. You must later remove the sample from 
the FOV and manually collect the reference 
image, per processes described in “Collecting a 
Reference Image,” on page 143.
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b. Estimate center shift is selected only if Auto recon and collect 
reference is also selected. The MicroXCT takes two projection 
images of the sample, one at Sample Theta = -10° and Sample 
Theta = +170°, to estimate the center shift before acquiring the 
tomography dataset.

NOTE If the center shift is known (rarely), type the center shift value 
in the Or use this center shift (pixels) text box, then cancel the Estimate 
center shift selection.

c. Select and/or type the following reconstruction setting values:

d. Select one of the following options from the Ring removal 
drop-down list box:

NOTE 3-section ring removal is known to sometimes add rings when there 
are regularly repeating high-contrast features.

Option Setting Value

Output data type
USHORT(16bit) (default)
Provides grayscale over a range 
of 0 to 65,535.

Recon binning 1 (default; recommended)

Beam hardening config file
Standard Beam Hardening Correction 
(default)

Beam hardening constant

If the beam hardening correction 
constant is known for the sample 
(rarely, unless similar samples have 
been run before), type its value, 
to be used in auto-reconstruction

Option Usage

None: No Ring Removal Use this option if DRR is enabled.

Low contrast – 8-section RR
Use this option if DRR is disabled, for 
bone, rock, plastic, carbon composite, 
or composite material samples.

High contrast – 3-section RR
Use this option if DRR is disabled, 
for high-contrast samples, such 
as semiconductors.
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e. Select one of the following options from the Defect correction 
drop-down list box:

NOTE Defect calibration must be completed before the Defect correction 
options are functional. (The defect calibration process must be performed 
by trained Xradia personnel, and is typically done during install or during 
a preventive maintenance session.) If defect calibration is not completed, 
an error message is issued during image reconstruction.

f. Select a software filter from the Recon Filters drop-down list box. 
The minimum is Smooth (Kernel Size = 0.5); if unsure, start with 
Smooth (Kernel Size = 0.7).

NOTE The Recon Filters value is magnification lens- and sample-dependent.

NOTE Determine which software filter value provides the most satisfactory 
balance between image resolution and noise (through your own experience); 
the correct software filter value provides for significant noise reduction, but 
has a minimal impact on resolution.

NOTE Do not use None nor Sharp (Shepp-Logan).

Option Usage

Bright and dark spots

Use this option if DRR is disabled, to 
remove both bright and dark defects 
on the projections. If these defects are 
not removed, intense rings might be 
observed in the reconstruction.

Bright spots only

Use this option if the Bright 
and dark spots option seems 
to add more artifacts than are 
desirable to the reconstruction.

Disable
Use this option in Version 7.x 
when DRR is enabled, to disable 
defect correction.
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g. In the Byte Scaling subpanel of the Reconstruction panel, apply 
byte scaling only if either of the following conditions is true:

NOTE Refer to CT Scaling Instructions (G000135), included with the MicroXCT 
product documentation, for details related to CT scaling.

8. Select the next tomography point in the Tomography Locations panel, 
then repeat steps 2 through 7, until all parameters are set up for all 
tomography points.

9. Follow steps a through d to save the recipe file:

a. Click Save as a recipe file… (lower right corner of the dialog box). 
A Save File dialog box opens.

b. Browse to the destination file path.

c. Type the new file name in the File name text box.

d. Click Save.

Recipe acquisition and reconstruction parameter setup is complete. 
Proceed to “Running a Recipe.”

Apply Byte Scaling When True Process

Global minimum and maximum byte 
scaling values are known from a prior 
similar sample (scan acquired at the 
same settings (X-ray source power, 
detector and X-ray source distances, 
number of projections, exposure 
times, binning, and magnification)).

Select Use the following min 
and max…, then type the global 
minimum and maximum byte scaling 
values in the Global minimum 
and Global maximum text 
boxes, respectively. 

Dataset is to be CT-scaled and 
CT scaling calibration is complete.

Select Apply CT Scale, then select 
the correct software filter from the 
CTScale Filter drop-down list box.
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Running a Recipe

This process describes how to run a recipe, to automatically collect 
and reconstruct the previously set-up tomographic data.

NOTE XMController internally calls XMReconstructor to reconstruct 
the dataset.

NOTE The amount of free space required on the hard disk drive must be at 
least 1 GB more than the file size of the tomography (projection) dataset.

To run a recipe

1. Turn OFF the interior light, by moving the visual light camera light 
switch (D on Figure 1-7, “Ergonomic Station,” on page 16) to the 
DOWN (OFF) position.

2. Click Browse on the Recipe dialog box Saving panel (lower left corner 
of the dialog box), to locate the destination file path.

Figure 4-9 Recipe Dialog Box – Saving Panel

3. Type a base file name in the File base name text box.

NOTE XMController collects 2D images, known as projection or data files. 
XMReconstructor creates reconstructed images or slices from these files.

NOTE The projection file from the first tomography point has Tomo_Area A 
appended to the file name. The projection file from the second tomography 
point has Tomo_Area B appended to the file name, and so forth. The X, Y, 
and Z of the actual point(s) appear(s) in the Recipe dialog box Tomography 
Locations panel, as described in “Setting up a Recipe.”

4. Click Run current recipe on the Recipe dialog box Operations panel, 
to begin running the recipe. An Acquisition Status message box opens 
(lower right corner) for each tomography point. When all data has been 
acquired, the Acquisition Status message box closes.
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Figure 4-10 Recipe Dialog Box – Operations Panel

After the recipe finishes running, proceed to the next process:

– If the tomography point was automatically and successfully 
reconstructed (the option Auto recon and collect reference was 
selected in “Setting Acquisition and Reconstruction Parameters,” 
step 7a), proceed to Chapter 7, “Viewing Tomographies,” to open 
the file in XM3DViewer and view the 3D volume reconstruction

– If the center shift is incorrect, proceed to Chapter 6, “Manually 
Reconstructing a 3D Dataset,” to manually repeat the reconstruction

– If the tomography point was not automatically reconstructed, proceed 
to Chapter 6, “Manually Reconstructing a 3D Dataset,” to manually 
reconstruct the dataset
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5 Manually Acquiring Images 
and Tomographic Data

This chapter describes how to use XMController to acquire images 
and tomographic data using Continuous, Single, Mosaic, Tomography, and 
Averaging acquisition modes, and how to create and apply a reference image.

CAUTION Troubleshooting tips regarding imminent collision appear 
throughout this chapter. For more complete troubleshooting tips regarding 
imminent collision, as well as for collision, refer to “Troubleshooting Sample 
Issues in XMController,” on page 210.

NOTE The automatic process for acquiring and reconstructing tomographic 
data is described in Chapter 4, “Automatically Acquiring Additional Data and 
Reconstructing Tomography Point(s).”

NOTE The processes in this chapter assume that XMController is already 
running. If you need to start XMController, refer to “Loading the Sample Holder 
Assembly onto the Sample Stage,” step 1, on page 42, for instructions.

NOTE The processes within this chapter assume that the sample is loaded 
into the MicroXCT, and that the detector, X-ray source, and sample are 
properly aligned, according to the processes described in Chapter 2, “Setting 
Up for Data Acquisition,” and Chapter 3, “Selecting the First Tomography Point.”
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Process Overview

The process of manually acquiring images and tomographic data is comprised 
of the following subprocesses:

1. Acquiring Images.

– Collecting Continuous Images

– Collecting a Single 2D Image

– Collecting a Mosaic Image

– Manually Collecting a 3D (Tomography) Dataset

– Collecting a Reference Image

2. Applying the Reference Image.

Each is described in the sections that follow.
126 MicroXCT-200 and MicroXCT-400 User’s Guide



Chapter 5 – Manually Acquiring Images and 
Acquiring Images

After the sample is installed and the X-ray source is turned ON (described 
in Chapter 2, “Setting Up for Data Acquisition”), you can use XMController 
to manually acquire images.

The following processes are used for acquiring images:

– Collecting Continuous Images

– Collecting a Single 2D Image

– Collecting a Mosaic Image

– Manually Collecting a 3D (Tomography) Dataset

– Collecting a Reference Image

Each is described in the sections that follow.
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Collecting Continuous Images
This process describes how to locate the region of interest in a sample, and 
to move the region of interest to the center of the FOV by double-clicking.

Double-clicking to move the sample is allowed only in Continuous acquisition 
mode. For description of how this is used in positioning the sample, refer 
to “Identifying the First Point,” on page 67.

To collect continuous images

1. Click  in the icon bar. The Acquisition Setting dialog box opens.

Figure 5-1 Acquisition Setting Dialog Box – Settings Applied for Continuous 
Acquisition Mode
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2. Select and/or type the acquisition setting values:

CAUTION Camera temperature should be < -55°C. Contact the Xradia 
Support Team if the temperature is higher.

3. Click Start Acquisition to acquire the image. An Acquisition Status 
message box opens, indicating real-time acquisition status, and an Image 
window opens, showing the image being updated, with light intensity 
counts indicated in blue (lower left status bar of the window).

NOTE Acquisition Setting dialog box values cannot be changed until 
acquisition is stopped. If you need to abort the acquisition and change 

the values, click  in the icon bar, then repeat steps 1 through 3 with 
a different value for exposure time. The minimum value that should 
be used for exposure time is 0.2 seconds.

The Acquisition Status message box closes when you click  
in the icon bar to abort continuous imaging.

NOTE To continue collecting images using the same acquisition setting 

values, click  in the icon bar. If you need to specify an exposure time 
other than 1 second or binning other than 4, change the values in the 
Acquisition Setting dialog box.

NOTE If image contrast and/or brightness requires adjustment, refer to the 
troubleshooting tips referenced in “Troubleshooting Image Contrast, Brightness, 
and Light Intensity Count Issues,” on page 226.

Option Setting Value

Mode Continuous

Exposure Time (sec) 1

Binning 4

ReadOut Time (u sec) Fast (default)
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4. Because continuous imaging is typically used only for sample 
positioning, these images are not typically saved.

Follow steps a through e if you want to save the images after acquisition 
is complete:

a. If you collected more than one set of continuous images, click the 
Image window of an image you want to save.

b. Click  in the icon bar. The Save File dialog box opens.

c. Browse to the destination file path.

d. Type the new file name in the File name text box.

e. Click Save.

Repeat steps a through e for each continuous image to be saved.

Proceed to the next process, depending upon what needs to be 
done next:

– If you need to determine the most ideal settings for a particular 
sample, proceed to “Collecting a Single 2D Image”

– If you need to view an overview of the sample, proceed to “Collecting 
a Mosaic Image”

– If you need to create a 3D volume dataset, to be manually 
reconstructed later to create a 3D reconstructed volume, 
proceed to “Manually Collecting a 3D (Tomography) Dataset”
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Collecting a Single 2D Image
This process describes how to collect a single image, using Single acquisition 
mode, which can be used to determine the most ideal settings for a 
particular sample.

To collect a single 2D image

1. Click  in the icon bar. The Acquisition Setting dialog box opens.

Figure 5-2 Acquisition Setting Dialog Box – Settings Applied for Single 
Acquisition Mode
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2. Select and/or type the acquisition setting values:

CAUTION Camera temperature should be < -55°C. Contact the Xradia 
Support Team if the temperature is higher.

3. Click Start Acquisition to acquire the image. An Acquisition Status 
message box opens, indicating real-time acquisition status, and an Image 
window opens, showing the image being updated, with light intensity 
counts indicated in blue (lower left status bar of the window).

NOTE Acquisition Setting dialog box values cannot be changed until 
acquisition is stopped. The acquisition will complete after the required 

exposure time, or you can click  in the icon bar to stop acquisition 
before completion.

The Acquisition Status message box closes when acquisition is 

complete, or when you click  in the icon bar to abort imaging.

NOTE To collect another image using the same acquisition setting values, 

click  in the icon bar. If you need to specify an exposure time other than 
10 seconds or binning other than 2, change the values in the Acquisition Setting 
dialog box.

NOTE If image contrast and/or brightness requires adjustment, refer to the 
troubleshooting tips referenced in “Troubleshooting Image Contrast, Brightness, 
and Light Intensity Count Issues,” on page 226.

Option Setting Value

Mode Single

Exposure Time (sec) 10

Binning 2

ReadOut Time (u sec) Fast (default)
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4. After acquisition is complete, follow steps a through e to save the image:

a. If you collected more than one single image, click the Image window 
of the image you want to save.

b. Click  in the icon bar. The Save File dialog box opens.

c. Browse to the destination file path.

d. Type the new file name in the File name text box.

e. Click Save.

Repeat steps a through e for each single image to be saved.

Proceed to “Collecting a Reference Image.”

NOTE When acquiring a reference image, the exposure time, detector and 
X-ray source positions, camera binning, and X-ray voltage and power settings 
should match the settings used for the actual tomography, or other images 
collected with different acquisition modes. Take note of the above settings, 
before proceeding to “Collecting a Reference Image.”
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Collecting a Mosaic Image
This process describes how to collect a mosaic image, using Mosaic acquisition 
mode. A mosaic is one large image that is created by scanning the sample, 
and then tiling the individual images acquired at each scanned X, Y location, 
to provide an overview of the sample.

NOTE A mosaic can only be collected when Sample Theta = 0°. In a future 
release, a mosaic can be collected at Sample Theta = ±90° as well.

To collect a mosaic image

1. Click  in the icon bar to open the Motion Controller dialog box, if it 
is not already open. The dialog box opens, defaulted to the Sample tab.

NOTE If  is highlighted orange in the icon bar, the Motion Controller 
dialog box is already open.

2. In the Sample Theta panel of the Motion Controller dialog box 
Sample tab, type 0 in the Sample Theta text box, then click GO 
to rotate Sample Theta to 0°.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.
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3. Click  in the icon bar. The Acquisition Setting dialog box opens.

Figure 5-3 Acquisition Setting Dialog Box – Settings Applied for Mosaic 
Acquisition Mode

4. Select and/or type the acquisition setting values:

CAUTION Camera temperature should be < -55°C. Contact the Xradia 
Support Team if the temperature is higher.

Option Setting Value

Mode Mosaic

Exposure Time (sec) Between 5 and 20

Binning 4 (or less, for higher resolution)

ReadOut Time (u sec) Fast (default)

In step 5, use the 
mouse pointer 

to click and drag 
within the grid-lined 

black square, to 
select the region of 

interest to image
MicroXCT-200 and MicroXCT-400 User’s Guide 135



Chapter 5 – Manually Acquiring Images and Tomographic Data
5. Select the region to image (and establish the Mode Dependent 
Settings). Use the mouse pointer to click and drag within the grid-lined 
black square, to select the region to image. (Refer to Figure 5-3.) The 
small yellow square indicates the current sample location. Each white 
square is a single FOV.

6. Click Start Acquisition to acquire the image. An Acquisition Status 
message box opens, indicating real-time acquisition status, and an Image 
window opens, showing the image being updated, with light intensity 
counts indicated in blue (lower left status bar of the window).

NOTE Acquisition Setting dialog box values cannot be changed until 
acquisition is stopped. If you need to abort the acquisition and change 

the values, click  in the icon bar, then repeat steps 3 through 6 with 
different settings.

The Acquisition Status message box closes when acquisition is 

complete, or when you click  in the icon bar to abort imaging.

7. After acquisition is complete, follow steps a through d to save the image:

a. Click  in the icon bar. The Save File dialog box opens.

b. Browse to the destination file path.

c. Type the new file name in the File name text box.

d. Click Save.

Proceed to “Collecting a Reference Image.”

NOTE When acquiring a reference image, the exposure time, detector and 
X-ray source positions, camera binning, and X-ray voltage and power settings 
should match the settings used for the actual tomography, or other images 
collected with different acquisition modes. Take note of the above settings, 
before proceeding to “Collecting a Reference Image.”
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Manually Collecting a 3D (Tomography) Dataset
This process describes how to collect a 3D tomography dataset, using 
Tomography acquisition mode. In this collection process, a series of 
2D images (also called projections) between specific starting and ending 
angles (Sample Theta) are acquired. These projections are later reconstructed 
by XMReconstructor (in Chapter 6, “Manually Reconstructing a 3D Dataset”) 
to create the 3D reconstructed volume.

NOTE If you want to acquire ring-artifact-free reconstruction, use Dynamic 
Ring Removal (DRR). Select Microscope > Configure System to open the 
Configure System dialog box. In the General tab (default), select Use DRR 
(Dynamic Ring Removal), then click OK to enable DRR.

Figure 5-4 Configure System Dialog Box – General Tab, with Use DRR Selected

Select this option
to enable DRR
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To manually collect a 3D (tomography) dataset

1. Turn OFF the interior light, by moving the visual light camera light 
switch (D on Figure 1-7, “Ergonomic Station,” on page 16) to the 
DOWN (OFF) position.

2. Determine whether MicroXCT is 360°-enabled, using Method 1, 
as described in Appendix F, “Determining Whether the MicroXCT 
is 360°-Enabled.” This information is used later, in the steps that follow.

3. MicroXCT is not 360°-enabled or imaging a flat sample (such 
as a semiconductor sample) – Follow steps a and b to determine 
the angle range for 180 + fan.

a. Select Microscope > Calculate Optimal Tomography Angles…. 
The Optimize Tomography Angles dialog box opens.

The Magnification, Source position (Source Z), and Detector 
position (Camera Z) indicate the current MicroXCT state.

Figure 5-5 Optimize Tomography Angles Dialog Box

b. Note the Optimal start and end angle (degree) values, then click 
Close. These values are used later, in step 6.
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4. Click  in the icon bar. The Acquisition Setting dialog box opens.

Figure 5-6 Acquisition Setting Dialog Box – Settings Applied for Tomography 
Acquisition Mode

5. Select and/or type the following acquisition setting values:

CAUTION Camera temperature should be < -55°C. Contact the Xradia 
Support Team if the temperature is higher.

NOTE If using a binning value of 1 instead of 2, use an exposure time that 
is four times (4x) the value noted for this point in “Determining the X-ray Source 
Power and Exposure Time,” step 5, on page 98.

Option Setting Value

Mode Tomography

Exposure Time (sec)
Between 5 to 60, or the value noted in 
“Determining the X-ray Source Power 
and Exposure Time,” step 5, on page 98

Binning 2 (refer to Note below)

ReadOut Time (u sec) Fast (default)
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6. Type the start and end angle values in their associated text boxes, based 
upon the MicroXCT capability or sample type:

7. Type the number of images to collect in the No. of Images text box, 
using the processes described in the following bullets to determine 
the value:

– MicroXCT is 360°-enabled – Set No. of Images to (360 * n) +1, 
where n = number of images per degree. 
 
For example, for n = 2: 
 
No. of Images = (360 * 2)+1 = 721

– MicroXCT is not 360°-enabled or imaging a flat sample (such 
as a semiconductor sample) – It is recommended to acquire at least 
two images per degree. Calculate the number of images to collect 
as ((End Angle - Start Angle) * n) +1, where n = number 
of images per degree. 
 
For example, for n = 2, End Angle = 91, and Start Angle = -91: 
 
No. of Images = ((91 - (-91)) * 2) + 1 = 365

MicroXCT Capability
or Sample Typea

a. Instructions for determining whether the MicroXCT is 180°- or 360°-enabled 
(referenced in step 2) are provided in Appendix F, “Determining Whether the 
MicroXCT is 360°-Enabled.”

Start Angle (degrees) End Angle (degrees)

MicroXCT is 360°-enabled 
(n = number of images 
per degree; n should be 
at least 2)

-180 180 - 1/n

MicroXCT is not 360°-
enabled or imaging 
a flat sample (such as a 
semiconductor sample)

Values noted in step 3
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8. Click Start Acquisition to acquire the image. The Save File dialog box 
opens. Follow steps a through c to save the file, and continue.

a. Browse to the destination file path.

b. Type the new file name in the File name text box.

c. Click Save.

An Acquisition Status message box opens, indicating real-time 
acquisition status, and an Image window opens, showing the image 
being updated, with light intensity counts indicated in blue (lower 
left status bar of the window).

NOTE Acquisition Setting dialog box values cannot be changed until 
acquisition is stopped. If you need to abort the acquisition and change 

the values, click  in the icon bar, then repeat steps 4 through 8 
with different settings.

The MicroXCT rotates the sample to the starting angle, and automatically 
acquires images at evenly spaced angles, between the starting and 
ending angles indicated in step 6, based upon the total number of images 
indicated in step 7. Each individual image is saved to disk and displayed 
in the Image window.

With tomography files, which contain a series of 2D images (projections), 
the Image window has a scroll bar and an image number indicator 
showing which image is currently displayed.

The Acquisition Status message box closes when acquisition is 

complete, or when you click  in the icon bar to abort imaging.
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Figure 5-7 Example Tomography File Image Window, with Scroll Bar 
and Image Number Indicator Shown

After collecting the 3D (tomography) dataset, you need to collect 
a reference image, which must be applied to the tomography dataset 
before you can reconstruct the dataset.

Proceed to “Collecting a Reference Image.”

NOTE When acquiring a reference image, the exposure time, detector and 
X-ray source positions, camera binning, and X-ray voltage and power settings 
should match the settings used for the actual tomography, or other images 
collected with different acquisition modes. Take note of the above settings, 
before proceeding to “Collecting a Reference Image.”

Scroll Bar and Image Number Indicator – 
Use these controls to scroll through the images
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Collecting a Reference Image
This process describes how to collect a reference image, using Averaging 
(on-the-fly) acquisition mode. A reference image (image acquired with the 
sample out of the FOV) is used to normalize the images acquired with 
the sample in the FOV. Applying a reference translates the intensity of the 
sample image to a percentage of X-ray transmission between 0% and 100%.

For this process, the exposure time, detector and X-ray source positions, 
camera binning, and X-ray voltage and power settings should match 
the settings used for the actual tomography, or other images collected 
with different acquisition modes.

To collect a reference image

1. Follow steps a through c, to move the sample out of the FOV:

a. Click  in the icon bar. The Motion Controller dialog box opens, 
defaulted to the Sample tab.

b. In the Sample Theta panel of the Motion Controller dialog box 
Sample tab, ensure that the current Sample Theta position is 0 deg. 
If not, type 0 in the Sample Theta text box, then click GO to rotate 
Sample Theta to 0°.

c. In the Sample X panel of the Motion Controller dialog box 
Sample tab, type 60,000 in the Sample X text box, then click GO.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

NOTE If  is highlighted orange in the icon bar, the Motion Controller 
dialog box is already open.

NOTE If the sample is too large and cannot be fully moved out of the FOV 
by moving Sample X, turn OFF the X-ray source, open the access door, 
manually remove the sample holder assembly from the sample stage, 
close the access door, then turn ON the X-ray source.

Instructions for turning OFF the X-ray source are provided in “Loading the 
Sample Holder Assembly onto the Sample Stage,” step 6, on page 45. Instructions 
for turning ON the X-ray source are provided in “Turning on the X-ray Source,” 
on page 58.
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2. Click  in the icon bar. The Acquisition Setting dialog box opens.

Figure 5-8 Acquisition Setting Dialog Box – Settings Applied for Averaging 
Acquisition Mode
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3. Select and/or type the acquisition setting values:

CAUTION Camera temperature should be < -55°C. Contact the Xradia 
Support Team if the temperature is higher.

NOTE Generally, the total time for the reference image (individual image 
time * number of images) should be greater than or equal to 10 times (10x) 
the length of time for one exposure in the tomography (for example, if the 
exposure time for each projection is 10 seconds, the reference image 
should be 10 images averaged with 10 seconds per image).

NOTE Exposure time for the reference image can be equal to that of a 
single tomography image, unless the intensity of the image produced from 
that exposure time oversaturates the image (the light intensity count is greater 
than 64,000 per pixel, indicative of a bright region in the center of the image).

If the image is saturated, reduce the exposure time for the reference image 
so that the counts are somewhere in the 30,000 range, and increase 
the number of images such that the time to acquire the reference image 
is about 10 times (10x) the length of time needed for one exposure in the 
images that need to be referenced corrected.

Option Setting Value

Mode Averaging

Exposure Time (sec)
Same as the exposure time 
used for the image that is being 
reference corrected

Binning
Same value used when acquiring 
the tomography

ReadOut Time (u sec) Fast (default)

No. of Images > 10

Average on fly Selected
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4. Click Start Acquisition to begin acquiring the reference image. 
The Save File dialog box opens.

5. Follow steps a through c to save the image:

a. Browse to the destination file path.

b. Type the new file name in the File name text box.

c. Click Save.

An Acquisition Status message box opens, indicating real-time 
acquisition status, and an Image window opens, showing the 
image being updated, with light intensity counts indicated in 
blue (lower left status bar of the window).

NOTE Acquisition Setting dialog box values cannot be changed until 
acquisition is stopped. If you need to abort the acquisition and change 

the values, click  in the icon bar, then repeat steps 2 through 5 with 
different settings.

The Acquisition Status message box closes when acquisition is 

complete, or when you click  in the icon bar to abort imaging.

After acquisition is complete, proceed to “Applying the 
Reference Image.”
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Applying the Reference Image

This process describes how to apply the reference image (collected in 
“Collecting a Reference Image”), which normalizes images taken with the 
sample visible (in the FOV), including tomography images, to a percentage 
value of the X-ray transmission.

To apply the reference image

1. Click the Image window that you want reference corrected, to make 
it the active window (that is, bring it to the front of all other windows/
dialog boxes).

2. Click  in the icon bar. The Image Controls dialog box opens, 
defaulted to the Annotation tab.

NOTE If  is highlighted orange in the icon bar, the Image Controls dialog 
box is already open, and clicking the icon closes, rather than opens, the 
dialog box. If the dialog box is hidden behind other windows or dialog boxes, 
click the highlighted orange icon, then click the non-highlighted icon, 
as described above.

Figure 5-9 Image Controls Dialog Box – Annotation Tab, Selecting 
the Reference Tab

In step 3, click the arrow 
icons to scroll through the 
available tabs, until the 
Reference tab is visible, –or–

In step 3, right-click within 
the main body of the 
Image Controls dialog box, 
then select Reference from 
the list of available tabs
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3. Select the Reference tab, using one of the following methods 
(refer to Figure 5-9):

– Scroll through the available tabs, by clicking the  or  arrow icon, 
until the Reference tab is visible

– Right-click within the Image Controls dialog box, then 
select Reference

Figure 5-10 Image Controls Dialog Box – Reference Tab
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4. Click Browse…. The Open File dialog box opens.

Figure 5-11 Open File Dialog Box

5. Browse to the destination file path, then select the reference file created 
in “Collecting a Reference Image,” step 5, for this tomography dataset 
or “image with sample.”

6. Click Apply Correction to correct the sample image with the reference 
image. The light intensity counts change to indicate percentage 
transmission upon applying the reference correction.

Proceed to the next step:

– Image with sample that is a tomography dataset – The file 
is automatically saved, and includes the reference image. 
Proceed to step 8.

– Image with sample that is a not a tomography dataset – 
Proceed to step 7 to save the file.
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7. Image with sample that is not a tomography dataset – 
Follow steps a through d to save the file created in step 6:

a. Click  in the icon bar. The Save File dialog box opens.

b. Browse to the destination file path.

c. Type the new file name in the File name text box.

d. Click Save.

8. Close the file (click , top right corner).

To create a viewable 3D volume, you must reconstruct the tomography 
dataset. Proceed to Chapter 6, “Manually Reconstructing a 3D Dataset.”
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6 Manually Reconstructing 
a 3D Dataset

This chapter describes how to use XMReconstructor to manually reconstruct 
3D tomography datasets when:

– A dataset is manually acquired, as described in “Manually 
Collecting a 3D (Tomography) Dataset,” on page 137, or

– A dataset is automatically acquired, but not reconstructed 
in Chapter 4, “Automatically Acquiring Additional Data and 
Reconstructing Tomography Point(s),” or

– The center shift is incorrect, or

– The automatic reconstruction had problems

Reconstruction is the process of using all the projections acquired during 
a tomography data acquisition, to create a 3D volume.

XMReconstructor can only be used to reconstruct images that have been 
reference corrected. (Refer to “Collecting a Reference Image,” on page 143, 
and “Applying the Reference Image,” on page 147.)

NOTE The automatic process for acquiring and reconstructing tomographic 
data is described in Chapter 4, “Automatically Acquiring Additional Data and 
Reconstructing Tomography Point(s).”

NOTE During reconstruction with XMReconstructor, the amount of free 
space required on the hard disk drive must be at least 1 GB more than 
the file size of the tomography (projection) dataset.
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Process Overview

The process of manually reconstructing a 3D dataset is comprised of the 
following subprocesses:

1. Preparing for Reconstruction.

2. Identifying Center Shift.

3. Identifying Beam Hardening Correction.

4. Reconstructing the Tomography Data.

Each is described in the sections that follow.
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Preparing for Reconstruction

This process describes how to open XMReconstructor, and ensure that the 
tomography dataset to be reconstructed is not in use by another program.

To prepare for reconstruction

1. Select Start > All Programs > Xradia > MicroXCT 7.x > 
XMReconstructor 7.x. The XMReconstructor main window opens.

NOTE “x” is the program’s current version number.

NOTE When using XMReconstructor, if an icon is highlighted orange in the 
icon bar, its associated dialog box is already open, and clicking the icon 
closes, rather than opens, the dialog box.

Figure 6-1 Default XMReconstructor Main Window (Opened File Shown for Reference Only)

Menu Bar Icon Bar

Status Bar
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2. Open the Open File dialog box, using one of the following methods:

– Select File > Open… 

– Click  in the icon bar

Figure 6-2 Open File Dialog Box

3. Browse to the destination file path of the tomography dataset 
(*.txrm file) to be opened.

4. Select the file, then click Open.

NOTE If the “This file is open on another machine” Warning dialog box opens, 
click OK, close the file in the other program, then repeat steps 2 through 4.

NOTE If the “Only reference corrected file supported…” Warning dialog 
box opens, the tomography file has not been reference corrected yet. 
Click OK, then apply a reference image to the file, according to the 
process described in “Applying the Reference Image,” on page 147. If a 
reference image has not been collected, collect one according to the 
processes described in “Collecting a Reference Image,” on page 143, and 
apply it to the tomography file. Upon completing either or both tasks, 
repeat steps 2 through 4.

Proceed to “Identifying Center Shift.”
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Identifying Center Shift

This process describes how to identify the center shift value. Center shift 
is the amount, in pixels, that the axis of rotation is offset from the center 
column of the detector. This value is used later, when determining the beam 
hardening correction value and when reconstructing the data.

Images with good center shift are focused and clear, while images with bad 
center shift are unfocused and blurry. (Refer to Figure 6-3.)

Figure 6-3 Comparison between Good and Bad Center Shift Results

Center Shift value

Good Center Shift
Image is clear and focused

Bad Center Shift
Image is blurry and unfocused
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To identify center shift in the open *.txrm file

1. Click  in the icon bar. The Rotation Center / Beam Hardening 
dialog box opens.

Figure 6-4 Rotation Center/Beam Hardening Dialog Box – Center Recon 
Option Selected

2. Select and/or type the center shift setting values (refer to Figure 6-4):

Leave all other values at their defaults on the first attempt to determine 
the center shift.

3. Click OK. A Reconstruction Status message box opens, indicating 
real-time reconstruction status, and a Reconstructed Slice Image 
window opens.

NOTE If you need to abort the center shift find process before it completes, 

click  in the icon bar.

Option Setting Value

Center Recon Selected

Binning 1
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The Reconstructed Slice Image window shows a series of 
2D reconstructed slices with increasing center shift being created, 
starting from the shift range specified in the Rotation Center / 
Beam Hardening dialog box Start Shift (pixels) text box, increasing 
in intervals, according to Step to shift, and ending in the shift 
specified in the End Shift (pixels) text box. The amount that 
each image is shifted is indicated in green (upper left corner).

Wait while the image finishes center-shifting through the range. The 
Reconstruction Status message box closes at the end of the process.

Figure 6-5 Reconstructed Slice Image Window

Center Shift value

Scroll Bar and Image Number Indicator – 
Use these controls to scroll through the images
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4. In cases where there are areas on the image that are all white or black, 
image contrast and brightness should be adjusted such that detailed 
features within the all white/black areas can be observed. Follow 
steps a and b to adjust contrast and brightness:

a. Click  in the icon bar. The Histogram panel opens and 
pins itself in the XMReconstructor main window (upper 
right corner).

Figure 6-6 Histogram Panel

b. Use the following instructions to maintain or adjust image contrast 
and brightness:

NOTE The Auto-Scaling option can be selected to automatically estimate 
the best contrast and brightness for the image; however, the results may not 
provide the results you want; therefore, manual adjustment is recommended.

Contrast and Brightness Process

Maintain for all images Select Lock.

Adjust for all images

Click Reset. Next, use the mouse pointer 
to click and drag to the RIGHT and/or LEFT 
within the gray area of the Histogram panel, 
to adjust contrast and brightness. (The panel 
is light gray until the mouse is dragged on it. 
The area in which the mouse is dragged turns 
dark gray.)
After you have sufficiently adjusted 
the contrast and brightness in the 
Reconstructed Slice Image window, 
select Lock.

In step 4b, to adjust 
contrast and brightness 

of the image in the 
Reconstructed Slice 

Image window, use the 
mouse pointer to click and 

drag to the RIGHT and/or 
LEFT within the gray area 

of the Histogram panel
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5. Scroll through the images in the Reconstructed Slice Image window, 
using the slider in the scroll bar or the image number control (click the 
– or + symbols) at the bottom of the window, to locate and identify the 
image with the crispest features (sharpest focus).

6. Note the center shift value of the image with the sharpest focus 
(indicated in green, top left corner of the Reconstructed Slice Image 
window). This value is used later, in “Identifying Beam Hardening 
Correction,” step 2.

NOTE If a good center shift is not found with the specified Start and End Shift 
range, repeat steps 1 through 6, but in step 2 change the Start and/or End 
Shift value to search over a different range. The step values in step 2 can 
also be changed to look at finer or coarser shift intervals.

Proceed to “Identifying Beam Hardening Correction.”
MicroXCT-200 and MicroXCT-400 User’s Guide 159



Chapter 6 – Manually Reconstructing a 3D Dataset
Identifying Beam Hardening Correction

This process describes how to identify the beam hardening correction value. 
This value is used later, along with the center shift value, when reconstructing 
the data.

Beam hardening is the result of the change in spectrum characteristic as the 
X-rays pass through the sample, where the sample density remains the same, 
but the light changes – one area is darker than another.

NOTE The typical beam hardening correction value is 0.2 to 0.4, 
if the correct source filter is used.

To identify beam hardening correction in the open *.txrm file

1. Click  in the icon bar. The Rotation Center / Beam Hardening 
dialog box opens.

Figure 6-7 Rotation Center / Beam Hardening Dialog Box – Beam Hardening 
Option Selected

In step 2, 
select this option

and

type values 

here
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2. Select and/or type the beam hardening setting values (refer to 
Figure 6-7):

3. Click OK. A Reconstruction Status message box opens, indicating 
real-time reconstruction status, and a Reconstructed Slice Image 
window opens.

NOTE If you need to abort the beam hardening correction find process 

before it completes, click  in the icon bar.

The Reconstructed Slice Image window shows a series of 
2D reconstructed slices with increasing beam hardening correction 
being created, starting from the value specified in the Rotation Center / 
Beam Hardening dialog box Start value text box, increasing 
in intervals, according to Step for Beam Hardening, and ending in 
the value specified in the End value text box. The amount that each 
slice is corrected is indicated in green (identified as a B.H. Constant, 
upper left corner).

Wait while the image finishes correcting for beam hardening through 
the range. The Reconstruction Status message box closes at the end 
of the process.

Option Setting Value

Beam Hardening Selected

Binning 1

Start value 0 (default)

Step for Beam Hardening 0.1 (default)

End value 1

Center Shift
Center shift value noted in “Identifying 
Center Shift,” step 6
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Figure 6-8 Reconstructed Slice Image Window

Scroll Bar and Image Number Indicator – 
Use these controls to scroll through the images

Beam Hardening
Constant
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4. Adjust image contrast and brightness using the Histogram tool, 
if necessary, as described in “Identifying Center Shift,” step 4.

5. Click  in the icon bar. The Image Control set toolbox opens.

Figure 6-9 Image Control set Toolbox

6. Click  to enable the Line Plot annotation tool.

7. Draw a line across the 2D reconstructed slice, by using the mouse 
pointer to click and drag within the Reconstructed Slice Image 
window. The line should span materials of similar density. The 
Reconstructed Slice x-Line Plot dialog box opens.
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Figure 6-10 Reconstructed Slice Image Window with Annotation Line

Figure 6-11 Reconstructed Slice x-Line Plot Dialog Box

Beam Hardening
Constant

Scroll Bar and Image Number Indicator – 
Use these controls to scroll through the images

In step 9, watch this 
graph line – it will 
be the most flat for 
the 2D reconstructed 
slice with the 
optimum beam 
hardening correction 
value in the 
Reconstructed Slice 
Image window

In step 8, increase 
this value to reduce 
noise on the plot
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8. To reduce noise on the plot (by averaging more lines, and thereby 
smoothing out the graph), widen the graph line width by typing 
a value between 10 and 64 (maximum) in the Line Width text box, 
then click Update. (Refer to Figure 6-11.)

9. In the Reconstructed Slice Image window, use the slider to scroll 
through the 2D reconstructed slices. As you scroll, watch the graph in the 
Reconstructed Slice x-Line Plot dialog box. The slice with the optimum 
beam hardening correction value in the Reconstructed Slice Image 
window will have the flattest graph in the Reconstructed Slice x-Line 
Plot dialog box. (Refer to Figure 6-11.)

10. Note the beam hardening correction value (indicated in green, 
identified as a B.H. Constant, upper left corner of the Reconstructed 
Slice Image window). This value is used later, in “Reconstructing the 
Tomography Data,” step 3.

11. Close the Reconstructed Slice Image window and Reconstructed 

Slice x-Line Plot dialog box (click , top right corner).

NOTE Finer intervals can be used for Step for Beam Hardening, in step 2, 
if the beam hardening correction must be more precise. Repeat steps 1 
through 11, but in step 2, narrow the range around the best beam hardening 
correction found during the previous attempt, and change Step for Beam 
Hardening to a smaller value.

Proceed to “Reconstructing the Tomography Data.”
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Reconstructing the Tomography Data

This process describes how to reconstruct the tomography data, after the 
center shift and beam hardening correction values are known.

To reconstruct the open *.txrm file

1. Open the Reconstruction Setting dialog box, using one of the 
following methods:

– Select Reconstruction > Reconstruction Setting… 

– Click  in the icon bar

Figure 6-12 Reconstruction Setting Dialog Box – Settings Applied 
in Subsequent Steps
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2. Follow steps a through c to assign the output reconstruction file name:

a. Click … (to the right of the Output File Name or Dicom Folder text 
box), then browse for the destination file path.

b. Type an output reconstruction file name in the File name text box.

c. Click OK. The path and file name appear in the Output File Name 
or Dicom Folder text box.

3. Select and/or type the following reconstruction setting values:

NOTE Because the acquisition binning for tomography is usually 2, 
reconstruction binning is 1.

Option Setting Value

Output Mode TXM (default)

Center Shift (pixels)
Center shift value identified in 
“Identifying Center Shift,” step 6

Output data type USHORT(16bit) (default)

Binning 1 (refer to Note)

Beam hardening configuration file
Standard Beam Hardening Correction 
(default)

Beam hardening constant
B.H. correction value identified 
in “Identifying Beam Hardening 
Correction,” step 9

Shift rotation angles by 0 deg (default)

Defect correction
– None if using DRR in Version 7.x
– Bright and dark spots (default) 

if not using DRR
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4. Select one of the following options from the Ring Removal drop-down 
list box:

NOTE 3-section RR is known to sometimes add rings when there are regularly 
repeating high-contrast features.

5. Select a software filter from the Recon Filters drop-down list box. 
The minimum is Smooth (Kernel Size = 0.5); if unsure, start with 
Smooth (Kernel Size = 0.7).

NOTE The Recon Filters value is magnification lens- and sample-dependent.

NOTE Determine which software filter value provides the most satisfactory 
balance between image resolution and noise (through your own experience); 
the correct software filter value provides for significant noise reduction, but 
has a minimal impact on resolution.

NOTE Do not use None nor Sharp (Shepp-Logan).

6. Use the Byte scaling option only if either of the following conditions 
is true:

NOTE Refer to CT Scaling Instructions (G000135), included with the MicroXCT 
product documentation, for details related to CT scaling.

Option Usage

None: No Ring Removal Use this option if DRR is enabled.

Low contrast – 8-section RR
Use this option if DRR is disabled, for 
bone, rock, plastic, carbon composite, 
or composite material samples.

High contrast – 3-section RR

Use this option if DRR is disabled, 
for high-contrast samples, such 
as semiconductors, or if the other 
two options do not apply.

Apply Byte Scaling When True Process

Global minimum and maximum byte 
scaling values are known from a prior 
similar sample (scan acquired at the 
same settings (X-ray source power, 
detector and X-ray source distances, 
number of projections, exposure times, 
binning, and magnification)).

Select Use the following min and max 
for byte scaling, then type the global 
minimum and maximum byte scaling 
values in the Min and Max text 
boxes, respectively. 

Dataset is to be CT-scaled and 
CT scaling calibration is complete.

Select Apply CT Scale, then select 
the correct software filter from the 
CTScale Filter drop-down list box.
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7. Click OK to close the Reconstruction dialog box.

8. Reconstruct the tomography data, using one of the following methods:

– Select Reconstruction > Start Reconstruction 

– Click  in the icon bar

The Reconstruction Status window opens, indicating real-time 
reconstruction progress (lower left status bar of the window).

NOTE If you need to abort the reconstruction process before it completes, 

click  in the icon bar.

Figure 6-13 Reconstruction Window
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9. When reconstruction is complete, the Reconstruction Status 
window closes and a Message dialog box opens, indicating 
the total reconstruction time. Click OK to close the dialog box.

The tomography is now reconstructed, and ready for viewing with 
XM3DViewer. Proceed to Chapter 7, “Viewing Tomographies.”
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This chapter describes how to use XM3DViewer to view and edit 
2D reconstructed slices and 3D volume datasets for use in reports and movies. 
This is typically done after acquiring, referencing, and reconstructing the 
tomography dataset (all the processes described in the previous chapters).

NOTE This chapter provides basic information for using XM3DViewer to 
view tomographic data after reconstruction. For further details regarding the 
program’s use, refer to the Xradia ExamineRT Workstation 1.1 User’s Manual, 
available under XM3DViewer’s Help menu.
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Process Overview

The process of viewing tomographies is comprised of the following 
subprocesses:

1. Checking a Large Reconstructed File.

2. Starting XM3DViewer.

3. Using XM3DViewer:

– Adjusting and Navigating the Reconstructed 2D Slices

– Creating 3D Volume Renderings

– Collecting Images (or Pictures) for a Report

– Generating a Report

– Creating Movies of Cross-Sectional 2D Reconstructed Slices 
and 3D Volumes

– Correcting Problems with the Reconstructed File

NOTE Unlike earlier chapters of this guide, most processes described 
in this chapter can be performed out of sequence.

Each is described in the sections that follow.
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Checking a Large Reconstructed File

This process describes how to check a large reconstructed file with 
XMController (before using XM3DViewer), which must be done 
if the reconstructed file generated in:

– Chapter 4, “Automatically Acquiring Additional Data and Reconstructing 
Tomography Point(s),” or

– Chapter 6, “Manually Reconstructing a 3D Dataset”

is larger than the memory available on the graphics adapter (~ 0.25 GB 
or greater), and you suspect that the file has a problem.

To check a large reconstructed file

1. Start XMController, if it is not already running.

NOTE Instructions for starting XMController are provided in “Loading the 
Sample Holder Assembly onto the Sample Stage,” step 1, on page 42.

2. Select File > Open…. The Open File dialog box opens.

Figure 7-1 Open File Dialog Box
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3. Select Volume Viewer File (*.txm) from the Files of type drop-down 
list box.

4. Browse to the destination file path.

5. Select the reconstructed file to be checked, then click Open. An Image 
window opens with the series of reconstructed slices.

Figure 7-2 Image Window with Slider Shown

Scroll Bar and Image Number Indicator – 
Use these controls to scroll through the images
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6. Scroll through the images, using the slider in the scroll bar or the image 
number control (click the – or + symbols) at the bottom of the window, 
to navigate to the middle slices and look for potential problems, such 
as streaks, blurriness, and other problems that affect image quality.

Proceed to the next process:

– If there are no problems with the file, close the file, then proceed 
to “Starting XM3DViewer.”

– If there is a problem with the file, proceed to “Correcting Problems 
with the Reconstructed File,” at the end of this chapter. 
After identifying the problem and taking steps to remedy it, 
close the file.

NOTE Instructions for removing the sample, after you are finished using it, 
are provided in Appendix E, “Removing the Sample after Use.”
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Starting XM3DViewer

This process describes how to start XM3DViewer and open a reconstructed file 
for viewing.

To start XM3DViewer

1. Select Start > All Programs > Xradia > MicroXCT 7.x > 
XM3DViewer 1.x. The XM3DViewer main window opens.

NOTE “x” is the program’s current version number.

NOTE In its main window title bar, XM3DViewer appears as “TXM3DViewer,” 
rather than as “XM3DViewer”.

Figure 7-3 Default XM3DViewer Main Window – Examine Tab, with Descriptions 
of Each Quadrant

2D Reconstructed Slice

of the sample
Y direction, onto the top

2D Reconstructed Slice

In the X direction,
perpendicular

2D Reconstructed Slice

In the Z direction, 3D Volume Rendering

to the beam line

along the beam line

Looking down in the

Menu Bar

Layout Icon Bar

Crop Icon Bar

Options Icon Bar

Data window Tools (2D)

and Tools

3D display (Mode)

Transfer function Tools (3D)

Tabs – Examine and Report

Mouse mode Icon Bar
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2. Select File > Open…. The Open File dialog box opens.

Figure 7-4 Open File Dialog Box

3. Browse to the destination file path, then locate the reconstructed file 
that you want to open (*_Recon.txm is appended to the output file 
names of the Recipe function).

NOTE If you saved the reconstructed file to the desktop, the file is located 
in the C:/Documents and Settings/[Your Windows User Login Name]/Desktop 
path. In this file path, you will see only the files created with that Login Name.

NOTE If you saved the reconstructed file to another hard disk drive, click the 
Look in drop-down list box, then browse to and select the correct drive and 
destination file path.
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4. Double-click the file name to open the file. A status window opens, 
statusing the file upload, then closes when the file upload is complete.

NOTE If the file is too large for the graphics adapter memory (larger than 
the available memory (RAM) capacity on the workstation), a dialog box 
opens, requesting for the file to be processed out-of-core. If this occurs, 
click Out-of-core mode to continue loading the file. An XM3DViewer status 
window opens, indicating the out-of-core operation’s progress.  
 
During this process, XM3DViewer generates two files – *.txm-exm and 
*.txm-exm-ooc – whenever you open a *.txm file that is larger than the 
available memory (RAM) capacity on the workstation. These files are 
accessed during viewing of reconstructed results on the XM3DViewer. 
These files can be quite large (on the order of a few gigabytes), and 
should be deleted after generating reports and creating movies.

Figure 7-5 “Out-of-core mode” Dialog Box
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Adjusting and Navigating the Reconstructed 2D Slices

After the processing is complete, images appear in each of the four panels 
in the XM3DViewer main window. (Refer to Figure 7-3.) 

The processes described in this section provide general guidelines for gaining 
familiarity with XM3DViewer:

– Adjusting Contrast and Brightness in the 2D Reconstructed 
Slice Windows

– Navigating the XM3DViewer Main Window

Each is described in the sections that follow.

NOTE If it is obvious that something is not right, proceed directly 
to “Correcting Problems with the Reconstructed File.”

NOTE Unlike earlier chapters of this guide, these processes can be 
performed out of sequence.

NOTE The guidelines provided in this section relate to the default layout 
of the main window, three equally sized 2D reconstructed slice windows 

and one 3D volume window, . (Refer to Figure 7-3.) The other layouts 
are listed below. All four are located in the Layout icon bar.

Icon Description

Click to display a single 2D reconstructed slice window. Click 
multiple times to cycle through the orientation of the slice in the 
2D reconstructed slice window. When clicked, adds Cine controls 
to the main window (left side, below the other icon bars and tools).

Click to display three equally sized 2D reconstructed slice windows, 
plus one larger 3D volume window. Displays the same four images 

as .

Click to display a single 3D volume window (not used for 
2D reconstructed slices).
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Adjusting Contrast and Brightness in the 
2D Reconstructed Slice Windows
This process describes how to adjust contrast or brightness in the 

2D reconstructed slice windows, using the Data window slider or  
Mouse mode icon.

To adjust contrast and brightness in the 2D reconstructed 
slice windows

1. Click  in the Layout icon bar.

2. Select 2D bilinear filter from the View drop-down menu, to turn ON 
the 2D bilinear filter. This provides for less noisy 2D reconstructed 
slice images.

3. Use the Data window slider to adjust the contrast and brightness of 
the reconstructed slices (2D reconstructed slices on the top and bottom 
left and top right quadrants), using the processes described in the 
following table.

Adjustment Needed Process

Contrast
Use the mouse pointer to click and drag the endpoints 
of the bar to the LEFT or RIGHT, to change the minimum 
and maximum contrast values of the Data window range.

Brightness

Use the mouse pointer to click and drag the center bar 
to the LEFT or RIGHT to change the Data window 
position along the histogram values, and thereby change 
the brightness.
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Figure 7-6 Using the Data window Slider

Changes in contrast and brightness can also be achieved within 
any of the three 2D reconstructed slice windows, using the processes 
described in the following table.

NOTE In the Data window Tools, leave the Window option selected as custom 
to avoid potential problems. For example, if you changed the Window option 
to CT Default, all the 2D reconstructed slices will turn white, and you will 
not be able to see the slices. If this occurs, use the mouse pointer to click and 
drag the right endpoint on the Data window slider to the RIGHT, to improve the 
contrast and brightness of the 2D reconstructed slice. The Window option will 
change back to custom.

Adjustment Needed Process

Contrast
Click  in the Mouse mode icon bar, then use the 
mouse pointer to click and drag UP or DOWN within 
any of the 2D reconstructed slice windows, to change 
the contrast (window width).

Brightness
Click  in the Mouse mode icon bar, then use the 
mouse pointer to click and drag LEFT or RIGHT within 
any of the 2D reconstructed slice windows, to change 
the brightness (window center).

Drag the endpoints to change the contrast

Drag toward the RIGHT Drag toward the LEFT

Drag the center bar LEFT/RIGHT 
to change the brightness
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Navigating the XM3DViewer Main Window
This process describes how to navigate the XM3DViewer main window, 
by walking you through common tasks.

To navigate the XM3DViewer main window

1. Use the navigation cross-hairs in the 2D reconstructed slice sections 
(colored lines), to change position in all the 2D reconstructed slice 
windows. (Refer to Figure 7-3.)

For example, move the green line in the upper left quadrant to locate the 
region of interest in the bottom left quadrant (green frame). Do the same 
with the blue line and corresponding blue frame, and then the red line 
and corresponding red frame, to identify the layers in which the region 
of interest lies.

NOTE Green = X/Z, blue = X/Y, and red = Y/Z.

2. Use the Zoom controls,  and , described in the 
following table, to make the complete slice visible within the 2D 
reconstructed slice windows.

Zoom Control Description

Click to Zoom OUT.

Click to Zoom IN.

Select a zoom percentage from the drop-down list box.

Click this icon in the Mouse mode icon bar, then, with the 
center-mouse button pressed, use the mouse pointer to 
click and drag UP and DOWN, within any 2D reconstructed 
slice window, to zoom IN and OUT, respectively.
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3. Orthogonal Slicing mode (  in the Options icon bar) positions 
the cross-hairs orthogonally – this is the default slicing mode.

If the region of interest is not on the orthogonal plane, click  in the 
Options icon bar to use Oblique Slicing mode. This places the region 
on one plane, rotating the green, blue, or red cross-hairs to line the 
planes up with the region of interest.

NOTE Use of Oblique Slicing mode reduces image resolution.

4. Select MPR (Multi-Planar Rendering) from the 3D display mode 
drop-down list box, to display the 2D reconstructed slices as planes 
in 3D space within the 3D volume window (lower right quadrant). 
This can help you to better observe the spatial interrelations 
of the three planes (green, blue, and red).

5. Under Options, use the mouse pointer to click and drag the Thickness 
slider to the RIGHT, to sum the slices between the dashed lines and 
produce a less-noisy image.

The thickness of the slice is illustrated by dashed lines in the Slice areas. 
Use the mouse pointer to click and drag the Thickness slider to the LEFT 
to reduce the thickness.

Figure 7-7 Increasing the Thickness of 2D Reconstructed Slices

The slices between the 
two dashed, horizontal 
blue lines (B, center of 
image) are summed 
to create the image 
shown on the blue plane 
(A, entire image)

A

B
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6. If you need to adjust the image contrast and/or brightness, follow 
the processes described in “Adjusting Contrast and Brightness in the 
2D Reconstructed Slice Windows,” step 3.

When the 2D reconstructed slice images look as they should, per your 
requirements, proceed to the next process:

– If you have already located the region(s) of interest, proceed 
to “Collecting Images (or Pictures) for a Report”

– If you want to work with 3D rendering, proceed to “Creating 
3D Volume Renderings”
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Creating 3D Volume Renderings

This process describes how to create a 3D volume rendering that can be used 
in reports or movies. After a reconstructed file (*.txm) is loaded, images 
appear in each of the four panels in the XM3DViewer main window. In the 
default view, the 3D volume window is the lower right quadrant of the main 
window. (Refer to Figure 7-3.)

NOTE Unlike earlier chapters of this guide, this process can be performed 
out of sequence.

To create a 3D volume rendering

1. Click the   in the Layout icon bar to open the single 
3D volume window.

2. The 3D display mode should be defaulted to VRT (volume rendering 
technique). If it is not defaulted to VRT, select VRT from the Mode 
drop-down list box.

NOTE VRT is the only 3D display mode that is described in this guide. 
For information regarding the other 3D display modes, refer to the Xradia 
ExamineRT Workstation 1.1 User’s Manual, available under XM3DViewer’s 
Help menu.

3. Use the  or , available in the Mouse mode icon bar, to tilt 
the 3D volume, by using the mouse pointer to click and drag within 
the 3D volume window.
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4. Use the Transfer function slider to adjust the contrast and brightness 
of the 3D volume, using the processes described in the following table. 
Use of these processes changes the mapping from actual input data 
values to display output values.

Figure 7-8 Using the Transfer function Slider

Changes in contrast and brightness can also be achieved in the 
3D volume window/quadrant, using the processes described 
in the following table.

Adjustment Needed Process

Contrast
Use the mouse pointer to click and drag the endpoints of 
the bar to the LEFT or RIGHT, to change the contrast.

Brightness

Use the mouse pointer to click and drag the center bar to 
the LEFT or RIGHT, to change the Transfer function 
along the histogram values, and thereby change the 
brightness.

Adjustment Needed Process

Contrast
Click  in the Mouse mode icon bar, then use the 
mouse pointer to click and drag UP or DOWN within 
the 3D volume window, to change the contrast 
(window width).

Brightness
Click  in the Mouse mode icon bar, then use 
the mouse pointer to click and drag LEFT or RIGHT 
within the 3D volume window, to change the brightness 
(window center).

Drag the end points to change the contrast

Drag toward the RIGHT Drag toward the LEFT

Drag the center bar LEFT/RIGHT 
to change the brightness
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NOTE Steps 5 through 7 reference tasks that use additional Transfer 
function controls.

NOTE In the Transfer function Tools, leave the Window option selected as 
custom to avoid potential problems. For example, if you changed the Window 
option to CT Default, the 3D volume becomes a white cube, and you will 
not be able to see the 3D volume data. If this occurs, use the mouse pointer 
to click and drag the right endpoint on the Transfer function slider to the RIGHT, 
to improve the contrast and brightness of the 3D volume. The Window option 
will change back to custom.

5. Use the mouse pointer to click and drag the Fade slider LEFT or RIGHT, 
to adjust the fade level, to make internal features visible.

6. Alternate using the mouse pointer to click and drag the Transfer 
function (contrast and brightness) and Fade sliders, to obtain a 
desirable 3D rendering.

7. Select different Color and Opacity drop-down list box options, 
then repeat step 6 to obtain the optimum effect with the newly 
selected options.

8. Isolate the region of interest within the 3D reconstructed volume, 

by clicking  in the Crop icon bar to isolate a region smaller than 
the complete volume. Use the remaining Crop icons, as needed, 
to obtain the effect that you want.

NOTE For further details regarding these cropping functions, refer 
to the Xradia ExamineRT Workstation 1.1 User’s Manual, available under 
XM3DViewer’s Help menu.

Icon Description

Click to enable cropping a corner within the 
3D reconstructed volume.

Click to enable creating a diagonal area within the 3D reconstructed 
volume.

Click to enable creating a parallel slice within the 3D reconstructed 
volume.

No crop (default). Click to omit any previously applied cropping.
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Collecting Images (or Pictures) for a Report

This process describes how to collect images (or pictures) of the sample, to 
be used in “Generating a Report.” The information you will collect depends 
upon what is needed to be known/reported.

If you are not the owner of the sample, ask the owner to identify what 
information is needed. For example, if the purpose of imaging is to identify 
a crack in a particular area of the sample, the images that you collect for 
the report should highlight the presence and location of the crack.

The processes are different, depending upon whether you are processing 
cross-sectional 2D reconstructed slices or 3D volumes:

– Visualize, Measure, and Capture Internal Structure 
on 2D Reconstructed Slices

– Visualize, Measure, and Capture Internal Structure on 3D Volumes

Each is described in the sections that follow.

NOTE Unlike earlier chapters of this guide, these processes can be 
performed out of sequence.
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Visualize, Measure, and Capture Internal Structure 
on 2D Reconstructed Slices
This process describes how to create images from 2D reconstructed slices, 
to illustrate the region of interest in a sample, for use in a report.

To visualize, measure, and capture the internal structure 
on 2D reconstructed slices

1. Click  in the Layout icon bar to display the single 2D reconstructed 
slice window.

2. Click  again, once per plane, to scroll through the green, blue, 
and red 2D planes, to see different views of each slice.

3. Select to View > Scale bar. This inserts a scale at the bottom of the 
window, which provides a reference for the size of the region shown.

4. Use the keyboard’s UP and DOWN arrow keys to scroll through the 
different slices, to identify a 2D reconstructed slice of interest.

5. If you want to add a measurement line, click  in the Mouse mode 
icon bar to enable Measurement mode. In the 2D reconstructed slice 
window, at the slice’s region of interest, click once to define the start 
point for measuring, then again to define the endpoint for measuring.

NOTE To remove an erroneous measurement line, click the line to 
select it (line changes from blue to yellow), then press the Delete key 
on the workstation keyboard.

If Measurement mode is not the active mode, click  to enable it, 
then proceed with the removal process described above.
MicroXCT-200 and MicroXCT-400 User’s Guide 189



Chapter 7 – Viewing Tomographies
6. If you want to apply arrow and text annotations, click  in the Mouse 
mode icon bar, to enable Annotation mode and apply the annotations:

NOTE To remove an erroneous annotation, click the annotation to 
select it (annotation changes from blue to yellow), then press the Delete key 
on the workstation keyboard.

If Annotation mode is not the active mode, click  to enable it, 
then proceed with the removal process described above.

7. After isolating and marking the region(s) of interest in the selected slice, 

click  in the Options icon bar, move the mouse onto the 2D 
reconstructed slice, then click to take a picture (snapshot) of the slice. 
This saves a picture of the 2D reconstructed slice in the Snapshots panel 
of the Report tab. (Refer to Figure 7-9.)

8. Repeat steps 1 through 7 for all 2D reconstructed slices that are 
of interest.

When finished, proceed to “Generating a Report.”

Annotation Process

Arrow
Click within the 2D reconstructed slice window at the point you 
want to start the arrow, then click again to at the point you want 
to end the arrow.

Text associated 
with the arrow

Double-click the arrow, then type the text you want to add.
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Visualize, Measure, and Capture Internal Structure 
on 3D Volumes
This process describes how to create images from a 3D volume, to illustrate 
the region of interest in a sample, for use in a report.

To visualize, measure, and capture the internal structure 
on 3D volumes

1. Click  in the Layout icon bar to bring up the single 3D volume 
rendering window.

2. Click  in the Mouse mode icon bar, to enable and use the following 
mouse functions:

3. Follow steps a and b if you want to include a distance reference:

a. Cancel the 3D perspective selection under View menu. This causes 
the image in the 3D volume window to appear out of perspective, 
which is necessary when including a distance reference.

b. Select View > Scale bar to insert a scale bar at the bottom of the 
3D volume window, to provide a size reference.

4. Follow steps a through c if you want to add a measurement line:

a. Cancel the 3D perspective selection under View menu (if you 
did not already cancel it in step 3a). This causes the image in the 
3D volume window to appear out of perspective, which is necessary 
when adding a measurement line.

b. Click  in the Mouse mode icon bar, to enable 
Measurement mode.

Function Process

Rotate the image
Use the mouse pointer to click and drag within the 
3D volume window.

Zoom IN and OUT
With the left- and center-mouse buttons simultaneously 
pressed, use the mouse pointer to click and drag UP 
and DOWN, respectively, within the 3D volume window.

Pan
With the center-mouse button pressed, use the mouse 
pointer to click and drag within the 3D volume window.
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c. In the 3D volume window, at the region of interest, click once 
to define the start point for measuring, then again to define 
the endpoint for measuring.

NOTE To remove an erroneous measurement line, click the line to 
select it (line changes from blue to yellow), then press the Delete key 
on the workstation keyboard.

If Measurement mode is not the active mode, click  to enable it, 
then proceed with the removal process described above.

5. If you want to apply arrow and text annotations, click  in the Mouse 
mode icon bar, to enable Annotation mode and apply the annotations:

NOTE To remove an erroneous annotation, click the annotation to 
select it (annotation changes from blue to yellow), then press the Delete key 
on the workstation keyboard.

If Annotation mode is not the active mode, click  to enable it, 
then proceed with the removal process described above.

6. After isolating and marking the region(s) of interest, click  in the 
Options icon bar, move the mouse onto the 3D volume, then click 
to take a picture (snapshot) of the 3D volume. This saves a picture 
of the 3D volume in the Snapshots panel of the Report tab. 
(Refer to Figure 7-9.)

7. Repeat steps 1 through 6 for all 3D reconstructed volumes that are 
of interest.

When finished, proceed to “Generating a Report.”

Annotation Process

Arrow
Click within the 3D volume window at the point you want to 
start the arrow, then click again at the point you want to end 
the arrow.

Text associated 
with the arrow

Double-click the arrow, then type the text you want to add.
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Generating a Report

This process describes how to generate a report, using the images that you 
created and modified in “Collecting Images (or Pictures) for a Report.”

Figure 7-9 XM3DViewer Main Window – Report Tab

Drag snapshots here Add comments here
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To generate a report

1. Click the report layout that you want to use from Template. That layout 
opens in the report screen, in the selected Page x tab.

2. Use the mouse pointer to click and drag snapshots onto the Page x tab, 
according to the chosen layout.

3. To add comments, type the comment text in the bottom panel 
(white space) of the page.

4. To add a page, click Insert page.

5. To remove a specific page, select the appropriate Page x tab, then click 
Remove page.

6. When you have finished combining the captured data that you want 
to include in the report, click Export to export and save the file 
as a formatted Microsoft Word *.doc document, to a specific 
destination path.

You can open and edit the file as you typically would a Word document.

NOTE The Word document includes a title page, the exported information, 
and closes the report with “Sincerely, RADIOLOGIST”.

NOTE The images exported in the document can be copied into 
other types of documents, such as a Microsoft PowerPoint presentation 
or Excel spreadsheet.
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Creating Movies of Cross-Sectional 2D Reconstructed Slices 
and 3D Volumes

This process describes how to create an animation (movie) of captured data, 
using the Cine controls. The instructions are slightly different, depending 
upon whether you are processing cross-sectional 2D reconstructed slices 
or 3D reconstructed volumes:

– Creating Movies of 2D Reconstructed Slices

– Creating Movies of 3D Reconstructed Volumes

Each is described in the sections that follow.

NOTE Unlike earlier chapters of this guide, these processes can be 
performed out of sequence.
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Creating Movies of 2D Reconstructed Slices
This process describes how to create a movie of 2D reconstructed slices, 
using the Cine controls.

To create a movie of 2D reconstructed slices

1. Click  in the Layout icon bar. Cine controls appear below 
the Crop icon bar area.

Figure 7-10 Cine controls (Added to XM3DViewer Main Window)

Plane and
Slide Number

Cine controls
are added here
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2. Use the following Cine controls to identify slices of interest, and specify 
how often to play them in the movie:

3. Click  under Cine controls. The Cine Options dialog box opens.

Figure 7-11 Cine Options Dialog Box

Option Description

Use the slider to scroll through the 2D reconstructed slices, 
to identify slices of interest (the slice numbers appear in 
the bottom left of the screen, indicated in white; if the slice 

numbers are not visible, click  to display them).
Note the beginning and ending slice numbers to be saved 
as the movie. This information is used later, in step 4.

From the drop-down list box, select whether to scroll 
through the 2D reconstructed slices once (play once; 
default) or continuously, in a loop.
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4. Select and/or type the following cine option setting values:

5. Click OK. The Choose filename for movie file dialog box opens, 
defaulted to the MPEG movie (.mpg) file type.

Figure 7-12 Choose filename for movie file Dialog Box

6. Browse to the destination file path; type the new file name in the 
File name text box, then click Save.

NOTE The program automatically scrolls through the included 
2D reconstructed slices and creates the movie. The window cannot be 
minimized and you cannot open another window until the movie completes.

Option Setting Value

Frames per second 24 is a good value to use

Number of frames Allow to default

Image size Allow to default

3D Volume Animation N/A

2D Animation
Slice Range
Type the beginning and ending slice numbers noted 
in step 2, in the from and to text boxes, respectively
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7. When the movie completes, an Info message box opens with 
the message “MPEG file successfully written”. Click OK to 
close the message box.

NOTE Instructions for removing the sample, after you are finished using it, 
are provided in Appendix E, “Removing the Sample after Use.”
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Creating Movies of 3D Reconstructed Volumes
This process describes how to create a movie of 3D reconstructed volumes, 
using the Cine controls.

To create a movie of a 3D reconstructed volume

1. Click  in the Layout icon bar. Cine controls appear below 
Transfer function.

Figure 7-13 Cine controls

2. Use the following Cine controls to preview a 360° view, and specify how 
often to play the 3D volume in the movie:

Option Description

Use the slider to preview a 360° view.

From the drop-down list box, select whether to 
play the 3D volume move once (play once; default) 
or continuously, in a loop.
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3. Click  under Cine controls. The Cine Options dialog box opens.

Figure 7-14 Cine Options Dialog Box

4. Select and/or type the following cine option setting values:

Option Setting Value

Frames per second 24 is a good value to use

Number of frames Allow to default

Image size Allow to default

Rotation axis

Can be changed, as needed

If allowed to default (most vertical), 
the movie will be taken with the sample 
rotated about the vertical axis.

Rotation angle Allow to default

2D Animation N/A
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5. Click OK. The Choose filename for movie file dialog box opens, 
defaulted to the MPEG movie (.mpg) file type.

Figure 7-15 Choose filename for movie file Dialog Box

6. Browse to the destination file path; type the new file name in the 
File name text box, then click Save.

NOTE XM3DViewer automatically scrolls through the 3D volume and creates 
the movie. The window cannot be minimized and you cannot open another 
window until the movie completes.

7. When the movie completes, an Info message box opens with 
the message “MPEG file successfully written”. Click OK to 
close the message box.

NOTE Instructions for removing the sample, after you are finished using it, 
are provided in Appendix E, “Removing the Sample after Use.”
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Correcting Problems with the Reconstructed File

NOTE Unlike earlier chapters of this guide, this process can be performed 
out of sequence.

NOTE Troubleshooting tips specific to image contrast and brightness is 
described in “Troubleshooting Image Contrast, Brightness, and Light Intensity Count 
Issues,” on page 226.

This section provides troubleshooting information for how to handle specific 
problems with reconstructed data:

– Table 7-1 lists “show stopper” problems, with probable cause 
and solutions

– Table 7-2 lists solutions to problems that require manual reconstruction

– Table 7-3 lists solutions to problems that require reimaging

Table 7-1 Show Stoppers

Problem Probable Cause Solution

Reconstruction failed 
(no reconstructed file)

Insufficient hard disk drive 
memory (depends upon 
the size of the acquired file 
before reconstruction).

Clean up the available space 
on the hard disk drive, then 
reconstruct the file again.
The amount of free space required 
on the hard disk drive must 
be at least 1 GB more than 
the file size of the tomography 
(projection) dataset.

Blank file

Sample fell off the sample stage 
due to incorrect positioning or 
motor failure (check for errors in 
the XMController main window 
Status bar).

Reposition sample, detector, and 
X-ray source, then re-acquire 
the data.

If the problem is due to motor 
failure, contact the Xradia 
Support Team.
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Table 7-2 Solutions to Problems that Require Manual Reconstruction

Problem Solution

There are streaks or blurring in the image.
Correct the center shift (refer to “Identifying Center 
Shift,” on page 155), then reconstruct the file.

The outer part of the sample looks more dense than 
the inside, and the sample is all the same material.

Correct Beam Hardening (refer to “Identifying 
Beam Hardening Correction,” on page 160), 
then reconstruct the file.

Regions of the image are blurred.

Reconstruction filter kernel is too large. Repeat 
“Reconstructing the Tomography Data,” on 
page 166, but in step 5, select a Recon Filter with 
a smaller kernel size.

Image is too noisy.

Areas that are supposed to be smooth contain 
very large intensity variations over short 
lengthscales on the order of the pixel size.

Reconstruction filter kernel is too small. Repeat 
“Reconstructing the Tomography Data,” on 
page 166, but in step 5, select a Recon Filter with 
a larger kernel size.
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Figure 7-16 Configure System Dialog Box – General Tab, with Use DRR Selected

Table 7-3 Solutions to Problems that Require Reimaging

Problem Solution

Magnification is insufficient – cannot see fractures or 
other flaws down to a sufficiently fine detail.

Repeat scan at a higher magnification, if it has not 
already been done.

There are too many rings and DRR (dynamic ring 
removal) was not turned ON.

Select Microscope > Configure System, 
select Use DRR (Dynamic Ring Removal) 
in the General tab (default), click OK, then 
repeat the scan. (Refer to Figure 7-16.)

Region of interest has streaks (sample may have 
moved during imaging).

Securely mount the sample on the sample holder; 
reposition the X-ray source and detector so that 
they do not collide with nor touch the sample. 
(Refer to “Finely Positioning the Detector,” on 
page 71, and “Finely Positioning the X-ray Source,” 
on page 75.) Repeat the scan.

Select this option
to enable DRR
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A Troubleshooting

This appendix describes how to resolve common issues that may 
be encountered when using the MicroXCT:

– Issues that Require Xradia Assistance

– Troubleshooting Sample Issues in XMController

– Troubleshooting Magnification Lens Too Close to the X-ray 
Source – Keeping the X-ray Source Aperture out of the Field 
of View

– Troubleshooting Image Contrast, Brightness, and Light 
Intensity Count Issues

– Troubleshooting Issues with XM3DViewer

– Troubleshooting MicroXCT Power Failures

– Troubleshooting Light Tower Issues

as well as Xradia Support Team contact information. If the suggested solutions 
do not resolve the problem, refer to “Contacting the Xradia Support Team 
(Technical Support).”
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Issues that Require Xradia Assistance

Table A-1 and Table A-2 list hardware and software issues, respectively, 
that must be referred to the Xradia Support Team for resolution.

WARNING Do not attempt to troubleshoot these issues on your own, 
because doing so will violate the product warranty and/or cause potential 
physical harm.

Table A-1 Hardware Problems that Require Xradia Support 
Team Assistance 

Symptom(s) Problem

Source Controller in XMController indicates 
that the X-ray source turns ON, but then 
turns OFF almost immediately and the 
Alarm button on the front of the PDU is lit.

Light tower is malfunctioning. Refer also 
to “Troubleshooting Light Tower Issues.”

One or more PDU power breakers are 
tripped (in the DOWN position). 
DO NOT RESET THE BREAKER.

Power to one or more of the MicroXCT 
components is turned OFF and/or the 
MicroXCT is malfunctioning.

Xray button label does not change to red 
ON when turning ON the X-ray source.

X-ray source does not turn ON after closing 
the access door(s) and clicking the green 
OFF Xray button in the Xray Source 
dialog box. Refer also to “Troubleshooting 
Light Tower Issues.”

Light tower’s red light does not turn ON.

Light tower’s yellow light does not turn ON 
when the access door(s) are closed.

Safety interlock is malfunctioning.Light tower’s yellow light is ON; however, 
the Interlock indicator in the Xray Source 
dialog box indicates OPEN.

Non-Macro magnification lens was selected, 
but the motorized turret does not rotate 
the selected lens into position.

Motorized turret is malfunctioning.

Homing Status dialog box indicates 
homing errors:
– “… followed out on coarse home”
– “… followed out on fine home”

One or more of the axes (Source Z, 
Camera Z, Sample X, Y, Z, and/or Theta) 
will not move or cannot be changed/homed.

Axis does not move after clicking GO 
in any one of the Motion Controller 
dialog box tabs.
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Any axis (Source Z, Camera Z, Sample X, 
Y, Z, and/or Theta) does not move, moves 
erratically, or vibrates when moving.

MicroXCT motion controller or motor(s) 
are malfunctioning.

NOTE If the MicroXCT has just 
completed manual or automatic axis 
homing, it is normal for the red Error 
message bar to appear. To resolve this, 
click the drop-down arrow to the right 

of in the icon bar, select a 
magnification lens, then click the 
red Error message bar to close 
the message bar.

Program running on the MicroXCT issues 
an “Unable to communicate with the 
(motion or source) controller” message.

Red Error message bar appears at the 
bottom of the XMController main window. 
Click or hover the mouse pointer over the 
Log Window label (bottom left corner of the 
XMController main window), then scroll 
through the acquisition log to locate error 
lines in red. The errors listed can indicate 
Error FATAL or Error Warning.

XMController Acquisition Setting 
dialog box indicates the camera temperature 
is > -55°C.

CCD does not reach operating temperature, 
< -55°C.

Table A-2 Software Problems that Require Xradia Support 
Team Assistance

Symptom(s) Problem

Image quality is not the same quality as 
achieved in prior acquisitions that used 
the same parameters.

Image quality is degraded.

Errors indicate a problem that cannot 
be easily user-remedied.

Status window or dialog box indicates 
severe errors.

Table A-1 Hardware Problems that Require Xradia Support 
Team Assistance (Continued)

Symptom(s) Problem
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Troubleshooting Sample Issues in XMController

This section provides tips for troubleshooting the following sample-related 
issues that you might experience when using XMController:

– Sample Is Unstable

– Sample Is Not Visible on the Visual Light Camera Monitor

– Sample Region of Interest Is Not Visible

– Sample and Detector Collision Is Imminent

– Sample and Detector Collided

– Sample and X-ray Source Collision Is Imminent

– Sample and X-ray Source Collided
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Sample Is Unstable

NOTE Mounting and installation of the sample are discussed in “Mounting the 
Sample in/on a Sample Holder,” on page 33, and “Installing the Sample,” on page 39, 
respectively. If you need to remount or install the sample, refer to the relevant 
processes described in those sections.

Symptom Sample is wobbly (unstable) on the sample stage or in its holder; 
acquired images are blurry and unfocused.

Problem Sample is not properly mounted or installed.

Solution To stabilize the sample

1. In XMController, open the Motion Controller dialog box. In the Source 
tab, note the current Source Z position. In the Detector tab, note the 
current Camera Z position. These values are used later, in step 8.

2. Follow the processes described in “Loading the Sample Holder Assembly 
onto the Sample Stage,” steps 3 through 7, starting on page 44, to move 
the X-ray source and detector away from the sample stage, turn OFF the 
X-ray source, and open the access door.

3. Ensure that the flat edges of the sample holder and sample stage are 
aligned. (Refer to Figure 2-12, “Sample Holder Assembly Loaded onto the 
Sample Stage, with Flat Edges Aligned, Facing the Front 
of the MicroXCT (Clip Sample Holder Shown),” on page 47.)

4. Ensure that the tungsten balls on the sample stage are fitted into 
the indentations on the underside of the sample holder. (Refer to 
Figure 2-11, “Sample Stage, with Tungsten Alignment Balls Highlighted,” 
on page 47.)

5. Ensure that the sample is securely mounted in/on the sample holder.

6. Ensure that the sample is stable, such that it does not move nor vibrate 
in response to gentle tapping on the sample holder.
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7. Follow steps a through d if the sample must be repositioned in/on the 
sample holder:

a. Remove the sample holder from the sample stage.

b. Adjust the sample’s position in the sample holder, based upon 
the criteria identified in steps 5 and 6.

NOTE The sample mounting instructions vary by sample holder type. 
Instructions for each holder type is provided in Chapter 2, starting at 
“Mounting the Sample in/on a Sample Holder,” on page 33.

c. Load the sample holder back onto the sample stage, using the 
processes described in “Loading the Sample Holder Assembly 
onto the Sample Stage,” on page 41.

d. Repeat steps 3 through 6.

8. Follow steps a and b to move the X-ray source and detector back to their 
original positions noted in step 1:

a. In the Motion Controller dialog box Source tab, type the original 
current Source Z position in the Source Z text box, then click GO.

b. In the Motion Controller dialog box Detector tab, type the original 
current Camera Z position in the Camera Z text box, then click GO.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

9. Follow the processes described in “Turning on the X-ray Source,” 
steps 1 through 3, starting on page 58, to close the access door 
and then turn ON the X-ray source.

If you resume the process in which you determined there was an issue, 
and the issue still exists, contact the Xradia Support Team for assistance.
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Sample Is Not Visible on the Visual Light Camera Monitor

NOTE Mounting and installation of the sample are discussed in “Mounting the 
Sample in/on a Sample Holder,” on page 33, and “Installing the Sample,” on page 39, 
respectively. If you need to remount or install the sample, refer to the relevant 
processes described in those sections.

Symptom Sample is not visible on the visual light camera monitor.

Problem Interior light might be turned OFF; sample is not properly installed; 
sample is out of the field of view (FOV).

Solution To make the sample visible on the visual light camera monitor

1. Ensure that the visual light camera monitor is turned ON.

NOTE When the visual light camera monitor is turned ON, you should see 
the sample stage (if the access door(s) is (are) closed) or yourself (if the 
access door(s) is (are) open). If you do not see anything on the monitor, 
press its Power button, to turn ON the monitor. If the visual light monitor 
remains blank after ensuring that the monitor is turned ON, contact 
the Xradia Support Team for assistance.

2. Ensure that the visual light camera light switch (D on Figure 1-7, 
“Ergonomic Station,” on page 16) is in the UP (ON) position, 
and that the interior light is ON. 

NOTE If the switch is in the ON position, and the light is not ON, contact 
the Xradia Support Team.

3. With the access door(s) closed, visually verify that the:

– Sample is securely mounted in/on the sample holder, and has not 
slid from view, and that its region of interest is:

– Facing up

– Located above the top surface of the holder

– Positioned so that the least amount of material is penetrated 
by X-ray

– Sample holder is properly loaded onto the sample stage 
(refer to “Loading the Sample Holder Assembly onto the Sample 
Stage,” on page 41)

– Detector and X-ray source are situated as close as possible 
to the sample, without colliding with nor touching the sample
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4. If it is difficult to see the sample due to glare, use the monitor’s 
brightness control to reduce the glare, until the sample is visible.

NOTE Two models of visual light camera monitors are currently in use. 
One has self-descriptive control buttons, and the other has control buttons 
represented by icons. Instructions for using the latter to adjust monitor glare 
is provided in Appendix D, “Visual Light Camera Monitor Brightness Controls.”

If you resume the process in which you determined there was an issue, 
and the issue still exists, contact the Xradia Support Team for assistance.
214 MicroXCT-200 and MicroXCT-400 User’s Guide



Appendix A – Troubleshooting
Sample Region of Interest Is Not Visible

NOTE Mounting and installation of the sample are discussed in “Mounting the 
Sample in/on a Sample Holder,” on page 33, and “Installing the Sample,” on page 39, 
respectively. If you need to remount or install the sample, refer to the relevant 
processes described in those sections.

Symptom Region of interest (the focus of the data to be acquired) is not visible.

Problem Sample is not properly mounted nor installed, or is out of the field 
of view (FOV).

Solution To make the sample region of interest visible

1. Try reducing the magnification level by one step at a time, until the 
region of interest is visible. In XMController, click the drop-down arrow 

to the right of  in the icon bar, then select a lower magnification 
level from the drop-down list. Follow the processes described in 
“Identifying the First Point,” steps 2 through 8, on page 68, to center the 
region of interest within the FOV of the selected magnification lens. 
If you do not see the region of interest, even at the lowest available 
magnification, proceed to step 2.

NOTE If the MicroXCT has a non-motorized turret, open the access door (if it 
is closed), slowly turn the turret CLOCKWISE or COUNTERCLOCKWISE, until the 
lower magnification lens you want to use clicks into place, at the bottom 
position (lowest point) of the turret, then close the access door. Follow standard 
procedures for turning the X-ray source OFF and ON, prior to opening and closing the 
access door, respectively.

2. Follow steps a through d to reposition the sample, using the visual 
light camera:

a. Open the Motion Controller dialog box. In the Source tab, note the 
current Source Z position. In the Detector tab, note the current 
Camera Z position. These values are used later, in step 4.

b. In the Motion Controller dialog box Detector tab, type a more 
positive value than the current Camera Z position, in the 
Camera Z text box, then click GO. This will provide more 
space for manipulating the sample.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.
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c. In the Motion Controller dialog box Source tab, type a more 
negative value than the current Source Z position, in the 
Source Z text box, then click GO. This will provide more 
space for manipulating the sample.

d. Estimate the location of the region of interest, and reposition 
it within the center of the visual light camera monitor, using the 
processes described in “Coarsely Positioning the Sample,” on 
page 48. Proceed to step 3.

3. Follow steps a through c to search for the region of interest, starting 
at the lowest magnification level:

a. Center the region of interest on the field of view (FOV), using the 
processes described in “Identifying the First Point,” steps 2 through 
7, on page 68, but increase the magnification by one level in step 7.

b. Repeat the processes described in “Identifying the First Point,” 
steps 2 through 6.

c. Continue iterating “Identifying the First Point,” steps 2 through 7, 
increasing the magnification by one level at a time, until optimum 
magnification is achieved for the region of interest.

4. Follow steps a and b to move the X-ray source and detector back to their 
original positions noted in step 2a:

a. In the Motion Controller dialog box Source tab, type the original 
current Source Z position in the Source Z text box, then click GO.

b. In the Motion Controller dialog box Detector tab, type the original 
current Camera Z position in the Camera Z text box, then click GO.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.
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5. Follow steps a and b to verify that the sample does not collide 
with either the detector or X-ray source, by rotating Sample Theta 
through the tomographic angle range:

a. Follow the processes described in “Finely Positioning the Detector,” 
steps 6 through 8, starting on page 73, to ensure that the sample 
does not collide with the detector.

b. Follow the processes described in “Finely Positioning the X-ray 
Source,” steps 6 through 8, starting on page 78, to ensure that 
the sample does not collide with the source.

If you resume the process in which you determined there was an issue, 
and the issue still exists, contact the Xradia Support Team for assistance.
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Sample and Detector Collision Is Imminent

Symptom While using XMController and moving the sample or detector, the two are 
coming too close to one another.

Problem The sample and detector are so close that they might collide or touch 
one another.

Solution To prevent the sample and detector from colliding

1. If you have just clicked GO within any axis panel, within any tab of the 

Motion Controller dialog box, click , in the same axis panel, 
to immediately stop movement.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

2. Review the safety guidelines provided in “Collision of Moving Parts,” 
on page xxii.

3. Move the Detector away from the sample. Select the Motion Controller 
dialog box Detector tab, type a value greater than the current Camera Z 
position, in steps of 5 mm or less, in the Camera Z text box, then 
click GO.

Repeat this step, as necessary, until the detector does not touch 
the sample, but is still sufficiently close to it.
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Sample and Detector Collided

Symptom While using XMController, the detector and sample are positioned such that 
they are touching one another, or the sample holder fell off the sample stage 
when the sample and detector collided.

Problem While moving the sample or detector, the two collided with one another.

Solution To resolve the problems caused by the collision

1. Click Stop all motors in any tab within the Motion Controller 
dialog box.

2. If the detector is damaged – Contact the Xradia Support Team 
for assistance.

3. Review the safety guidelines provided in “Collision of Moving Parts,” 
on page xxii.

4. If the sample holder fell off the sample stage – Follow steps a 
through e to load the sample holder back onto the sample stage:

a. Open the Motion Controller dialog box Detector tab. Type a value 
5 mm (or more) greater than the current Camera Z position, in the 
Camera Z text box, then click GO to move the detector away from 
the sample.

b. Follow the process described in “Loading the Sample Holder 
Assembly onto the Sample Stage,” steps 6 and 7, starting on page 45, 
to turn OFF the X-ray source, and then open the access door.

c. Load the sample holder back onto the sample stage, using the 
process described in “Loading the Sample Holder Assembly 
onto the Sample Stage,” step 8, on page 46.

d. Follow the processes described in “Finely Positioning the Detector,” 
on page 71, to position the detector as close to the sample as 
possible, through the tomographic angle range, without touching 
or colliding with the sample.

Repeat this step, as necessary, until the detector is sufficiently close 
to the sample, without touching it.

e. Follow the processes described in “Turning on the X-ray Source,” 
steps 1 through 3, starting on page 58, to close the access door 
and then turn ON the X-ray source.
MicroXCT-200 and MicroXCT-400 User’s Guide 219



Appendix A – Troubleshooting
5. If the sample is damaged – Follow steps a through c to replace 
the sample:

a. Follow the processes described in Appendix E, “Removing the 
Sample after Use,” to remove and discard the sample.

b. Mount a new sample in/on the sample holder, following the 
processes described in “Mounting the Sample in/on a Sample 
Holder,” on page 33.

c. Follow the processes described earlier in this guide, starting 
from Chapter 2, to position and scan the new sample.
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Sample and X-ray Source Collision Is Imminent

Symptom While using XMController and moving the sample or X-ray source, the two 
are coming too close to one another.

Problem The sample and X-ray source are so close that they might collide or touch 
one another.

Solution To prevent the sample and X-ray source from colliding

1. If you have just clicked GO within any axis panel, within any tab of the 

Motion Controller dialog box, click , in the same axis panel, 
to immediately stop movement.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

2. Review the safety guidelines provided in “Collision of Moving Parts,” 
on page xxii.

3. In the Motion Controller dialog box, select the Source tab, 
type a value more negative than the current Source Z position, 
in steps of 5 mm or less, in the Source Z text box, then click GO.

Repeat this step, as necessary, until the X-ray source does not touch the 
sample, but is still sufficiently close to it.
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Sample and X-ray Source Collided

Symptom While using XMController, the X-ray source and sample are positioned such 
that they are touching one another, or the sample holder fell off the sample 
stage when the sample and X-ray source collided.

Problem While moving the sample or X-ray source, the two collided with one another.

Solution To resolve the problems caused by the collision

1. Click Stop all motors in any tab within the Motion Controller 
dialog box.

2. If the X-ray source or detector is damaged – Contact the Xradia 
Support Team for assistance.

3. Review the safety guidelines provided in “Collision of Moving Parts,” 
on page xxii.

4. If the sample holder fell off the sample stage – Follow steps a 
through e to load the sample holder back onto the sample stage:

a. Open the Motion Controller dialog box Source tab. Type a value 
5 mm or more negative than the current Source Z position, in the 
Source Z text box, then click GO to move the source away from 
the sample.

b. Follow the process described in “Loading the Sample Holder 
Assembly onto the Sample Stage,” steps 6 and 7, starting on page 45, 
to turn OFF the X-ray source, and then open the access door.

c. Load the sample holder back onto the sample stage, using the 
process described in “Loading the Sample Holder Assembly 
onto the Sample Stage,” step 8, on page 46.

d. Follow the processes described in “Finely Positioning the X-ray 
Source,” on page 75, to position the X-ray source as close to the 
sample as possible, through the tomographic angle range, without 
touching or colliding with the sample.

Repeat this step, as necessary, until the X-ray source is sufficiently 
close to the sample, without touching it.

e. Follow the processes described in “Turning on the X-ray Source,” 
steps 1 through 3, starting on page 58, to close the access door 
and then turn ON the X-ray source.
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5. If the sample is damaged – Follow steps a through c to replace 
the sample:

a. Follow the processes described in Appendix E, “Removing the 
Sample after Use,” to remove and discard the sample.

b. Mount a new sample in/on the sample holder, following the 
processes described in “Mounting the Sample in/on a Sample 
Holder,” on page 33.

c. Follow the processes described earlier in this guide, starting 
from Chapter 2, to position and scan the new sample.
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Troubleshooting Magnification Lens Too Close  
to the X-ray Source – Keeping the X-ray Source  
Aperture out of the Field of View

It is important to keep the X-ray source aperture out of the field of view (FOV) 
for the Macro, 1X, 2X, and 4X lenses. If the separation between the X-ray 
source and detector is less than the amount specified in Table 3-3, “Minimum 
Distance between X-ray Source and Detector for Macro, 1X, 2X, and 4X 
Lenses,” on page 75, the X-ray source aperture will be visible in the FOV.

Symptom X-ray source aperture is visible in image scans.

Problem Corner clipping of the images taken with Macro-70, 1X, and 4X lenses and 
reduction in area of the round FOV in the Macro-55 (0.5X) and 2X lenses 
occur due to the X-ray source aperture.

Figure A-2 Example of Image with Source Aperture in FOV of Macro-70 
Lens – Image taken with X-ray Source at -50 mm and Detector 
at 50 mm
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Solution To remove the X-ray source aperture from the image

1. In the Motion Controller dialog box Source tab, type a value 5 mm 
more negative than the current Source Z position in the Source Z text 
box, then click GO, to move the X-ray source away from the sample. 
 
–or– 
 
In the Motion Controller dialog box Detector tab, type a value 5 mm 
greater than the current Camera Z position in the Camera Z text box, 
then click GO, to move the detector away from the sample.

The end result should resemble Figure A-3.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

Figure A-3 Example of Core Sample Filling FOV for Macro-70 , without 
X-ray Source Aperture Showing
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Troubleshooting Image Contrast, Brightness, 
and Light Intensity Count Issues

Image contrast, brightness, and light intensity count (saturation) adjustments 
are typically process-specific. Table A-3 lists processes in the guide that 
describe how to adjust image contrast, brightness, and/or light intensity 
counts, within the context of those processes.

Table A-3 Processes that Apply Contrast, Brightness, and/or Light Intensity 
Count (Saturation) Adjustments, by Program

Program
Processes that Apply Contrast, Brightness, and/or
Light Intensity Count (Saturation) Adjustments

XMController

“Collecting Continuous Images,” step 2, on page 66

“Selecting the Source Filter,” step e, on page 83

“Determining the Optimum X-ray Source Voltage,” 
step 2b, on page 92

“Collecting a Reference Image,” step 3, on page 145, 
Exposure time-related Note

XMReconstructor
“Identifying Center Shift,” step 4, on page 158

“Identifying Beam Hardening Correction,” step 4, on page 163

XM3DViewer

“Adjusting Contrast and Brightness in the 2D Reconstructed Slice 
Windows,” on page 180

“Creating 3D Volume Renderings,” step 4, on page 186

“Creating 3D Volume Renderings,” step 6, on page 187
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Troubleshooting Issues with XM3DViewer

NOTE This guide provides basic information for using XM3DViewer to 
view tomographic data after reconstruction. For further details regarding the 
program’s use, refer to the Xradia ExamineRT Workstation 1.1 User’s Manual, 
available under XM3DViewer’s Help menu.

Because XM3DViewer is a third-party product, its troubleshooting is described 
separately, in “Correcting Problems with the Reconstructed File,” on page 203.

Additional troubleshooting, with respect to image contrast and brightness, 
is also provided in earlier in this appendix, in “Troubleshooting Image 
Contrast, Brightness, and Light Intensity Count Issues.”
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Troubleshooting MicroXCT Power Failures

This section provides tips for troubleshooting MicroXCT power failures.

Symptom Light tower lights do not turn ON; entire MicroXCT and/or workstation 
does not turn ON; visual light camera monitor and/or workstation 
monitor does not turn ON.

Problem One or more components within the MicroXCT is not receiving power.

Solution To troubleshoot MicroXCT power failures

1. Verify that the MicroXCT’s three-prong power connector is connected 
to a grounded 100 to 240 VAC, 12A power source. If it is not, plug it in, 
then proceed to step 6.

However, if using an uninterruptible power source (UPS), line 
conditioner, surge protector, or similar device, ensure that the MicroXCT 
is connected to the device, and that the device’s power connector is 
connected to a grounded 100 to 240 VAC, 12A power source. If it is not, 
plug it in, then proceed to step 6.

2. Open the cabinet door on the lower left side of the MicroXCT. Verify 
that all PDU power breakers are in the UP position, and that none 
are tripped (in the DOWN position). (Refer to item J in Figure 1-1 
on page 5 (MicroXCT-200) or Figure 1-2 on page 6 (MicroXCT-400).)

WARNING Do not reset a power breaker if it is tripped. Contact the Xradia 
Support Team for assistance.

3. Verify that the component’s (workstation, visual light camera monitor, 
and/or workstation monitor) Power button is lit. If it is not lit, press 
its Power button again.

If MicroXCT power is still failing, proceed to step 4. Otherwise, this 
process is complete.

4. Shut down the MicroXCT, following the processes described in “Shutting 
Down the MicroXCT in a Non-Emergency Event,” on page 246.

5. Verify that the power source is working, by plugging another electrical 
item into it, or testing it with an electrical outlet tester.

NOTE Contact your Facilities or Maintenance Department if another 
electrical item does not work when plugged into the power source. Either 
the electrical receptacle must be replaced, or the power source’s circuit 
breaker is tripped.
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6. Turn ON the MicroXCT, following the processes described 
in “Turning ON the MicroXCT,” on page 247.

If you resume the process in which you determined there was an issue, 
and the issue still exists, contact the Xradia Support Team for assistance.
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Troubleshooting Light Tower Issues

Table A-4 describes the behavior of each light (status indicator) in the light 
tower. Figure A-5 illustrates a sample light tower status combination. If any 
status indicators are not functioning as described, contact the Xradia Support 
Team for assistance.

Figure A-5 Sample Light Tower Status Combination

Table A-4 Light Tower Lights (Status Indicators)

Light Tower Indicator Status Description

All lights OFF Power to the MicroXCT is OFF.

Red light ON (top)
X-ray source is ON, and X-rays are present 
within the enclosure.

Red light OFF (top)
X-ray source is OFF, and X-rays are not 
present within the enclosure.

Yellow light ON (center) Access door(s) is (are) closed.

Yellow light OFF (center) Access door(s) is (are) open.

Green light ON (bottom) Power to the microscope is ON.

Green light OFF (bottom) Power to the microscope is OFF.

Red light OFF – X-ray source is OFF, X-rays are not present within the enclosure 
Yellow light ON – Access door(s) is (are) closed
Green light ON – Power to the microscope is ON
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Contacting the Xradia Support Team (Technical Support)

If you need assistance with the MicroXCT, contact the Xradia Support Team, 
using one of the following methods:

Email: service@xradia.com

Telephone: 1 (888) 497-2342 
1 (925) 771-8093

Mail: Xradia, Inc. 
5052 Commercial Circle 
Concord, CA 94520   USA
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B MicroXCT Files and File Storage

This appendix describes the file types unique to the MicroXCT programs, 
recommended file handling, and how to export the files to graphic formats, 
as well as file storage:

– File Types

– Exporting Files

– Exporting *.xrm Files or Single Images on XMController

– Exporting *.txrm and *.txm Files

– File Storage (Hard Disk Drive(s))
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File Types

XMController controls the MicroXCT hardware during setup and data 
acquisition. It can also be used for general image processing and 2D-image 
viewing for Xradia-specific images. XMController is primarily used for 
acquiring tomography datasets, which are a collection of 2D images 
(projections) acquired at different angles around the axis of rotation in 
the MicroXCT. Datasets that contain a collection of projection images are 
saved with the extension .txrm. Each *.txrm file contains multiple images. 
In contrast, files with the extension .xrm contain only one image.

XMReconstructor reconstructs images stored in each *.txrm file, to form a set 
of reconstructed slices. A slice is a 2D section of the 3D reconstructed volume, 
oriented in the X/Z plane. Slices generated from each *.txrm file are stored in 
a file with the extension .txm. A *.txm file contains a collection of slices that 
make up the reconstructed volume. If no specific region is selected during 
reconstruction, the number of slices is equal to the height of each projection 
image in the original *.txrm file.

A *.txm file generated by XMReconstructor is also referred to as a volume 
viewer file. These files can be viewed with XM3DViewer. XMController can 
also open and process *.txm files.

Table B-1 summarizes the file extensions used for files used by the MicroXCT, 
and their associated programs. The check mark ( ) indicates that the file 
type is opened and/or processed by the program. Figure B-1 illustrates the 
relationship between the XMController, XMReconstructor, and XM3DViewer 
programs, and the data, processes, and files generated by each.

Table B-1 File Extensions and Related Programs

File Description
File 

Extension XMController XMReconstructor XM3DViewer

Collection of 2D projection 
images acquired using 
XMController. Also referred 
to as a tomography dataset.

.txrm

Image acquired with Single, 
Averaging (on-the-fly), 
Continuous, and Mosaic 
acquisition modes and saved, 
using XMController.

.xrm

Collection of 2D reconstructed 
slices created by 
XMReconstructor. Also referred 
to as a volume viewer file.

.txm
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Figure B-1 MicroXCT Data, Processes, and Files
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Exporting Files

NOTE XM3DViewer can be used to export Word documents (*.doc) and 
MPEG movies (*.mpg). For details, refer to “Generating a Report,” on page 193 
and “Creating Movies of Cross-Sectional 2D Reconstructed Slices and 3D Volumes,” 
on page 195, respectively.

XMController can be used to export images acquired and/or reconstructed 
by the MicroXCT programs, into the following graphic file formats:

– 8-bit tiff (.tif)

– bitmap (.bmp)

– JPEG (.jpg)

– 16-bit raw tiff (.tiff)

– binary (.bin)

– single image (.xrm)

Images exported as 8-bit tiff, bitmap, and JPEG files can be viewed by standard 
graphics programs, such as Microsoft Paint, Adobe Photoshop, and others, and 
can be inserted into documents, such as Microsoft Word and PowerPoint files. 
JPEG files can also be viewed in web browsers.

16-bit tiffs can only be viewed with specialized image software, 
such as MATLAB and ImageJ. 

Binary images are accompanied by header files (*Header.txt) – simple text 
files that indicate the parameters required to read these images. An example 
of a binary header file is provided in Figure B-2.

Multiple images in *.txrm and *.txm files can be exported as single-image 
*.xrm files, that XMController can read and display. Although available, this 
export option is not often needed/used.

The export process varies, dependent upon the original file type:

– Exporting *.xrm Files or Single Images on XMController

– Exporting *.txrm and *.txm Files

Each is discussed in the sections that follow.
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Figure B-2 Header File that Accompanies Exported Binary File(s)
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Exporting *.xrm Files or Single Images on XMController
*.xrm files are single image files acquired using XMController. 
This process describes how to export *.xrm files or any single images 
from XMController to the various formats previously described.

To export *.xrm files

1. Start XMController, if it is not already running.

NOTE Instructions for starting XMController are provided in “Loading the 
Sample Holder Assembly onto the Sample Stage,” step 1, on page 42.

2. If the file or image to be exported is already open, proceed to step 6; 
otherwise open the file by selecting File > Open…. The Open File 
dialog box opens.

Figure B-3 Open File Dialog Box

3. Browse to the file’s path.

4. Select Projection Image Files (*.xrm) from the Files of type 
drop-down list box.

5. Select the *.xrm file to be exported, then click Open. A *.xrm file 
window opens within the XMController main window.
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6. Select File > Export…. The Save File dialog box opens.

Figure B-4 Save File Dialog Box

7. Browse to the destination file path.

8. Type the new file name in the File name text box.

9. Select the export file format from the Save as type drop-down list box.

10. Click Save to export the file to the selected format.
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Exporting *.txrm and *.txm Files
*.txrm files contain projection images acquired during a tomography. *.txm 
files contain 2D reconstructed slices output from XMReconstructor. This 
process describes how to export *.txrm and *.txm files to the various formats 
previously described.

To export *.txrm and *.txm files

1. Start XMController, if it is not already running.

NOTE Instructions for starting XMController are provided in “Loading the 
Sample Holder Assembly onto the Sample Stage,” step 1, on page 42.

2. If the file or image to be exported is already open, proceed to step 6; 
otherwise open the file by selecting File > Open…. The Open File 
dialog box opens.

Figure B-5 Open File Dialog Box

3. Browse to the file’s path.

4. Select the *.*xrm or *.txm file type from the Files of type drop-down 
list box.

5. Select the *.txrm or *.txm file to be exported, then click OK. A *.txrm 
or *.txm file window opens within the XMController main window.
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6. If you are planning to export the entire file – Proceed to step 7.

If you are planning to export only a single image from the file –
Scroll through the images in the file’s window, using the slider in 
the scroll bar or the image number control (click the – or + symbols) 
at the bottom of the window, to locate and identify the image 
to be exported in step 9.

7. Select File > Export…. The Export Images dialog box opens.

Figure B-6 Export Images Dialog Box

8. Select the export file format from the Save as type drop-down list box.

9. Select the save options:

Option Setting Value

Option

Select one of the following options:
– Whole Series – Exports all images from the *.txrm or *.txm file
– Current Image – Exports only the currently displayed image 

selected in step 6

If you selected Whole Series, select one of the following options:
– Save as Multiple File – Exports the images individually. The 

file name of each image will have four digits appended to it, 
in increasing numbers, starting from 0001, corresponding 
to the image sequence in the original *.txrm or *.txm file.

– Save as One File – Exports all images in a single file.

Include 
Annotations

Select to include, in the exported image, the scale bar, and any 
annotations that were applied. This option is not available for 
binary and raw tiff format.
MicroXCT-200 and MicroXCT-400 User’s Guide 241



Appendix B – MicroXCT Files and File Storage
10. Select the location options:

11. Click OK. If exporting multiple images, a Wait message box 
opens, showing the export progress, then closes when the file 
is finished exporting.

Figure B-7 Wait Message Box

NOTE If you need to cancel the export before the file completes the export 
process, click Abort.

Option Setting Value

Dir Click …, then browse to the destination file path.

Series/File name
Type the new file name for the exported file(s) 
in this text box.
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File Storage (Hard Disk Drive(s))

The MicroXCT workstation has one internal hard disk drive – drive C, which 
is a RAID-5 array hard disk drive with fast read/write speed. The amount 
of disk space available on drive C varies, because it is dependent upon 
the workstation model available at the time of shipment/purchase.

An optional storage server is also available from Xradia. If included with your 
MicroXCT, it is networked to the workstation, and as an additional hard 
disk drive.

NOTE RAID (redundant array of independent disks) provides redundant 
(mirrored copies) fail-safe storage for all programs and data stored on drive C.

NOTE The desktop folder path is typically C:/Documents and Settings/
[Your Windows User Login Name]/Desktop.

NOTE It is recommended that you periodically backup drive C, 
and remember to empty the Recycle Bin after deleting files.

NOTE During reconstruction with XMReconstructor, the amount of free 
space required on the hard disk drive must be at least 1 GB more than 
the file size of the tomography (projection) dataset.
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C Shutting Down and Restarting 
the MicroXCT

This appendix describes how to shutdown and restart the MicroXCT, 
and then home all motorized axes to pre-defined initialization positions:

– Shutting Down the MicroXCT in a Non-Emergency Event

– Turning ON the MicroXCT

– Homing the Axes

NOTE The EMO shutdown process (pressing of the EMO button), 
used in the event of a personal safety or equipment emergency, 
is described in “EMO Shutdown,” on page xii.
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Shutting Down the MicroXCT in a Non-Emergency Event

This process describes how to shut down the MicroXCT in a non-emergency 
event, such as when troubleshooting a problem that requires resetting the 
MicroXCT, or if the MicroXCT is not going to be used for a long period 
of time (such as during a holiday closure).

To shut down the MicroXCT in a non-emergency event

1. On the workstation, close any programs that are running.

2. Select Start > Shut Down.

3. If the MicroXCT has a storage server – Refer to the provided storage 
server manufacturer’s product documentation for its shutdown 
instructions.

4. When prompted, select Shut Down to shut down the workstation.

Follow the instructions as they appear onscreen.

5. After the workstation is shut down, firmly press the EMO button (located 
on the front panel of the enclosure (and back panel, MicroXCT-400 
only); refer to Figure C-1), to turn OFF power to the MicroXCT.

Proceed to “Turning ON the MicroXCT.”

NOTE For specific EMO and RESET button locations, refer to Figure 1-1, 
“MicroXCT-200 External View, with Access Door Open, and Lower Doors Removed,” 
on page 5, and Figure 1-2, “MicroXCT-400, External View, with Lower Doors 
Removed,” on page 6.

Figure C-1 EMO and RESET Buttons

MicroXCT-200 MicroXCT-400
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Turning ON the MicroXCT

This process describes how to turn ON the MicroXCT if it has been shut 
down (turned OFF).

To turn ON the MicroXCT

1. Ensure that the three-prong power connector (located at the back 
of the MicroXCT) is connected to a grounded 100 to 240 VAC, 
12A power source.

NOTE The MicroXCT should already be connected to power, at installation.

NOTE If using an uninterruptible power source (UPS), line conditioner, surge 
protector, or similar device, ensure that the MicroXCT is connected to the 
device, and that the device’s power connector is connected to a grounded 
100 to 240 VAC, 12A power source.

2. If restarting the MicroXCT after an emergency event – Verify that the 
emergency has passed, all personnel are safe, and all appropriate safety 
conditions are satisfied.

3. Turn the EMO button (refer to Figure C-1) CLOCKWISE, until 
it pops upward. This releases the EMO button and enables 
use of the RESET button.

4. Press the RESET button (located above the EMO button) to turn ON 
the MicroXCT.

The green light on the light tower (bottom light) turns ON. If the access 
door(s) is (are) closed, satisfying all safety interlocks, the yellow light 
on the light tower (middle light) also turns ON.

NOTE If pressing the RESET button does not power-on the MicroXCT, 
repeat step 3, to ensure that the RESET button is enabled.

NOTE At this point, it is okay to have the access door(s) open. If the 
yellow light does not turn ON, the access door(s) is (are) not securely closed. 
To securely close the access door(s), open and then reclose the door(s).
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Figure C-2 Light Tower

5. If the MicroXCT has a storage server – Refer to the provided storage 
server manufacturer’s product documentation for its power-on 
instructions.

6. Press the workstation’s Power button, to turn ON the MicroXCT 
workstation.

7. Press the workstation monitor’s Power button, to turn ON the monitor. 
The standard Windows XP desktop should be(come) visible.

8. Turn ON the interior light, by moving the visual light camera light 
switch (D on Figure 1-7, “Ergonomic Station,” on page 16) to the 
UP (ON) position.

9. Press the visual light camera monitor’s Power button, to turn ON 
the monitor.

NOTE When the visual light camera monitor is turned ON, you should see 
the sample stage (if the access door(s) is (are) closed), as well as yourself 
(if the access door(s) is (are) open). If you do not see anything on the monitor, 
press its Power button again, to turn ON the monitor.

If you plan to use XMController, proceed to “Homing the Axes.”

Red light OFF – X-ray source is OFF, X-rays are not present within the enclosure 
Yellow light ON – Access door(s) is (are) closed
Green light ON – Power to the microscope is ON
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Homing the Axes

This process describes how to use XMController to home all motorized 
axes to their pre-defined initialization positions – set the Sample X, Y, Z, 
and Theta values of the sample stage to 0, and the X-ray source and detector 
to their negative (-Limit) and positive (+Limit) limits, respectively – 
in preparation for acquiring tomographic data.

Typically, the axes are automatically homed, as described in “Automatically 
Homing the Axes.” However, if it is necessary to manually home the axes, 
instructions for doing so are provided in “Manually Homing the Axes.”

NOTE The axes must be homed whenever the MicroXCT is restarted 
after a shutdown. It is usually not necessary to home the axes at any 
other time, unless instructed to do otherwise by the Xradia Support Team.
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Automatically Homing the Axes
This process describes how to automatically home all motorized axes to their 
pre-defined initialization positions.

To automatically home all axes

1. Start XMController, if it is not already running.

NOTE Instructions for starting XMController are provided in “Loading the 
Sample Holder Assembly onto the Sample Stage,” step 1, on page 42.

2. If the MicroXCT has previously been turned OFF, just prior to starting 
XMController, the Homing required dialog box opens. Click Yes to 
home all motorized axes. Follow the instructions as they appear.

WARNING If you accidentally clicked No in the Homing required dialog 
box, you must manually home all axes. Proceed directly to “Manually Homing 
the Axes.”

Figure C-3 Homing required Dialog Box

During the homing process, the Homing Status dialog box opens, 
indicating the status in real time. This process can take several minutes.

Axis homing is complete and successful when the “All homing routines 
have completed successfully” message and the Done button appear 
in the Homing Status dialog box.
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Figure C-4 Final Homing Status Dialog Box – All Axes Successfully Homed

WARNING For each axis, the two homing errors illustrated in Figure C-5 
(indicated in red) can occur during:

– Coarse home, when the axis fails to move to its limit

– Fine home, when the axis fails to move to the predetermined offset

If there are homing errors, the message “… failed to home” also appears 
in the Homing Status dialog box, at the end of the message list. Locate the 
homing status error(s), scrolling up through the messages, as necessary, 
then contact the Xradia Support Team for assistance.
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Figure C-5 Final Homing Status Dialog Box – Homing Errors

3. If homing was successful – Click Done, then proceed to Chapter 2, 
“Setting Up for Data Acquisition,” to prepare the MicroXCT for 
acquiring data.

If homing was unsuccessful (that is, the Homing Status dialog box 
indicates homing errors) – Contact the Xradia Support Team.

NOTE If the MicroXCT has just completed axis homing, it is normal for the red Error 
message bar to appear. To resolve this, click the drop-down arrow to the right 

of in the icon bar, select a magnification lens, then click the red Error message 
bar to close the message bar.

Error – Followed out on coarse home Error – Followed out on fine home
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Manually Homing the Axes
This process describes how to manually home all motorized axes to their 
pre-defined initialization positions. Use this process only if you clicked No 
in “To automatically home all axes,” step 2, or if you need to manually 
home all axes.

To manually home all axes

1. Start XMController, if it is not already running.

NOTE Instructions for starting XMController are provided in “Loading the 
Sample Holder Assembly onto the Sample Stage,” step 1, on page 42.

2. Select Microscope > Home all axes…. The Home All Axes dialog 
box opens.

Figure C-6 Home All Axes Dialog Box

3. Click Yes to home all axes. A Warning dialog box opens, indicating 
the sample must be removed before proceeding. The warning appears 
regardless of whether a sample is physically present.

Figure C-7 Warning Dialog Box – Sample Present
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4. If a sample is present – Follow steps a through c to remove the sample:

a. Open the access door.

b. Remove the sample holder assembly from the sample stage.

c. Close the access door.

NOTE If you can see yourself on the visual light camera monitor, the access 
door is still open.

5. Click OK.

During the homing process, the Homing Status dialog box opens, 
indicating the status in real time. This process can take several minutes.

Axis homing is complete and successful when the “All homing routines 
have completed successfully” message and the Done button appear 
in the Homing Status dialog box. (Refer to Figure C-4.)

WARNING For each axis, the two homing errors illustrated in Figure C-5 
(indicated in red) can occur during:

– Coarse home, when the axis fails to move to its limit

– Fine home, when the axis fails to move to the predetermined offset

If there are homing errors, the message “… failed to home” also appears 
in the Homing Status dialog box, at the end of the message list. Locate the 
homing status error(s), scrolling up through the messages, as necessary, 
then contact the Xradia Support Team for assistance.

6. If homing was successful – Click Done, then proceed to Chapter 2, 
“Setting Up for Data Acquisition,” to prepare the MicroXCT for 
acquiring data.

If homing was unsuccessful (that is, the Homing Status dialog box 
indicates homing errors) – Contact the Xradia Support Team.

NOTE If the MicroXCT has just completed axis homing, it is normal for the red Error 
message bar to appear. To resolve this, click the drop-down arrow to the right 

of in the icon bar, select a magnification lens, then click the red Error message 
bar to close the message bar.
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D Visual Light Camera Monitor 
Brightness Controls

This appendix describes how to change the brightness, to reduce image glare, 
on the visual light camera monitor that has icon control buttons. (Refer to 
Figure D-1.)

NOTE The brightness control buttons on the other visual light camera 
monitor used by some MicroXCTs are self-explanatory.
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Figure D-1 Visual Light Camera Monitor with Icon Control Buttons

NOTE The image in Figure D-1 is provided to illustrate the button layout only, 
and does not represent the type of glare being adjusted on the monitor.

To adjust the visual light camera monitor brightness

1. Access Menu mode, by pressing the Menu button, . Brightness 
with a brightness level number appears on the monitor.

2. Press  or  to adjust brightness, until image glare is no longer visible 
on the monitor.

The word Brightness disappears from the monitor after approximately 
5 seconds of non-use.

3. At this point, you can also or scroll through other menu options – 

Color, Contrast, and Tint – by pressing  to access each, until 
you reach the last option and exit Menu. These other menu options 
can be adjusted, using the same  or  method described in step 2.

Up and Down Menu Power
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E Removing the Sample after Use

This appendix describes how to remove the sample from the MicroXCT, 
after you have finished imaging the sample.

CAUTION Follow the safe sample handling procedures established 
by your work site.

To remove the sample after use

1. Follow the processes described in “Loading the Sample Holder Assembly 
onto the Sample Stage,” steps 3 through 7, starting on page 44, to move 
the X-ray source and detector away from the sample stage, turn OFF the 
X-ray source, and open the access door.

2. Remove the sample holder from the sample stage.

3. Remove the sample from the sample holder, as described in the 
following table.

4. Store the sample in a safe place that is free from contaminants, for future 
use, or dispose of properly, per site-specific requirements.

Holder Type Process

Clamp
While holding the sample, loosen the clamp thumbscrew 
COUNTERCLOCKWISE, then remove the sample from the clamp.

Clip
While holding the sample, push down on the clip to open the clip, 
then remove the sample from the clip.

Pin Vise
Rotate the outer section of the vise COUNTERCLOCKWISE, then 
remove the sample (or toothpick or rod) from the vise.

Sample Base
While holding the sample, remove the cellophane tape from the 
sample base surface.
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THIS PAGE INTENTIONALLY LEFT BLANK
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F Determining Whether the 
MicroXCT is 360°-Enabled

This appendix describes how to determine whether the MicroXCT is 180° 
or 360°-enabled.

Some older MicroXCT models are 180°-enabled; others are 360°-enabled. 
If the MicroXCT is not 360°-enabled, use the -90 to +90 tomographic 
angle range, when a tomographic angle range is requested.

Table F-1 lists the sample types and their corresponding Sample Theta 
tomographic angle ranges.

Table F-1 Sample Types and Sample Theta Tomographic Angle Ranges

Sample Type
Sample Theta

Tomographic Angle Range

Semiconductor, flat
-90 to +90 (180°; half circle)

(appear as -90 deg and +90 deg 
in Sample Theta panel)

Rigid biological material
-180 to +180 (360°; full circle)

(appear as -180 deg and +180 deg 
in Sample Theta panel)

Soft biological material that fits within a tube

Solid material
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There are two methods for determining whether the MicroXCT has 180° 
or 360° capability.

Method 1

1. In the Motion Controller dialog box, select the Sample tab.

2. In the Sample Theta panel, type 180 in the Sample Theta text box, 
then click GO.

If the Sample Theta Current Position status indicates +Limit before 
Sample Theta rotates to 180 deg, the MicroXCT is not 360°-enabled.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.

Method 2

1. In the Motion Controller dialog box, select the Sample tab.

2. In the Sample Theta panel, type -180 in the Sample Theta text box, 
then click GO.

If the Sample Theta Current Position status indicates -Limit hit before 
Sample Theta rotates to -180 deg, the MicroXCT is not 360°-enabled.

CAUTION Always position the mouse pointer over , in the same axis 
panel, after clicking GO in the Motion Controller dialog box, so that movement 
can be quickly stopped (by clicking the button) if collision is imminent.
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G Specifications

This appendix lists the MicroXCT-200 and MicroXCT-400 specifications 
that are of use to customers.

NOTE Contact the Xradia Support Team for specific questions related 
to maintenance, or for any specifications that may not be included 
in this guide at the time of publication.

NOTE All specifications are subject to change. Consult Xradia for 
current specifications.
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MicroXCT-200 Specifications

This appendix provides the following MicroXCT-200 specifications:

– Spatial Resolution

– Components

– Facility Requirements

Spatial Resolution

Table G-1 Spatial Resolution – MicroXCT-200

Magnification Level/
Lens

Best Resolution 
at 10% MTFa

(µm)

a. MTF (Modulation Transfer Function) measured using Xradia’s standard 
2D resolution target.

Detector Pixel Sizeb

(µm)

b. Pixel size on the face of the detector; Detector Area = 2,048 * Detector Pixel size, 
except 1X; Detector Area for 1X = 1,024 x Detector Pixel Size.

Sample Width Limit
(mm)

Standard Lenses (included with every MicroXCT)

4X 5.0 3.4 50

10X 2.5 1.4 50

20X 1.5 0.7 30

Optional Lenses (available upon request)

Macro-70c

c. The Macro lens, if included, provides a second beam line for imaging, and is mounted 
beside, rather than on, the turret.

20.0 34.0 100

1X 9.0 13.5 50

2Xd, e

d. The 2X lens has a round FOV. Therefore, its 3D FOV range is the diameter of the FOV.
e.  The 2X lens is not available when the MicroXCT has an optional Macro lens.

6.0 6.8 50

40Xf

f. Spatial Resolution Limit for 40X is 0.7 µm.

1.0 0.3 20
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Components

Table G-2 Sample Stage – MicroXCT-200

X Axis Y Axis Z Axisa

a. The Z direction is defined as being along the X-ray beam path.

Rotation

Travel 90 mm 50 mm 10 mm 360°b

b. Some older MicroXCT models are 180°-enabled. All current models are 360°-enabled. 
To determine the rotation capability of your MicroXCT, refer to Appendix F, “Determining 
Whether the MicroXCT is 360°-Enabled.”

Load Capacity 1 kg

Table G-3 Sample Diameter/Width and Height Limitations – MicroXCT-200

Diameter/Width Limitations
(Centered on Axis of Rotation) Height Limitations

100 mm 150 mm

Table G-4 X-ray Source Minimum Warm-Up Time, and Minimum and 
Maximum Voltage and Power Settings – MicroXCT-200

X-ray Source

Minimum 
Warm-Up 

Time Prior
to Usea

a. 15 minutes is the minimum warm-up period, if the X-ray source has been turned OFF 
for more than 15 minutes, for optimal X-ray source stability during scans.

Voltage
(kV)

Power
(W)

Minimum Maximum Minimum Maximum

90 kV 15 minutes 20 90 1 8

150 kV 15 minutes 40 150 4 10

Table G-5 Detector and X-ray Source Axes Travel Limits – MicroXCT-200

Detector Axis X-Ray Source Axis

120 mm 85 mm

Table G-6 Detector – MicroXCT-200

Category Specification

Pixel Array 2,048 x 2,048

Turret Lens Capacity 6
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Table G-7 Charge-Coupled Device – MicroXCT-200

Category Specification

Operating Temperature

< -55°C

CAUTION Contact the Xradia 
Support Team if the XMController 
Acquisition Setting dialog box indicates 
a temperature > -55°C.

Table G-8 Workstation (Computer, Quad Core) – MicroXCT-200

Category Specification

Operating System Windows XP Pro

Hard Disk Drive Space – Drive C
Varies, dependent upon the 
workstation model available 
at the time of shipment/purchase

RAM 4 GB

Monitor 19-inch LCD

Table G-9 Tomography Software – MicroXCT-200

Category Specification

Reconstruction Time
1,024 slices (8-bit) from 181 projections 
(GPU accelerated) < 3 minutes
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Facility Requirements

Table G-10 Facility Requirements – MicroXCT-200

Category Specificationa

a. Length measurements are rounded.

Electricalb

b. Refer to Appendix H, “Electrical Documentation,” for information specific 
to the EMO system and safety interlocks.

90 to 240 VAC, 15A, 50/60 Hz
Isolated circuit (not shared 
by other equipment)

Footprint (w x d)c, d

c. Includes handle and ergonomic workstation arm bracket.
d. Refer to Figure G-1 and Figure G-2.

1.64 m x 0.9 m
Flat surface (0° angle)

Heighte

e. Includes light tower.

1.78 m

Weight 1,361 kg

Radiation Safety <1 µS/hr

Operating Temperature 18 to 25°C, with < 2°C variation

Exterior Clearance

Front – 1.2 m
Left – 1 m
Right – 1 m
Back – 0.9 m
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Figure G-1 Footprint – MicroXCT-200
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Figure G-2 Dimensions – MicroXCT-200
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MicroXCT-400 Specifications

This appendix provides the following MicroXCT-400 specifications:

– Spatial Resolution

– Components

– Facility Requirements

Spatial Resolution

Table G-11 Spatial Resolution – MicroXCT-400

Magnification Level/
Lens

Best Resolution 
at 10% MTFa

(µm)

a. MTF (Modulation Transfer Function) measured using Xradia’s standard 
2D resolution target.

Detector Pixel Sizeb

(µm)

b. Pixel size on the face of the detector; Detector Area = 2,048 * Detector Pixel size, 
except 1X; Detector Area for 1X = 1,024 x Detector Pixel Size.

Sample Width Limit
(mm)

Standard Lenses (included with every MicroXCT)

4X 5.0 3.4 100

10X 2.5 1.4 50

20X 1.5 0.7 30

Optional Lenses (available upon request)

Macro-70c

c. The Macro lens, if included, provides a second beam line for imaging, and is mounted 
beside, rather than on, the turret.

20.0 34.0 100

Macro-55 (0.5X)c, d, e

d. The Macro-55 (0.5X) lens is obsolete, and was replaced by the Macro-70 as an option. 
The lens is still in use in some MicroXCT units.

e. The Macro-55 (0.5X) and 2X lenses have a round FOV. Therefore, their 3D FOV range 
is the diameter of the FOV.

16.0 27.0 100

1X 9.0 13.5 50

2Xe, f

f.   The 2X lens is not available when the MicroXCT has an optional Macro lens.

6.0 6.8 50

40Xg

g. Spatial Resolution Limit for 40X is 0.7 µm.

1.0 0.3 20
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Components

Table G-12 Sample Stage – MicroXCT-400

X Axis Y Axis Z Axisa

a. The Z direction is defined as being along the X-ray beam path.

Rotation

Travel 45 mm 100 mm 50 mm 360°b

b. Some older MicroXCT models are 180°-enabled. All current models are 360°-enabled. 
To determine the rotation capability of your MicroXCT, refer to Appendix F, “Determining 
Whether the MicroXCT is 360°-Enabled.”

Load Capacity 15 kg

Table G-13 Sample Diameter/Width and Height Limitations – MicroXCT-400

Diameter/Width Limitations
(Centered on Axis of Rotation) Height Limitations

500 mm 400 mm

Table G-14 X-ray Source Minimum Warm-Up Time, and Minimum and 
Maximum Voltage and Power Settings – MicroXCT-400

X-ray Source

Minimum 
Warm-Up 

Time Prior
to Usea

a. 15 minutes is the minimum warm-up period, if the X-ray source has been turned OFF 
for more than 15 minutes, for optimal X-ray source stability during scans.

Voltage
(kV)

Power
(W)

Minimum Maximum Minimum Maximum

90 kV 15 minutes 20 90 1 8

150 kV 15 minutes 40 150 4 10

Table G-15 Detector and X-ray Source Axes Travel Limits – MicroXCT-400

Detector Axis X-Ray Source Axis

300 mm 400 mm

Table G-16 Detector – MicroXCT-400

Category Specification

Pixel Array 2,048 x 2,048

Turret Lens Capacity 6
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Table G-17 Charge-Coupled Device – MicroXCT-400

Category Specification

Operating Temperature

< -55°C

CAUTION Contact the Xradia 
Support Team if the XMController 
Acquisition Setting dialog box indicates 
a temperature > -55°C.

Table G-18 Workstation (Computer, Quad Core) – MicroXCT-400

Category Specification

Operating System Windows XP Pro

Hard Disk Drive Space – Drive C
Varies, dependent upon the 
workstation model available 
at the time of shipment/purchase

RAM 4 GB

Monitor 19-inch LCD

Table G-19 Tomography Software – MicroXCT-400

Category Specification

Reconstruction Time
1,024 slices (8-bit) from 181 projections 
(GPU accelerated) < 3 minutes
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Facility Requirements

Table G-20 Facility Requirements – MicroXCT-400

Category Specificationa

a. Length measurements are rounded.

Electricalb

b. Refer to Appendix H, “Electrical Documentation,” for information specific 
to the EMO system and safety interlocks.

90 to 240 VAC, 15A, 50/60 Hz
Isolated circuit (not shared 
by other equipment)

Footprint (w x d)c, d

c. Includes handle and ergonomic workstation arm bracket.
d. Refer to Figure G-3 and Figure G-4.

2.17 m x 1.2 m
Flat surface (0° angle)

Heighte

e. Includes light tower.

2.09 m

Weight 2,722 kg

Radiation Safety <1 µS/hr

Operating Temperature 18 to 25°C, with < 2°C variation

Exterior Clearance

Front – 1.2 m
Left – 1.34 m
Right – 1.1 m
Back – 1.2 m
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Figure G-3 Footprint – MicroXCT-400

M
IC

R
O

X
C
T
-4

0
0
 W

E
IG

H
S
 ~

5
0
0
0
lb

 (
~

2
2
6
8
K
G

) 
F
U

L
L
Y
 A

S
S
E
M

B
L
E
D

(R
E
F
: 

 A
0
0
0
2
8
8
 R

E
V
 B

)

S
E
E
 B

O
M

M
A
T
E
R
IA

L S
E
E
 N

O
T
E
S

.X
  

  
 

 0
.3

.X
X
  

 
 0

.1
3

A
.0

2
A

0
0

0
2

8
8

5
 o

f 
7

.X
  

 
 0

.5

.X
X
 

 0
.2

5

5
 o

f 
7

B

1
:3

0

A
.0

2
A

0
0

0
2

8
8

M
IC

R
O

 X
C

T
-4

0
0

, 
B

A
S

E
L
IN

E
 A

S
S

Y
 W

/
 

U
M

A
C

 M
O

T
IO

N
 C

O
N

T
R

O
L

4

A

3

B

4
3

D
W

G
 N

O
.

F
IN

IS
H 2D

O
 N

O
T
 S

C
A
L
E
 D

R
A
W

IN
G

A
P
P
R
O

V
A
L
S

D
A
T
E

S
C
A
L
E

S
IZ

E

T
IT

L
E

U
N

L
E
S
S
 O

T
H

E
R
W

IS
E
 S

P
E
C
IF

IE
D

D
IM

E
N

S
IO

N
S
 A

R
E
 I

N
 M

IL
L
IM

E
T
E
R
S
.

D
IM

E
N

S
IO

N
S
 I

N
 [

 ]
 A

R
E
 I

N
C
H

E
S
.

T
O

L
E
R
A
N

C
E
S
 A

R
E
:

A
N

G
L
E
S

D
E
C
IM

A
L
S

1

S
H

E
E
T

R
E
V

A

S
H

E
E
T

D
W

G
 N

O
.

R
E
V

B

1

M
E
T
R
IC

T
H

IR
D

 A
N

G
L
E
 P

R
O

JE
C
T
IO

N

T
H

IS
 D

O
C
U

M
E
N

T
 A

N
D

 T
H

E
 D

A
T
A
 C

O
N

T
A
IN

E
D

 H
E
R
E
IN

 
O

R
 H

E
R
E
W

IT
H

 I
S
 T

H
E
 P

R
O

P
R
IE

T
A
R
Y
 P

R
O

P
E
R
T
Y
 O

F
 

X
R
A
D

IA
, 
IN

C
.,
 A

N
D

 I
S
 N

O
T
 T

O
 B

E
  
R
E
P
R
O

D
U

C
E
D

, 
U

S
E
D

, 
O

R
 D

IS
C
L
O

S
E
D

 I
N

 W
H

O
L
E
 O

R
 I

N
 P

A
R
T
 T

O
 A

N
Y
O

N
E
 

W
IT

H
O

U
T
 T

H
E
 W

R
IT

T
E
N

 P
E
R
M

IS
S
IO

N
 O

F
 X

R
A
D

IA
, 
IN

C
.

0
2
/1

1
/2

0
1
0

0
4
/0

2
/2

0
0
9

a
ch

u

e
m

a
b
a
lo

t

U
P
D

A
T
E
D

U
P
D

A
T
E
D

D
R
A
W

IN
G

e
m

a
b
a
lo

t
0
2
/1

1
/2

0
1
0

0
4
/1

6
/2

0
0
8

a
ch

u

M
O

D
E
L

1
9
2
7

7
3
9

0

1
7
1
9

2
0
8
1

6
2
8

1
8
0
4

1
2
0
0

F
R
O

N
T
 E

M
O

1
1
8
5

2
1
1
9

8
3
3

A
P
P
R
O

X
 A

R
M

 T
R
A
V
E
L
 

2
8
0
0

3
0
5
5

4
0
1
3

3
2
0
2

4
4
5
4

A
P
P
R
O

X
 D

O
O

R
 S

W
IN

G

1
1
8
5

9
4
6

8
9
56
5

0

6
8
3

2
3
7

R
E
A
R
 E

M
O

A
C
 I

N

272 MicroXCT-200 and MicroXCT-400 User’s Guide



Appendix G – Specifications
Figure G-4 Dimensions – MicroXCT-400
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H Electrical Documentation

This appendix provides electrical documentation specific to the Emergency 
Off (EMO) system and safety interlocks.
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Appendix H – Electrical Documentation
EMO Sequence of Operation

The Safety Relay SR1 is powered through the EMO1 and EMO2 circuits, from 
the primary 24 VDC power supply, PWS1. If the EMO button is not activated 
(its normally CLOSED contacts are CLOSED) and 24 VDC has been supplied 
from PWS1, pressing the RESET button energizes the CON1 and CON2 
contactors, whose contacts close and provide the power for the secondary 
24 VDC power supply, PWS2. If EMO button is activated, the Safety Relay SR1 
turns OFF, CON1 and CON2 immediately de-energize, and PWS2 is cut off 
from power. The normal condition can be restored when the EMO button is 
released (de-activated) and RESET button pressed. (Refer to Figure H-1.)

NOTE EMO2 is used only by the MicroXCT-400; in the MicroXCT-200 circuit, 
EMO2 is shorted.

Figure H-1 EMO Electrical Diagram
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Appendix H – Electrical Documentation
Interlock Sequence of Operation

NOTE Elsewhere in this guide, the “signal light tower” is referred to as the 
“light tower,” and its lights are referred to as “lights,” rather than “LEDs.” 
The technical terminology (signal light tower and LED) are used only within 
this appendix.

When PWS2 is powered up (EMO OK), the relay CR3 is energized and the 
(signal) light tower’s (SLT1) green LED turns ON. When the access door(s) 
is (are) closed, both door interlocks are made (Door Interlock switch 2 is 
connected directly to the Interlock 2 input of the X-ray source; refer to 
Figure H-2), the relay CR4 becomes energized and the light tower’s (SLT1) 
yellow LED turns ON. At this condition, the X-ray source is enabled 
(unless LR1 is energized). Failure on any interlock circuit (1 or 2) disables 
the X-ray source.

When the X-ray source turns ON, the relay CR1 becomes energized. The 
Normally OPEN contact of CR1 turns ON the light tower’s (SLT1) red LED, 
indicating that the X-ray source is ON. CR2 becomes energized from the 
current sensing relay, which monitors the current flowing through the light 
tower’s (SLT1) red LED.

At the same time CR1 turns ON, the time delay relay TR1 becomes energized 
and, after a short delay, its contact closes in the latching relay LR1 SET coil 
circuit. However, LR1 SET is not energized, because the normally CLOSED 
contact CR2 (which is in series with LR1 SET coil) becomes OPEN before the 
delay times out.

If the light tower’s (SLT1) red LED turns OFF while the X-ray source is ON 
(LED failure, broken wire, or other electrical-related problem), the relay CR2 
turns OFF. The LR1 becomes SET and disables the X-ray source, and the PDU’s 
ALARM light turns ON. Normal conditions can be restored, if the light tower’s 
(SLT1) red LED circuit is fixed prior to activating alarm reset LPB1.
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Figure H-2 Safety Interlock Electrical Diagram
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J License, Warranty, and 
Service Information

This appendix provides the software license agreement, limited warranties, 
service and maintenance information, and Xradia contact information.
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Appendix J – License, Warranty, and Service Information
Software License Agreement

All Software obtained by Purchaser from Xradia is proprietary to Xradia and its 
licensors and is subject to copyrights, other intellectual property rights and 
moral rights owned by Xradia and its licensors. Any references to “purchases” 
of Software signify only the purchase of a license to use the Software in 
question pursuant to the terms of the following software license. Xradia grants 
to Purchaser a non-exclusive license to use, according to its intended use, any 
software or firmware incorporated in or provided to operate with the 
Products, together with any modifications or enhancements to such software 
or firmware supplied to Purchaser by Xradia. Except as expressly set forth 
herein, no other rights are granted to or acquired by Purchaser with respect 
to Software. Purchaser may not sublicense, assign or otherwise transfer its 
rights to use Software except upon a transfer of any Products with or for 
which the Software was supplied and then only if these same licensing terms 
and limitations are applicable to the sublicensee, assignee or transferee. 
Purchaser acknowledges that the Software incorporates valuable trade secrets 
of Xradia and agrees not to copy, decompile, disassemble, reverse engineer, 
or modify any software provided by Xradia or its suppliers. This license 
granted herein will take effect upon delivery of the Software to Purchaser 
at the Ex works Point.
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Appendix J – License, Warranty, and 
Limited Warranties

a) Hardware Warranty – Xradia warrants to Purchaser that the hardware 
component of the Products will be free from defects in material and 
workmanship and will conform to applicable specifications or documentation 
for a period of twelve (12) months from the date of delivery to Purchaser (the 
“Warranty Period”) when given normal, proper and intended usage and care. 
If, during the Warranty Period, the hardware component of any Product fails to 
conform to the foregoing warranty, Xradia shall, in its sole discretion, either 
repair or replace such Product, without charge to Purchaser, provided that: 
i) Xradia is promptly notified in writing by Purchaser (not later than thirty (30) 
days after discovery of the nonconformity or thirty (30) days after expiration of 
the Warranty Period, whichever occurs first) that the Product does not 
conform to the foregoing warranty, and ii) Purchaser obtains a Return Material 
Authorization (“RMA”) and a RMA number from Xradia prior to returning the 
nonconforming Product to Xradia at the Ex works Point, freight prepaid.

b) Software Warranty – Xradia warrants to Purchaser that during the Warranty 
Period the Software will perform substantially in accordance with its user 
documentation and specifications. Xradia does not warrant that the Software 
will operate in combination with other software or firmware which may be 
selected for use by Purchaser. If, during the Warranty Period, the Software fails 
to conform to the foregoing warranty, Xradia shall correct the nonconforming 
Software so that it performs as warranted at no charge to Purchaser, provided 
that: i) Xradia is promptly notified in writing by Purchaser (not later than 
thirty (30) days after discovery of the nonconformity or thirty (30) days after 
expiration of the Warranty Period, whichever occurs first) that the Product 
does not conform to the foregoing warranty.

c) Xradia shall have no responsibility with respect to defects in the Products or 
performance problems occurring in whole or part by reason of i) accident, 
misuse, neglect, alteration, improper installation, unauthorized repair, 
improper testing, unusual physical or electrical stress, or other conditions 
outside the operating parameters specified by Xradia, ii) software or firmware 
not supplied by Xradia, or iii) Purchaser’s failure to follow operating or 
corrective instructions provided by Xradia.

d) Xradia shall have a reasonable time to repair or replace nonconforming 
Product(s) or correct nonconforming Software. Xradia will pay standard 
freight for shipment of the repaired or replacement Product to Purchaser. 
Each repaired or replacement Product will be warranted for a period equal 
to the remainder of the original warranty period for the returned Product 
or ninety (90) days from the date of shipment of the repaired or replacement 
Product to Purchaser, whichever is longer.
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Appendix J – License, Warranty, and Service Information
e) Xradia warrants to Purchaser that, at the time title to the Products passes to 
Purchaser, Xradia has good and marketable title to the Products and that they 
are free and clear of all liens and encumbrances.

f) THE WARRANTIES STATED HERE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHER WARRANTIES, WHETHER EXPRESS, IMPLIED, OR STATUTORY, 
INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. THE REMEDIES STATED HERE 
ARE EXCLUSIVE WITH RESPECT TO ANY DEFECTS OR DEFICIENCIES 
IN THE PRODUCTS.

Service and Maintenance

All service and maintenance is to be performed by trained Xradia personnel 
for customers with field service contracts. Should the MicroXCT require 
service outside the contracted maintenance schedule, contact Xradia 
to schedule a service visit.

Contact Information

Xradia, Inc. 
5052 Commercial Circle 
Concord, CA 94520   USA

Phone: 1 (888) 497-2342 
1 (925) 771-8093 

Fax: 1 (925) 243-8788 
Email: service@xradia.com 
Website: http://www.xradia.com/products/support.php
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K Glossary

access door(s) Part of the enclosure. Closes off the X-ray source, providing 
protection from harmful X-ray radiation.

artifacts Features that exist in an image that are not part of the sample, 
but are introduced by the imaging system.

baffle Part of the interior shielding within the enclosure, designed to deflect 
and/or absorb X-rays.

beam hardening Result of the change in spectrum characteristic as the X-rays 
pass through the sample, where the sample density remains the same, but the 
light changes – one area is darker than another. 

beam line Imaging X-ray/light path consisting of the X-ray source, sample, 
and detector.

binning Process of combining charges from adjacent pixels in a CCD during 
readout. The two primary benefits of binning are improved signal-to-noise 
ratio (SNR) and the ability to increase frame rate, albeit at the expense of 
reduced spatial resolution. A binned pixel can be referred to as a super pixel, 
because charges of the binned pixels are combined to one. To ensure that dark 
current noise does not lower SNR during binning, it is essential that the CCD 
be sufficiently cooled, to reduce the dark current noise to a negligible level 
relative to the read noise.
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Appendix K – Glossary
CCD Charge-Coupled Device. A device for the movement of electrical 
charge, usually from within the device to an area where the charge can be 
manipulated. Technically, CCDs are implemented as shift registers. Often the 
device is integrated with a sensor, such as a photoelectric device to produce 
the charge that is being read, used where the conversion of images into 
a digital signal is required. CCDs are widely used in professional, medical, 
and scientific applications where high-quality image data is required.

center shift Amount, in pixels, that the axis of rotation is offset from the 
center column of the detector.

counts, light intensity Refer to light intensity counts.

CT Computed Tomography.

CT scale, CT scaling Process by which the tomography images produced 
have the appropriate Hounsfield Units (HU), in which air and water have 
values of -1,000 and 0, respectively. Xradia uses the unsigned short data 
format; therefore, Xradia CT scaling scales air to 0 and water to 1,000.

detector assembly Assembly that picks up X-ray images of the sample.

Dynamic Ring Removal Refer to DRR.

DRR Dynamic Ring Removal. Xradia proprietary method to remove 
ring artifacts in reconstructed slices and volume (available by selecting 
Microscope > Configure System). 

EMO button Emergency Off button. Used to shut down the MicroXCT 
in emergency and non-emergency events.

enclosure Insulated steel and lead-lined framework that covers the exterior 
of the MicroXCT, providing protection from harmful X-ray radiation.

ergonomic station User console for controlling the MicroXCT for data 
acquisition and analysis.

exposure time Amount of time that the CCD is exposed to light when 
acquiring an image.

fiducial Fixed basis of reference or comparison.

field of view  Refer to FOV.

FOV Field of View. Size of the area imaged by the system.
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hardening the X-ray Using a source filter to remove lower-energy X-rays, 
to reduce the effects of beam hardening.

hazardous material Dangerous or toxic substance that is a biological, 
chemical, or physical agent (or a combination of agents), whose presence 
or use in the workplace can endanger the health or safety of a worker.

Hounsfield Units (HU) Scale in which the radiodensity of distilled water 
at standard pressure and temperature (STP) is defined as zero HU, while 
the radiodensity of air at STP is defined as -1000 HU. These standards are 
universally available references and are suited to the imaging of the internal 
anatomy of living creatures based on organized water structures and mostly 
living in air. The scale was established by Sir Godfrey Newbold Hounsfield, 
one of the principal engineers and developers of computed axial tomography 
(CAT, or CT scans).

ionizing hazard Hazard caused by exposure to X-ray radiation.

kernel size Number of pixels sampled as a unit during image manipulation.

light intensity counts Pixel intensity values, indicated in blue, in the lower 
left status area of an Image window.

light tower Indicator located on top of the MicroXCT that visually reports 
status conditions.

mosaic One large image that is created by scanning the sample and tiling 
the individual images acquired at each scanned X/Y location.

motion controller hardware Provides the interface between the workstation 
and all motors.

MTF  Modulation Transfer Function. In imaging systems, it describes the 
response of an optical system to an image decomposed into sine waves. MTF 
represents the Bode plot of an imaging system (such as a microscope or the 
human eye), and thus depicts the filtering characteristic of the imaging system.

noise Random variation in intensity, in images produced by the different 
components of the imaging system.

PDU Power Distribution Unit. Distributes power to the electrical 
MicroXCT components.

Power Distribution Unit Refer to PDU.
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projection 2D images acquired during data acquisition/tomography 
using XMController.

reconstruction Process of using all the projections acquired during data 
acquisition/tomography, to create a 3D volume. This process requires the 
use of XMReconstructor.

reference image Blank image acquired with the sample out of the FOV.

region of interest Data acquisition area of focus.

RESET button Button used to reset MicroXCT power after a shutdown.

safety interlocks Device applied to two or more moveable parts that 
allows the operation of the X-ray source, only when the parts are locked 
in a pre-determined position. For the MicroXCT, the safety interlocks 
turn OFF the X-ray source when the access door(s) is (are) opened.

sample holder assembly Sample mounted on a sample holder.

sample holder Device used to hold the sample in place. Sample holders 
used with MicroXCT are clamps, clips, pin vises, and sample bases. Sample 
holders are described in “Mounting the Sample in/on a Sample Holder,” on 
page 33.

sample stage Platform upon which the sample (imaging target), mounted 
on a sample base, is secured for microscopy.

scintillator Device used for detecting and counting scintillations produced 
by ionizing radiation.

slice XMReconstructor reconstructs images stored in each *.txrm file to form 
a set of reconstructed slices. A slice is a 2D section of the 3D reconstructed 
volume. Slices generated from each *.txrm file are stored in a file with 
the extension .txm. A *.txm file contains a collection of slices that make 
up the reconstructed volume. If no specific region is selected during 
reconstruction, the number of slices is equal to the height of each projection 
image in the original *.txrm file.

SNR Signal-to-Noise Ratio. Describes the quality of a measurement. In CCD 
imaging, SNR refers to the relative magnitude of the signal compared to the 
uncertainty in that signal on a per-pixel basis. Specifically, it is the ratio of the 
measured signal to the overall measured noise (frame-to-frame) at that pixel. 
High SNR is particularly important in applications that require precise 
light measurement.
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source aperture Tungsten piece with a hole in the center of it, that is bolted 
onto the front of the X-ray source.

source controller hardware Provides the interface between the workstation 
and X-ray source. Included only with the 150 kV X-ray source.

source filter  Material (available in a filter kit from Xradia) that improves 
reconstructed image quality, by removing low-energy X-rays that do not 
provide useful information through the sample.

stitching Process in which two volumes are merged at a common plane, 
to become a single volume. The two volumes must be reconstructed at the 
same byte scaling, to provide identical grayscale levels for both volumes.

tomography Technique that allows virtual cross-sectioning or de-layering, 
which enables you to look at the interior of the sample, without destroying 
the sample.

transmission value Ratio of X-rays through the sample versus the X-rays 
without the sample present.

turret Part of the detector assembly. Holds up to six lenses. The lens located 
at the lowest point on the turret is used to focus on the sample.

visual light camera Supplies images to the visual light camera monitor. 
Located behind the sample stage, at the rear of the enclosure. 
Used for positioning the sample, detector, and X-ray source.

VRT Volume Rendering Technique. Default 3D display mode in 
XM3DViewer that is used to compute a color and transparency mapping 
of a 3D reconstructed volume.

workstation Windows XP-based computer included in the MicroXCT.

XM3DViewer Program used to view regions of interest in reconstructed 
tomographic data as a 3D volume.

XCT X-ray Computed Tomography.

XMController Program used to manage the data acquisition process, from 
setting up the sample to the acquisition of data, either manually or through 
the automatic Recipe. Also used to acquire X-ray images, and monitor and 
control the microscope’s hardware components.

XMReconstructor Program used to reconstruct 2D projections into 
3D reconstructed volumes. Refer also to reconstruction.
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X-ray source Mechanism that generates X-rays, from 20 to 90 kV (90 kV X-ray 
source) or 40 to 150 kV (150 kV X-ray source), used by the MicroXCT to image 
samples and reference images.

X-ray source aging Required X-ray source warm-up process that lasts up 
to 30 minutes or longer, after the X-ray source has been turned OFF for more 
than 8 hours. The X-ray source voltage and current increase up to their 
maximum levels in a pre-determined fashion during warm-up.
288 MicroXCT-200 and MicroXCT-400 User’s Guide


	Contents
	Safety
	Safety Guidelines
	EMO Shutdown
	Enclosure Covers and Access Door(s)
	Potential Hazards and Safety Precautions - Personnel
	High Voltage
	Ionizing Hazard
	Pinch Hazards
	Magnetic Field
	Hazardous Materials

	Potential Hazards and Safety Precautions - Equipment
	Loss of Data and/or Irreversible Damage Due to EMO Shutdown
	Collision of Moving Parts
	Improper Grounding

	Safety Labels

	Preface
	Document Organization
	Document Conventions
	Instructions and Information
	Special Text Formats
	Cross-References
	Terminology
	Notes, Cautions, and Warnings

	Assumptions

	1 Overview
	Technology Overview
	X-ray Microscopy
	How X-ray Microscopy Works
	What Xradia MicroXCT Does
	Xradia MicroXCT Product Family

	MicroXCT Hardware and Software
	Hardware Description
	Major External and Internal Hardware Components
	X-ray Source
	Detector Assembly
	Ergonomic Station
	Visual Light Camera Controller

	Software Control
	XMController
	XMReconstructor
	XM3DViewer


	Process Overview

	2 Setting Up for Data Acquisition
	Process Overview
	Mounting the Sample in/on a Sample Holder
	Mounting Using a Clamp
	Mounting Using a Clip
	Mounting Using a Pin Vise
	Mounting Using a Sample Base

	Installing the Sample
	Loading the Sample Holder Assembly onto the Sample Stage
	Coarsely Positioning the Sample
	Selecting the Lowest Magnification
	Coarsely Positioning the Detector
	Verifying the X-ray Source’s Position

	Turning on the X-ray Source

	3 Selecting the First Tomography Point
	Process Overview
	Collecting Continuous Images
	Identifying the First Point
	Finely Positioning the Detector
	Finely Positioning the X-ray Source
	Selecting the Source Filter
	Installing the Selected Source Filter
	Determining the Optimum X-ray Source Voltage
	Determining the X-ray Source Power and Exposure Time

	4 Automatically Acquiring Additional Data and Reconstructing Tomography Point(s)
	Process Overview
	Recording the First Selected Tomography Point (Region of Interest)
	Selecting Additional Tomography Points, Using Continuous Imaging
	Setting up a Recipe
	Tour of the Recipe Dialog Box
	Opening the Recipe Dialog Box and Editing Collected Points

	Setting Acquisition and Reconstruction Parameters
	Running a Recipe

	5 Manually Acquiring Images and Tomographic Data
	Process Overview
	Acquiring Images
	Collecting Continuous Images
	Collecting a Single 2D Image
	Collecting a Mosaic Image
	Manually Collecting a 3D (Tomography) Dataset
	Collecting a Reference Image

	Applying the Reference Image

	6 Manually Reconstructing a 3D Dataset
	Process Overview
	Preparing for Reconstruction
	Identifying Center Shift
	Identifying Beam Hardening Correction
	Reconstructing the Tomography Data

	7 Viewing Tomographies
	Process Overview
	Checking a Large Reconstructed File
	Starting XM3DViewer
	Adjusting and Navigating the Reconstructed 2D Slices
	Adjusting Contrast and Brightness in the 2D Reconstructed Slice Windows
	Navigating the XM3DViewer Main Window

	Creating 3D Volume Renderings
	Collecting Images (or Pictures) for a Report
	Visualize, Measure, and Capture Internal Structure on 2D Reconstructed Slices
	Visualize, Measure, and Capture Internal Structure on 3D Volumes

	Generating a Report
	Creating Movies of Cross-Sectional 2D Reconstructed Slices and 3D Volumes
	Creating Movies of 2D Reconstructed Slices
	Creating Movies of 3D Reconstructed Volumes

	Correcting Problems with the Reconstructed File

	A Troubleshooting
	Issues that Require Xradia Assistance
	Troubleshooting Sample Issues in XMController
	Sample Is Unstable
	Sample Is Not Visible on the Visual Light Camera Monitor
	Sample Region of Interest Is Not Visible
	Sample and Detector Collision Is Imminent
	Sample and Detector Collided
	Sample and X-ray Source Collision Is Imminent
	Sample and X-ray Source Collided

	Troubleshooting Magnification Lens Too Close to the X-ray Source - Keeping the X-ray Source Aperture out of the Field of View
	Troubleshooting Image Contrast, Brightness, and Light Intensity Count Issues
	Troubleshooting Issues with XM3DViewer
	Troubleshooting MicroXCT Power Failures
	Troubleshooting Light Tower Issues
	Contacting the Xradia Support Team (Technical Support)

	B MicroXCT Files and File Storage
	File Types
	Exporting Files
	Exporting *.xrm Files or Single Images on XMController
	Exporting *.txrm and *.txm Files

	File Storage (Hard Disk Drive(s))

	C Shutting Down and Restarting the MicroXCT
	Shutting Down the MicroXCT in a Non-Emergency Event
	Turning ON the MicroXCT
	Homing the Axes
	Automatically Homing the Axes
	Manually Homing the Axes


	D Visual Light Camera Monitor Brightness Controls
	E Removing the Sample after Use
	F Determining Whether the MicroXCT is 360˚-Enabled
	G Specifications
	MicroXCT-200 Specifications
	Spatial Resolution
	Components
	Facility Requirements

	MicroXCT-400 Specifications
	Spatial Resolution
	Components
	Facility Requirements


	H Electrical Documentation
	EMO Sequence of Operation
	Interlock Sequence of Operation

	J License, Warranty, and Service Information
	Software License Agreement
	Limited Warranties
	Service and Maintenance
	Contact Information

	K Glossary

